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ΠΕΡΙΛΗΨΗ 
 

 Σκοπός της διπλωματικής εργασίας είναι η σχεδίαση ενός κυκλώματος διεπαφής μεταξύ 

κυκλώματος μικροελεγκτή και κεραίας μεταγωγής λοβού. Για τον σκοπό αυτό ακολουθήθηκε 

μία σειρά βημάτων που περιλαμβάνει από το αρχικό σχεδιάγραμμα του κυκλώματος της 

πλακέτας μέχρι την προσομοίωσή της. 

Στην παρούσα εργασία, παρατίθενται αναλυτικά τα βήματα και παρουσιάζονται τα 

εργαλεία για τον σχεδιασμό, την βελτιστοποίηση και την προσομοίωση της πλακέτας. 

Παρουσιάζονται συγκεκριμένα δύο εργαλεία, το Altium Designer που θεωρείται κορυφαίο στον 

τομέα σχεδίασης πλακετών και είναι ένα εδραιωμένο πρόγραμμα στην βιομηχανία και το CST 

Studio Suite, με τα υποπρογράμματα του τελευταίου να παίζουν καθοριστικό ρόλο στον έλεγχο 

ορθότητας του κυκλώματος και της απόδοσής του. 

 Τα βήματα που παρουσιάζονται, μπορούν να λειτουργήσουν σαν οδηγός σχεδίασης, 

προσομοίωσης και ελέγχου σε ένα ευρύ φάσμα κατασκευών και το όλο εγχείρημα έχει επαφή με 

την σημερινή πραγματικότητα της βιομηχανίας. 

 

ΛΕΞΕΙΣ – ΚΛΕΙΔΙΑ: << Έλεγχος πλακέτας τυπωμένου κυκλώματος, Κύκλωμα διεπαφής, 

Προσομοίωση πλακέτας τυπωμένου κυκλώματος, Altium Designer, CST Studio Suite, 

Python>> 
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ABSTRACT 
 

The scope of this thesis is the design of a switch interface between a microprocessor 

and a lobe switching antenna. For this purpose, a series of steps was followed, including the 

initial concept and diagram of the circuit up to the simulation of the PCB. 

The steps that were followed to design this PCB are broken down and the software 

tools that were used for the design, optimization and simulation of the PCB are shown in a 

form of guide for future reference. To be more precise, two software tools were used for the 

purposes of this thesis, Altium Designer, which is a golden standard of the industry of design 

and manufacturing, as well as CST Studio Suite, the submodules of which had a decisive role 

in the design check and the performance of the PCB in question. 

The steps that are in display may act as a design guide, simulation, and design check 

in a wide spectrum of PCB designs and is up to date with todays’ industry standards. 

 

  

KEYWORDS: PCB design check, Switching interface circuit, PCB Simulation, Altium 

Designer, CST Studio Suite, Python 
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ΠΙΝΑΚΑΣ ΣΥΜΒΟΛΩΝ-ΑΚΡΩΝΥΜΙΩΝ-

ΣΥΝΤΟΜΟΓΡΑΦΙΩΝ  

 
PWB Printed wiring board 

SMT Surface Mount Technology 

IC Integrated Circuit 

EDA Electronic Design Automation 

BGA Ball Grid Array 

SoC System on Chip 

DFT Design for Test 

CPW Coplanar Waveguide  

GCPW Grounded Coplanar Waveguide 

PCB Printed Circuit Board 

CAM Computer Aided Manufacturing 

CAD Computer Aided Design 

CNC Computer Numerical control 

FGCPW Finite Grounded Coplanar Waveguide 

TEM Transverse Electro-Magnetic 

SPDT Single Pole Double Throw 

MSOP Mini Small-outline package 

QSOP Quarter-size small-outline package 

SP6T Single Pole Six (6) Throw 

BoM Bill of Materials 
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ΕΙΣΑΓΩΓΗ:  

Αντικείμενο, ερευνητικά ερωτήματα και διάρθρωση της εργασίας 

 

Οι σχεδιαστές υψίσυχνων κυκλωμάτων πρέπει συχνά να λαμβάνουν  υπόψη τα φυσικά 

όρια που τίθενται από τον εκάστοτε περιβάλλοντα χώρο τοποθέτησης του σχεδίου τους, της 

πλακέτας τους, καθώς και τις απαιτήσεις που θα έχουν από άποψη επιδόσεων. Οι 

ηλεκτρομαγνητικές εκπομπές είναι ένας ακόμη παράγοντας που δεν πρέπει να αψηφά κανείς 

κατά τη διαδικασία σχεδιασμού μίας πλακέτας.   

Σχηματίζονται έτσι κάποιες προδιαγραφές, οι οποίες καλούν τον σχεδιαστή να επιλέξει 

την τεχνολογία βάσει της οποίας θα υλοποιηθεί η πλακέτα που θα αναπτύξει. Τα στοιχεία 

δηλαδή που θα τοποθετήσει σε αυτήν αλλά και την τοπολογία των στοιχείων αυτών. 

Ξεκινώντας συχνά από ένα σχεδιάγραμμα το οποίο περιγράφει τον τρόπο επίλυσης του 

εκάστοτε προβλήματος - κατασκευής, ο σχεδιαστής καταλήγει στην υλοποίηση του σχεδίου 

του μέσα από την συγκεκριμένη διαδικασία.  

Η εργασία θα ασχοληθεί με την ανάπτυξη ενός κυκλώματος διεπαφής (switch interface) 

μεταξύ κυκλώματος μικροελεγκτή και κεραίας μεταγωγής λοβού. Πιο συγκεκριμένα, θα 

σχεδιαστεί και θα αναπτυχθεί σε τεχνολογία PCB FR4 πλακέτα κυκλώματος με συνδυασμό 

αγώγιμων οδεύσεων RF και βασικής ζώνης για τον έλεγχο και την RF τροφοδοσία μιας 

κεραίας λήψης/εκπομπής. Οι RF οδεύσεις θα υλοποιηθούν με τεχνολογία GCPW (Grounded 

Coplanar Waveguide). 

Η παρούσα εργασία περιλαμβάνει την υλοποίηση του κυκλώματος και τα στάδια που 

ακολουθήθηκαν. Αναφέρονται, επομένως, τόσο τα εργαλεία που χρησιμοποιήθηκαν για τον 

σχεδιασμό της πλακέτας όσο και τα επιμέρους στοιχεία που επιλέχθηκαν για την υλοποίησή 

της. 

 

Δομή της διπλωματικής εργασίας 

 

 Στο κεφάλαιο 1 τίθεται το θεωρητικό πλαίσιο της διπλωματικής εργασίας. Ορίζονται οι 

διάφορες τεχνολογίες κατασκευής κυκλωμάτων PCB, καθώς και μία σύντομη ιστορική 

αναδρομή για τα τυπωμένα κυκλώματα PCB. Επίσης, παρουσιάζεται η διαδικασία και ο 

υπολογισμός ενός Wilkinson Combiner/Divider που είναι απαραίτητος για την εκπόνηση της 

παρούσας εργασίας. 

 Στο κεφάλαιο 2, γίνεται μία παρουσίαση του εργαλείου Altium Designer, προγράμματος που 

χρησιμοποιήθηκε για την σχεδίαση του κυκλώματος, παραθέτοντας τα βήματα που 

ακολουθήθηκαν για τον σχεδιασμό του κυκλώματος. Γίνεται, επίσης, και η επιλογή των 

στοιχείων μιας και αυτά είναι άρρητα συνδεδεμένα με την διαδικασία σχεδίασης. 

 Στο κεφάλαιο 3, παρουσιάζεται η εισαγωγή της πλακέτας στο εργαλείο CST Studio Suite. 

Εκεί πραγματοποιείται ο έλεγχος και η διόρθωση της πλακέτας καθώς και προετοιμάζεται για 

την φάση των προσομοιώσεων.  

 Στο κεφάλαιο 4, πραγματοποιείται η προσομοίωση και βελτιστοποίηση του κυκλώματος της 

πλακέτας στο εργαλείο  Microwave Studio, μέρος της σουίτας λογισμικού CST Studio. 

 Στο κεφάλαιο 5, πραγματοποιείται η εξαγωγή των τελικών μερών της πλακέτας από το CST 

Studio και η εισαγωγή τους στο Altium Designer, για την πραγματοποίηση των αλλαγών της 

πλακέτας στο σύνολό της, και εν συνεχεία θα παρουσιάζονται τα αποτελέσματα της 

προσομοίωσης της πλακέτας ως σύνολο με όλα τα επιμέρους στοιχεία.  
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 Το κεφάλαιο 6, συμπεριλαμβάνει συμπεράσματα και πιθανές μελλοντικές βελτιώσεις που 

μπορούν να πραγματοποιηθούν. 

 Σε ξεχωριστή υποενότητα, μετά το πέρας του Κεφαλαίου 6, περιέχεται η βιβλιογραφία της 

διπλωματικής.  
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ΚΕΦΑΛΑΙΟ 1 

 

1.1. Ιστορική αναδρομή στις τυπωμένες πλακέτες κυκλωμάτων PCB 

 

Πριν από την εμφάνιση των πλακετών τυπωμένου κυκλώματος, τα ηλεκτρονικά και ηλεκτρικά 

κυκλώματα είχαν συνδέσεις με καλώδια. Τα στοιχεία, τοποθετημένα πάνω σε πλαίσια 

κατασκευασμένα συνήθως από κάποιο μέταλλο, είχαν στις άκρες τους κολλημένα με κόλληση 

καλώδια που τα συνέδεαν απευθείας σε άλλα στοιχεία. Η εφαρμογή αυτής της μεθόδου είχε ως 

αποτέλεσμα τα κυκλώματα να είναι ογκώδη, δύσκαμπτα και εύθραυστα. Στις αρχές του 20
ου

 αιώνα 

ωστόσο, εμφανίστηκαν νέες μέθοδοι για την κατασκευή κυκλωμάτων. Ο Γερμανός Albert Hanson 

καταθέτει πατέντα στην Βρετανία και πρωτοπορεί περιγράφοντας μία επίπεδη συσκευή πολλαπλών 

επιπέδων, όπου φύλλα αγωγών είναι τοποθετημένα πάνω σε μία μονωτική πλακέτα (Εικόνα 1). Ο 

Γερμανός εφευρέτης, περιέγραψε, επίσης την ιδέα για χρήση οπών σε ένα επίπεδο για την πρόσβαση 

στους ηλεκτρικούς αγωγούς, εξασφαλίζοντας ηλεκτρικές συνδέσεις, την γνωστή σε όλους μας 

διάτρητη πλακέτα.  

 
Εικόνα 1: Απεικόνιση από την πρώτη κατάθεση πατέντας για τυπωμένα κυκλώματα από τον 

Albert Hanson 

 

Το 1925,ο Charles Ducas καταθέτει πατέντα, στην οποία περιγράφει μία διαδικασία για πρόσθεση 

αγώγιμου μελανιού επάνω σε ένα μονωτικό υλικό ( 

Εικόνα 2). 

 

 

 

Εικόνα 2: Απεικόνιση από την κατάθεση πατέντας του Charles Ducas, το τυπωμένο 

κύκλωμα ως θερμαντικό στοιχείο 
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Αν και χρησιμοποιήθηκε ως θερμαντικό στοιχείο, η εφεύρεση αυτή, μας φέρνει πιο κοντά στην 

μεταγενέστερη γέννηση των πλακετών με καλώδια (PWB – printed wiring board). 

Η ανάγκη για καλύτερα μέσα επικοινωνίας, γίνεται κατανοητή κατά την διάρκεια του Β΄ Παγκοσμίου 

Πολέμου από το Αμερικανικό Υπουργείο Άμυνας, ιδιαίτερα μετά την τραγωδία του Pearl Harbor. 

Κατά την χρονική αυτή περίοδο εντοπίζεται και το πρώτο κύκλωμα τυπωμένης πλακέτας (PCB) που 

δυστυχώς χρησιμοποιείται για στρατιωτικούς σκοπούς. Στην παρακάτω εικόνα (Εικόνα 3) 

παρατηρούμε την πρώτη χρήση ενός PCB όπως το γνωρίζουμε σήμερα στην ασφάλεια εγγύτητας 

(proximity fuse). Σκοπός της, η έκρηξη του βλήματος προτού αυτό έρθει σε επαφή με τον στόχο του. 

 
Εικόνα 3: Το πρώτο τυπωμένο κύκλωμα  

 

Το 1943 ο Αυστριακός Paul Eisler, που ζει στο Ηνωμένο Βασίλειο, καταθέτει πατέντα και περιγράφει 

ένα φύλλο χαλκού επάνω σε μία μη αγώγιμη βάση γυαλιού. Ο Eisler κατασκευάζει και ραδιόφωνο με 

την τυπωμένη του πλακέτα (Εικόνα 4). 
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Εικόνα 4: Το ραδιόφωνο του Paul Eisler 

 

Μετά από πειράματα του Thomas Edison με χημικές μεθόδους για την επίστρωση αγωγών πάνω σε 

χαρτί, η τεχνολογία τύπωσης κυκλωμάτων πάνω σε πλακέτες αναπτύχθηκε κατά την διάρκεια του Β΄ 

Παγκοσμίου Πολέμου και η εφεύρεση αυτή δόθηκε για χρήση στο ευρύ κοινό το 1948. Με το τέλος 

του Β’ Παγκοσμίου Πολέμου, η ανάγκη για ηλεκτρικές οικιακές συσκευές προσιτές στο πρώην 

καταπιεσμένο ευρύ κοινό αυξάνεται.  

 

 
Εικόνα 5: Ταμπέλα της εταιρίας του Edison (Edison Electric Light Co.) 1878 

 

Φτάνουμε στην εποχή του Ψυχρού Πολέμου. Η επικοινωνία διαδραματίζει πρωτεύοντα ρόλο στην 

διαμάχη των Σοβιετικών με τους Αμερικανούς. Το 1956 ο αμερικανικός στρατός κοινοποιεί την 

πατέντα για την «Επεξεργασία της Συναρμολόγησης Ηλεκτρικών Κυκλωμάτων». Καθίσταται εφικτό 

έτσι για τις κατασκευάστριες εταιρίες να έχουν μία τυποποιημένη μέθοδο, για να κρατούν τα 

ηλεκτρονικά στοιχεία και να τα συνδέουν μεταξύ τους με μεταλλικές οδούς. Η καινοτομία και η 

τεχνολογική εξέλιξη είναι αναπόφευκτες, ο αγώνας για την εξερεύνηση του διαστήματος έχει 

ξεκινήσει και καμία από τις δύο συνεχόμενα αντικρουόμενες πλευρές δεν δέχεται να μείνει πίσω από 

την σκιά της άλλης. 
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Το 1963 η εταιρία Hazeltyne καταθέτει πατέντα περιγράφοντας την τεχνολογία επιμεταλλωμένων 

οπών (plated through-hole technology) (Εικόνα 6). Επίσης, η IBM εισαγάγει την τεχνολογία τύπου 

SMT (Surface Mount Technology).  

 

 

 

 

Τη δεκαετία του 70, συναντάμε τον πρώτο μικροεπεξεργαστή στην μορφή του ολοκληρωμένου 

κυκλώματος (Integrated Circuit – IC). Το πρώτο IC αρχικά δημιουργήθηκε από τον Jack Kilby 

στην γνωστή σε όλους μας Texas Instruments (TI) το 1958. Όταν οι προϊστάμενοι και πιο έμπειροι 

μηχανικοί συνάδελφοι του Kibly έπρεπε για μία εβδομάδα να λείψουν από την εταιρία για ένα 

συνέδριο, εκείνος βρήκε τον χώρο να αναπτύξει την ιδέα του. Όταν εκείνοι γύρισαν από το συνέδριο 

αφουγκράστηκαν την ιδέα του Kibly και έκτοτε, τα ολοκληρωμένα κυκλώματα αποτελούν 

αναπόσπαστο κομμάτι της βιομηχανία και όλων των εφαρμογών των ηλεκτρονικών. 

 

Εικόνα 6: Απεικόνιση από την πατέντα που 

κατέθεσε η Hazeltyne το 1963 
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Εικόνα 7: Ο Jack Kilby κρατώντας το πρώτο ολοκληρωμένο κύκλωμα 

 

Η ψηφιακή εποχή δεν αργούσε να έρθει, προαναγγέλλοντας μεγάλες και τρομακτικές αλλαγές στην 

ανθρώπινη κοινωνία σχετικά με το πώς ο μέσος άνθρωπος θα κατανάλωνε πολυμέσα, από τις 

προσωπικές του πλέον συσκευές, που εισήχθησαν σταδιακά σε όλη την αγορά. Παιχνιδομηχανές, 

κάμερες, βιντεοκασέτες καθώς και συσκευές αναπαραγωγής τους, συσκευές αναπαραγωγής μουσικής 

εισέβαλαν στις ζωές των ανθρώπων.  

Ο σχεδιασμός των τυπωμένων κυκλωμάτων PCB γινόταν ακόμα στο χέρι, με την χρήση ενός 

φωτιζόμενου πίνακα και στένσιλ (Εικόνα 8). Λογισμικά EDA (Electronic Design Automation) θα 

εισέρθουν μετέπειτα στην βιομηχανία. Λογισμικά όπως το Protel και το EAGLE, θα αλλάξουν 

τελείως τον τρόπο με τον οποίο σχεδιάζονται οι τυπωμένες πλακέτες. Αντί για την χρήση, 

κυριολεκτικά, φωτογραφιών των πλακετών, η νέα μέθοδος προκρίνει την αποθήκευση των σχεδίων 

σε αρχεία κειμένου Gerber. Οι συντεταγμένες που περιγράφουν τα αρχεία αυτά, μπορούν και 

εισάγοντα πολύ πιο εύκολα σε μηχανές κατασκευής πλακετών. Έτσι επιτυγχάνεται καλύτερη 

πιστότητα, μεγαλύτερη ταχύτητα στην διαδικασία παραγωγής και φυσικά πολύ πιο γρήγορος 

σχεδιασμός, μιας και οι αλλαγές είναι πολύ πιο εύκολες σε ένα αρχείο ηλεκτρονικού υπολογιστή, 

παρά σε ένα «φωτογραφικό φιλμ». 
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Εικόνα 8: Σχεδιάζοντας μία τυπωμένη πλακέτα την δεκαετία του 1960 

 

Η δεκαετία του ’90, πιο κοντά στην δική μας, χαρακτηρίζεται και ως η εποχή του ίντερνετ. 

Παρατηρούμε πολύ ευρεία μονοκρυσταλλικής σιλικόνης για την κατασκευή ημιαγωγών και 

ολοκληρωμένων κυκλωμάτων BGA (Ball Grid Array). Περισσότερες πύλες μπορούν να χωρέσουν σε 

ένα και μόνο τσιπ, όπου πλέον μπορούν να ενσωματωθούν μνήμες και συστήματα σε τσιπ (System on 

Chip). Η βιομηχανία οδεύει όλο και περισσότερο στα ολοκληρωμένα κυκλώματα (IC). Οι σχεδιαστές  

πλέον χρησιμοποιούν στρατηγικές σχεδιασμού για τεστ (DFT – Design for Test) στις διατάξεις τους. 

Πρέπει, δηλαδή, πλέον να προνοούν για μελλοντικές αλλαγές κατά την διάρκεια του σχεδιασμού. Οι 

ηλεκτρονικές πλακέτες διέρχονται στην περίοδο της σμίκρυνσης, χάρη στα ολοκληρωμένα 

κυκλώματα. Μικρότερα μεγέθη πακέτων (packages) κατακλύζουν τα ηλεκτρονικά σχέδια των 

πλακετών, μιας και προσφέρουν σχεδόν τα ίδια χαρακτηριστικά με πολύ μικρότερο αποτύπωμα 

επάνω στην πλακέτα. Δημιουργείται χώρος, έτσι, για τον σχεδιασμό μεγαλύτερων και 

πολυπλοκότερων συστημάτων επάνω στις πλακέτες, κρατώντας, όμως, το συνολικό μέγεθος της 

τελικής πλακέτας ίδιο. Βέβαια ένα αποτέλεσμα που επιφέρει η κατάληξη αυτή, είναι το να γίνεται 

πλέον όλο και πιο δύσκολη η αποσυναρμολόγηση ή η συναρμολόγηση μίας πλακέτας ως προς τα 

στοιχεία της. Ας μην ξεχνάμε πως είμαστε ήδη στην τεχνολογία Surface Mount (SMT). Τα μικρότερα 

πακέτα υλικών που κυκλοφορούν (0402) γίνονται όλο και πιο δύσκολα ορατά στο γυμνό μάτι. 

Αντίστοιχα, σχεδόν αδύνατη είναι και η κόλληση με το χέρι των στοιχείων αυτών στις πλακέτες. 
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Ειδικά μηχανήματα παραγωγής είναι απαραίτητα για την κατασκευή των πλακετών και την κόλληση 

των στοιχείων. Ο σχεδιαστής των ηλεκτρονικών κυκλωμάτων ασχολείται μόνο με το λογισμικό 

σχεδιασμού και ο κατασκευαστής είναι αυτός που διαχειρίζεται την παραγωγή και την 

συναρμολόγηση. 

 
Εικόνα 9: Διάφορα στοιχεία τύπου SMT 

 

Με την αλλαγή της χιλιετίας, μπαίνουμε στην λεγόμενη εποχή των υβριδίων. Παλαιότερα, κάθε 

συσκευή είχε ως στόχο την ικανοποίηση μίας ανάγκης, την επίλυση ενός και μόνο προβλήματος. 

Πλέον δεν χρειάζεται να έχει κάποιος μαζί του μία ψηφιακή κάμερα, μία συσκευή αναπαραγωγής 

μουσικής, μία ψηφιακή συσκευή πλοήγησης, μία παιχνιδομηχανή, μία συσκευή καταγραφής φωνής, 

κτλ. Με ένα σύγχρονο smartphone (κινητό τηλέφωνο), οι παραπάνω συσκευές - λειτουργίες - ανάγκες 

καλύπτονται από μία και μόνο συσκευή. Βρισκόμαστε σε μία εποχή όπου οι συσκευές μας αρχίζουν 

να συνδυάζονται. Με την αύξηση της πολυπλοκότητάς τους, μπορούν πλέον να κάνουν περισσότερα 

πράγματα, να εκτελούν περισσότερες διεργασίες, να καλύπτουν περισσότερες ανάγκες. 

 

Οι πλακέτες τυπωμένων κυκλωμάτων (PCBs) έχουν εδραιωθεί ολοκληρωτικά στην βιομηχανία και 

στις ζωές των ανθρώπων. Η βιομηχανία έχει δημιουργήσει αυτοματοποιημένες διαδικασίες σχεδόν 

για τα πάντα. Πλέον οι σχεδιαστές πλακετών είναι λιγότεροι σε αριθμό σε σχέση με αυτούς που 

υπήρχαν κατά τις προηγούμενες γενιές. Ίσως το μέλλον του PCB να βρίσκεται στην ρομποτική, ή σε 

ευλύγιστα κυκλώματα που μπορούν να φορεθούν (wearables). Ίσως αντί να βασιζόμαστε σε 

ηλεκτρόνια για την μετάδοση πληροφοριών να χρησιμοποιούμε φωτόνια, κάτι που εν μέρει 

χρησιμοποιείται και σήμερα για την μετάδοση μεγάλου όγκου και ρυθμού δεδομένων στον τομέα των 

δικτύων. Ζεύξεις μεταξύ μεγάλων αλλά και μικρότερων κέντρων δεδομένων (datacenters) 

πραγματοποιούνται ήδη με οπτικές ίνες. Μεγάλες ταχύτητες και ρυθμοί μετάδοσης δεδομένων που 

δεν είναι εφικτοί με μέσα μετάδοσης όπως ο χαλκός σε μεγάλες αποστάσεις, είναι εφικτά με οπτικά 

καλώδια. 

Η κοινωνία και η ανθρωπότητα γενικότερα κατευθύνεται στην εποχή «της ταχύτητας», όπου όλα 

είναι γρήγορα και σχεδόν στιγμιαία. Το πλήθος των καταναλωτών-χρηστών μεγαλώνει και απαιτεί 

γρηγορότερες ταχύτητες, γρηγορότερη εκτέλεση των διεργασιών και γρηγορότερη σύνδεση με 

μεγάλα κέντρα δεδομένων. Η ιστορία της σταθερής τηλεφωνίας επαναλαμβάνεται με πρωταγωνιστή 

την σύνδεση στο διαδίκτυο. Περισσότερα και πιο ευέλικτα datacenter θα είναι αναγκαία για την 

εξυπηρέτηση των χρηστών και θα βιώσουμε την αποκεντροποίηση του διαδικτύου. 
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1.2.  Τεχνικές κατασκευής πλακετών τυπωμένων κυκλωμάτων 

Ως πλακέτα τυπωμένου κυκλώματος ορίζεται μία μηχανική υποστήριξη και ηλεκτρική σύνδεση 

ηλεκτρονικών ή ηλεκτρικών στοιχείων. Χρησιμοποιεί αγώγιμες οδεύσεις (tracks) και άλλες τεχνικές 

από χαλκό, ο οποίος είναι τοποθετημένος πάνω σε μη αγώγιμο υλικό (υπόστρωμα). Τα στοιχεία 

είθισται να κολλιούνται πάνω στην πλακέτα με σκοπό την ηλεκτρική σύνδεση αλλά και την μηχανική 

υποστήριξη. Οι τυπωμένες αυτές πλακέτες μπορούν να υποστηρίξουν πολλαπλά επίπεδα χαλκού 

ενδιάμεσα στο υπόστρωμα ή καλύτερα σε επίπεδα υποστρώματος, πέρα από το επάνω και κάτω 

επίπεδο χαλκού που τοποθετούνται στα εξωτερικά του υποστρώματος. Χαρακτηριστικά παρατίθεται 

και παρακάτω εικόνα από την κατασκευάστρια εταιρεία πλακετών τυπωμένων κυκλωμάτων 

Eurocircuits, στην οποία περιγράφονται τα προαναφερθέντα (Εικόνα 10) 

 

 
Εικόνα 10: Τομή μίας πλακέτας και επεξήγηση στρώσεων 

 

Από ότι βλέπουμε και στην παραπάνω εικόνα, ένα PCB μπορεί να είναι μονής όψης, με μία στρώση 

χαλκού επάνω στο υπόστρωμα, διπλής όψης, με δύο στρώσεις χαλκού συνολικά επάνω στο 

υπόστρωμα, μία στην κάθε πλευρά ή πολλαπλών επιπέδων, με πολλαπλές στρώσεις στο εσωτερικό 

του υποστρώματος πέραν των εξωτερικών πλευρών (άνω και κάτω). Τα PCBs πολλαπλών επιπέδων 

επιτρέπουν προφανώς τη μεγαλύτερη πυκνότητα υλικών επάνω στην πλακέτα. Τα εσωτερικά 

στρώματα χαλκού, επικοινωνούν με τα υλικά μέσω επιμεταλλωμένων οπών που διαπερνούν το 

υπόστρωμα.  

Το πιο διαδεδομένο υπόστρωμα είναι το FR-4. Πρόκειται για ένα συνθετικό πολυστρωματικό εποξικό 

υλικό, ενισχυμένο με γυαλί. Τα γράμματα FR στο όνομα του υλικού, είναι συντομογραφία των 

λέξεων flame retardant. Βέβαια το ότι το όνομά του εμπεριέχει τις λέξεις flame retardant, δεν το 
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καθιστά συμμορφωμένο με το standard UL94V-0, εκτός βέβαια αν προηγηθεί εργαστηριακός έλεγχος 

σύμφωνα με τον τρόπο διεξαγωγής της δοκιμής και τα όρια που επιβάλει ο άτυπα υποχρεωτικός 

κανονισμός για την εμπορία ηλεκτρονικών συσκευών. 

 

Για την κατασκευή πλακετών, ακολουθούνται συνήθως τα παρακάτω βήματα: 

 

 PCB CAM  

Στο πρώτο αυτό βήμα, δημιουργείται το ηλεκτρονικό σχέδιο CAD (Computer Aided Design), 

που προήλθε από κάποιο πρόγραμμα σε ηλεκτρονικό υπολογιστή. Το σχέδιο αυτό, 

μεταφέρεται σε ένα πρόγραμμα CAM (Computer Aided Manufacturing), όπου και 

συμβαίνουν τα εξής: 

o Ανάγνωση των δεδομένων κατασκευής. 

o Επικύρωση/επαλύθεση των δεδομένων. 

o Εισαγωγή διορθώσεων για τις ανοχές της κατασκευαστικής διαδικασίας (αλλαγή 

κλίμακας για διόρθωση στραυλώσεων κατά την παρασκευή των λεπτών ελασμάτων 

χαλκού). 

o Εξαγωγή αρχείων σχετικών με το τελικό σχέδιο του χαλκού επάνω στο πάνελ, αρχεία 

σχετικά με τις οπές (θέση, βάθος, διάμετρος), κ.λ.π. 

o Δημιουργία πάνελ. 

Εδώ αξίζει να σημειώσουμε πως αρκετές πλακέτες ίδιες ή και διαφορετικές, μπορούν 

να ενωθούν κατά την διαδικασία παραγωγής, με σκοπό να τις μεταχειριστούν σαν 

ένα πάνελ, ένα μεγαλύτερο σύνολο δηλαδή πλακετών, κάτι που βοηθά αρκετά κατά 

την διαδικασία της παραγωγής. 

 

 Διαμόρφωση χαλκού 

Από το αρχείο που εξάγεται μέσω του CAM, προκύπτει ένα σχέδιο/μοτίβο για τον χαλκό, το 

οποίο θα πρέπει να αντιγραφεί επάνω σε μία προστατευτική «μάσκα», η οποία με την σειρά 

της θα τοποτετηθεί επάνω στο φύλλο χαλκού. Περιττά κομμάτια χαλκού θα αφαιρεθούν σε 

επόμενα βήματα από τη διαδικασία απόχάλκωσης που θα ακολουθήσει. Η δημιουργία της 

προστατευτικής μάσκας γίνεται με τους παρακάτω τρόπους: 

o Εκτύπωση μεταξοτυπίας: Χρησιμοποιείται ειδικό μελάνι που δεν διαβρώνεται κατά 

τη διαδικασία της απόχάλκωσης και δημιουργείται έτσι μία προστατευτική «μάσκα». 

o  Προβολή του ηλεκτρονικού σχεδίου της πλακέτας σε φωτοευαίσθητο υλικό για τη 

δημιουργία προστατευτικής «μάσκας». 

o Επικάλυψη της πλακέτας με ειδική μαύρη μπογιά και στην συνέχεια χρήση λέιζερ για 

την αφαίρεση μπογιάς. 

Εναλλακτικά και κυρίως για λόγους δημιουργίας προτοτύπων, τα ανεπιθύμητα κομμάτια 

χαλκού, μπορούν να αφαιρεθούν με την χρήση των παρακάτω μέσων:  

o Απόμάκρυνση ανεπιθύμητων κομματιών χαλκού με χρήση κονδυλίων κοπής 

(milling). Χρησιμοποιείται CNC δύο ή τριών αξόνων. 

o Απόμάκρυνση κομματιών χαλκού με χρήση λέιζερ. 
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1.3.  Τεχνολογίες γραμμών μεταφοράς 

Έχοντας δει συνοπτικά τα υλικά και τις τεχνικές κατασκευής πλακέτας, ήρθε η ώρα να μιλήσουμε και 

για τον τρόπο σχεδιασμού τους. Αναφέρομαι ειδικότερα στην επιλογή του τύπου των αγώγιμων 

οδεύσεων, στον τύπο γραμμής μεταφοράς που θα επιλεγεί. Οι γραμμές μεταφοράς που 

χρησιμοποιούνται συνήθως για την κατασκευή κυκλωμάτων με ψηφιακά σήματα υψηλής ταχύτητας, 

κυκλωμάτων ραδιοσυχνότητας (RF) και μικροκυματικών κυκλωμάτων είναι οι επίπεδες γραμμές 

μεταφοράς (planar transmission lines). Η γραμμή μεταφοράς που χρησιμοποιείται συνήθως είναι η 

μικροταινία (microstrip). Ο λόγος για τον οποίο η μικροταινία είναι αρκετά δημοφιλής είναι ο 

εύκολος τρόπος παρασκευής της, κάτι που διευκολύνει τη μαζική παραγωγή πλακετών.  

 

Υπάρχουν δύο μεγάλες κατηγορίες επίπεδων γραμμών μεταφοράς, όπως φαίνεται και στην παρακάτω 

εικόνα (Εικόνα 11), οι ομοιογενείς και οι ανομοιογενείς. 

Οι γραμμές μεταφοράς, μπορούν να χωριστούν στις δύο αυτές μεγάλες κατηγορίες ανάλογα με την 

ομοιογένεια του μέσου που πλαισιώνει την γραμμή μεταφοράς. Αν το ενσωματωμένο μέσο είναι 

ομοιογενές, η γραμμή μεταφοράς χαρακτηρίζεται ως ομοιογενής. Αν υπάρχουν δύο ή περισσότερες 

περιοχές με διαφορετική επιτρεπτότητα (permittivity), τότε η γραμμή μεταφοράς χαρακτηρίζεται ως 

ανομοιογενής. 

 

 
Εικόνα 11: Ομοιογενείς και ανομοιογενείς γραμμές μεταφοράς 

ε0 

εr 

εr 

εr 

ε0 

εr 

ε0 

εr 

ε0 

εr 
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Στις ομοιογενείς γραμμές μεταφοράς, τα πεδία βρίσκονται σε επίπεδο κάθετο από την κατεύθυνση 

διάδοσης. Οι γραμμές μεταφοράς, στις οποίες τα πεδία που δημιουργούνται κατά μήκος της 

κατεύθυνσης διάδοσης μπορούν να θεωρηθούν αμελητέα, χαρακτηρίζονται και σαν γραμμές 

μεταφοράς που υποστηρίζουν ρυθμό μετάδοσης TEM (Transverse Electro-Magnetic). 

 

 
Εικόνα 12: Ρυθμός μετάδοσης TEM 

 

Εν συνεχεία, ακολουθεί συνοπτικά αναφορά στις γραμμές μεταφοράς. 

 

1.3.1. Stripline  

Πρόκειται για γραμμή μεταφοράς που υποστηρίζει τον ρυθμό μετάδοσης ΤΕΜ (Transverse Electro-

Magnetic) και εφευρέθηκε την δεκαετία του 1950 από τον Robert M. Barrett. Αποτελεί ουσιαστικά 

την πρώτη μορφή επίπεδης γραμμής μεταφοράς, μιας και πρόκειται για εξέλιξη του ομοαξονικού 

καλωδίου. 

 

  
Εικόνα 13: Εξέλιξη του Stripline 

Ηλεκτρικό πεδίο 

Μαγνητικό πεδίο 

Κατεύθυνση Διάδοσης 
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Όπως φαίνεται και στην παραπάνω εικόνα (Εικόνα 13), πρόκειται για έναν αγωγό που βρίσκεται 

ανάμεσα σε δύο στρώσεις διηλεκτρικού υλικού, ανάμεσα σε δύο ground planes. Δεδομένου ότι ο 

ρυθμός μετάδοσης είναι TEM, όπως αντίστοιχα θα ήταν και σε έναν κυματοδηγό, δεν παρατηρείται 

διασπορά. Τυχόν στοιχεία ασυνέχειας της γραμμής μεταφοράς όπως κενά ή ανοιχτά στελέχη (open 

stubs) παρουσιάζουν καθαρά σύνθετη αντίσταση μεταβλητή στην συχνότητα (reactive impedance).  

 
Εικόνα 14: Τομή πλακέτας με Stripline (α) 

 

Για μία συμμετρική stripline, όπως αυτή φαίνεται στην παρακάτω εικόνα (Εικόνα 16: Τομή 

πλακέτας με Stripline (γ)]), φάρδους w, πάχους t, με ύψος διηλεκτρικού b, η ενεργή διηλεκτρική 

σταθερά είναι ίση με την σχετική διηλεκτρική σταθερά του εκάστοτε διηλεκτρικού υλικού εr που έχει 

χρησιμοποιηθεί για την κατασκευή της stripline. 

 

 
Εικόνα 15: Τομή πλακέτας με Stripline (β) 

 

 
Εικόνα 16: Τομή πλακέτας με Stripline (γ) 

 

Η συνάρτηση για τον υπολογισμό της χαρακτηριστικής αντίστασης, για μία stripline  είναι η 

παρακάτω:
1 

   
   

   

  
 
 

            
 

Όπου: 

                                                      
1
 Steer, M. (2019). Microwave and RF Design Transmission Lines. NC State University p.152 

C’f 

C’f 

C’f 

C’f 

εr 

εr 
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Και:  

   
 

 
   

 

  
 
 

    
 

  
   

 

        
    

 

Ως Cf, ορίζουμε την πυκνότητα στις γωνίες της γραμμής, λεγόμενη και περιθωριακή (fringing 

capacitance). Η Cf ισχύει για πάχος ταινίας t<<b. Η περιθωριακή πυκνότητα    υπολογίζεται από την 

παρακάτω σχέση:
2
 

    
      

     
 

 

Στην περίπτωση που θεωρούμε μηδενικό το πάχος της stripline, η χαρακτηριστική αντίστασή της 

υπολογίζεται από τις σχέσεις
2
: 

 

   
   

   

 

              
 

Όπου: 

    

 
 

 

 
       

 

 
 
 

    
 

 
                      

 

 
       

 

 
     

  

 

Και η περιθωριακή πυκνότητα της γραμμής ισούται με: 

              

 

 

1.3.2. Microstrip 

Η μικροταινία είναι η πιο εύκολη γραμμή μεταφοράς ως προς την κατασκευή της. Πρόκειται για ένα 

λεπτό σχετικά διηλεκτρικό υλικό με μέταλλο και στις δύο πλευρές του. Το μέταλλο σε μία από τις 

δύο πλευρές θα χρησιμοποιηθεί σαν ηλεκτρική γη, ενώ το μέταλλο της άλλης πλευράς μετά την 

φωτολιθογραφία που θα υποστεί και την χημική ίσως κατεργασία, θα χρησιμοποιηθεί για την 

δημιουργία αγωγών διέλευσης ηλεκτρικών σημάτων. Αν και πρόκειται για μία αρκετά απλή 

γεωμετρική κατασκευή, τα ηλεκτρομαγνητικά πεδία που δημιουργούνται είναι αρκετά σύνθετα και 

δεν μπορούν εύκολα να καθοριστούν αναλυτικά.  

                                                      
2
 ό.π. , pp.152-153 
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Εικόνα 17: Τομή πλακέτας με Microstrip (α) 

 

Όπως παρατηρούμε στην παραπάνω εικόνα (Εικόνα 17), μέρος του πεδίου βρίσκεται στον αέρα και 

στο διηλεκτρικό υλικό ανάμεσα στην ταινία και στην ηλεκτρική γη. Πρακτικά, το ύψος του 

διηλεκτρικού υλικού είναι πολύ μικρότερο του μήκους κύματος του σήματος που διανύει τον αγωγό. 

Στις περιπτώσεις αυτές το εγκάρσιο πεδίο είναι κυρίαρχο και τα πεδία αποκαλούνται quasi-TEM.  

 

Η συνάρτηση για τον υπολογισμό της χαρακτηριστικής αντίστασης, για μικροταινία όπου:  

 

 
Εικόνα 18: Τομή πλακέτας με Microstrip (β) 

 

 

 το πάχος του αγωγού t θεωρείται αμελητέο σε σύγκριση με το ύψος του διηλεκτρικού υλικού 

h (t/h < 0.005). 

 φάρδος w είναι μικρότερο του ύψους του διηλεκτρικού υλικού h (w/h <1) είναι η παρακάτω:
3
 

   
  

       
    

 

 
 

 

  
  

Όπου σαν Ζf ορίζεται: 

    
  

  
        

Και ως εeff ορίζεται: 

     
    

 
 

    

 
      

 

 
 

  
  

        
 

 
 
 

  

 

  

                                                      
3
 Bahl L J. and Trivedi D. K. (1977), A Designer's Guide to Microstrip Line, Microwaves, pp. 174-182 

εr 
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Οι παραπάνω σχέσεις στην περίπτωση κατά την οποία το φάρδος w της μικροταινίας είναι 

μεγαλύτερο του ύψους του διηλεκτρικού υλικού h αλλάζουν και ισχύουν οι παρακάτω:
3
 

 

   
  

            
 
 

 
 
 
   

 
 

        

 

Όπου και πάλι το Zf ορίζεται: 

    
  

  
        

Και ως εeff ορίζεται: 

     
    

 
 

    

 
     

 

 
 

  
  

 

 

Υπενθιμίζουμε ωστόσο πως και στις δύο περιπτώσεις το πάχος του αγωγού θεωρείται αμελητέο σε 

σύγρικση με το ύψος του διηλεκτρικού υλικού. 
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1.3.3. Coplanar Waveguide (CPW) 
Μπορεί η μικροταινία να είναι το πιο διαδεδομένο και ευρέως χρησιμοποιούμενο μέσο για τον 

σχεδιασμό κυκλωμάτων σε συχνότητες που κυμαίνονται από μερικά εκατοντάδες megahertz έως και 

δεκάδες gigahertz, ωστόσο τα ηλεκτρικά χαρακτηριστικά της επιρρεάζονται πολύ από το ύψος του 

διηλεκτρικού υλικού. Τυχόν διαφορές από τις υπολογισμένες προδιαγραφές, έχουν ως απότέλεσμα 

αλλαγές στην συμπεριφορά του εκάστοτε κυκλώματος, μιάς και ανάλογα με την διαφοροποίηση στο 

ύψος του διηλεκτρικού υλικού, αντίστοιχη θα είναι και η διαφορά της χαρακτηριστικής αντίστασης 

της μιρκοταινίας. Μία λύση στο πρόβλημα αυτό που προκαλείται με την χρήση μικροταινίας, είναι η 

χρήση CPW για τον σχεδιασμό των ηλεκτρικών αγωγών.  

 
Εικόνα 19 : Τομή πλακέτας με Coplanar Waveguide (α) 

 

Πρόκειται για έναν κεντρικό αγωγό, στις πλευρές του οποίου βρίσκονται μεταλλικά επίπεδα που 

φέρουν το επιστρεφόμενο ρεύμα. Οι εξωτερικοί αγωγοί μπορούν να θεωρηθούν και σαν ηλεκτρική γη 

αν και δεν είναι απαραίτητο να είναι συνδεδεμένοι σε αυτή. Όπως φαίνεται και στην παραπάνω 

εικόνα (Εικόνα 19), τα πεδία στην CPW διαιρούνται σχεδόν το ίδιο ανάμεσα στον αέρα επάνω από το 

επίπεδο των αγωγών και στο διηλεκτρικό υλικό που τα υποστηρίζει, ειδικά για τις περιπτώσεις όπου 

το κενό ανάμεσα στον κεντρικό αγωγό και στους πλευρικούς αγωγούς είναι μικρό σε σχέση με το 

πάχος του διηλεκτρικού υλικού. 

Τα ηλεκτρικά χαρακτηριστικά του συνεπίπεδου κυματοδηγού CPW εξαρτώνται εξολοκλήρου από τις 

πλευρικές διαστάσεις, δεδομένου βέβαια ότι το πάχος του διηλεκτρικού υλικού είναι αρκετά μεγάλο. 

Πρακτικά, το ύψος h όπως φαίνεται και στην εικόνα (Εικόνα 20) είναι δύο ή και τρείς φορές 

μεγαλύτερο από το σύνολο του πλάτους w της γραμμής μεταφοράς και του πλάτους του κενού s 
ανάμεσα στην γραμμή μεταφοράς και στους πλευρικούς αγωγούς που φέρουν τον ρόλο της 

ηλεκτρικής γης. 

 

 
Εικόνα 20: Τομή πλακέτας με Coplanar Waveguide (β) 

  

  

εr 



27 

Μεταπτυχιακή Διπλωματική Εργασία, Διονύσης Δεληγιαννόπουλος, ΑΜ: IES-0015 

Στην πραγματικότητα βέβαια, οι πλευρικοί αγωγοί έχουν πεπερασμένες διαστάσεις, οπότε και ένα πιο 

ρεαλιστικό μοντέλο θα μπορούσε δυνητικά να ήταν και το παρακάτω με πλάτος πλευρικών αγωγών 

w1: 

 

 
Εικόνα 21: Τομή πλακέτας με Coplanar Waveguide (γ) 

 

Η συνάρτηση για τον υπολογισμό της χαρακτηριστικής αντίστασης είναι:
4
 

 

   
   

     

     

    
 

Όπου: 

                             
 

 
          

 

 
                                    

 

Με  

  
 

    
 

 

Τα K(k) και K(k’) πρόκειται για ολοκληρώματα υπολογισμού εμβαδού έλλειψης (elliptic integrals), 

ωστόσο, ο λόγος τους υπολογίζεται από τις παρακάτω συναρτήσεις:
4
 

 

    

     
 

 

 
    

    

    
                   

  

     

    
 

 

 
    

     

     
                   

Και  

           
 

Παρατηρούμε πως η χαρακτηριστική αντίσταση Ζ0 καθορίζεται από τον λόγο του πλάτους w του 

κεντρικού αγωγού, προς την απόσταση s του κενού που υπάρχει ανάμεσα στον κεντρικό και τους 

πλευρικούς αγωγούς. Αυτό προσθέτει ένα μεγάλο βαθμό ευελιξίας κατά την διαδικασία του 

σχεδιασμού. 

 

  

                                                      
4
 Steer, M. (2019). Microwave and RF Design Transmission Lines. NC State University, p.156. 

εr 
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Εικόνα 22: Τομή πλακέτας με Grounded Coplanar Waveguide (α) 

1.3.3. Grounded Coplanar Waveguide (GCPW) 

Ουσιαστικά πρόκειται για μία διαφορετική εκδοχή του CPW, με την προσθήκη ηλεκτρικής γης κάτω 

από το διηλεκτρικό υλικό και την πλευρά όπου βρίσκονται οι ηλεκτρικοί αγωγοί. Ονομάζεται και 

finite ground-plane coplanar waveguide (FGCPW). Προτιμάται σε σύγκριση με την μικροταινία όταν 

το πάχος του διηλεκτρικού υλικού είναι αρκετά μεγάλο. Η χρήση του GCPW έχει αρχίσει να γίνεται 

όλο και πιο συχνή στον σχεδιασμό πλακετών καθώς πρωτόκολλα επικοινωνίας όπως το WiFi και το 

Bluetooth είναι όλο και πιο συχνά στις περισσότερες κατασκευές και προϊόντα πλέον. 

Μερικά από τα πλεονεκτήματα του GCPW είναι τα ακόλουθα: 

 

 Χαμηλότερες απώλειες: Το μεγαλύτερο μέρος του ηλεκτρικού πεδίου διέρχεται μέσω του 

αέρα και όχι μέσα από το διηλεκτρικό υλικό που φέρει απώλειες. Κάτι τέτοιο συμβάλει στη 

χρήση λιγότερο ακριβού υλικού για την κατασκευή πλακετών.  

 

 Ισχυρότερη απομόνωση σήματος: Σε συνδυασμό με τη χρήση vias πλευρικά του κεντρικού 

αγωγού έχουμε ως αποτέλεσμα την συγκράτηση των γραμμών των πεδίων κοντά στον 

κεντρικό αγωγό χωρίς πολλές απώλειες. 

 

Εικόνα 23: Τομή πλακέτας με Grounded Coplanar Waveguide (β) 

 

 Ευελιξία στον σχεδιασμό: Η σύνθετη αντίσταση στο GCPW καθορίζεται κατά κύριο λόγο 

από το κενό ανάμεσα στον κεντρικό αγωγό και στις πλευρικές επιφάνειες ηλεκτρικής γης. 

 

 Χαμηλότερες απώλειες λόγο άγριας επιφάνειας χαλκού: Στην μικροταινία για παράδειγμα 

παρατηρούμε επιδερμικό φαινόμενο με το περισσότερο ρεύμα να μεταφέρεται στην κάτω 

πλευρά του ηλεκτρικού αγωγού (επάνω στο διηλεκτρικό υλικό), η πλευρά αυτή όμως από 

κατασκευής είναι πιο τραχιά. Σε αντίθεση, στο GCPW παρατηρείται ότι το ρεύμα 

συγκεντρώνεται στις άκρες του χαλκού όπου και η επιφάνεια είναι πιο ομαλή.  
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Εικόνα 24: Εικόνα από τρισδιάστατο μοντέλο πλακέτας 

 

 Ευκολότερη τοποθέτηση παθητικών στοιχείων για την βοήθεια στην προσαρμογή της 

γραμμής: Στην περίπτωση του GCPW, τα κομμάτια χαλκού πλευρικά από τον κεντρικό 

αγωγό, μιας και λειτουργούν σαν ηλεκτρική γη, χρησιμεύουν στην ευκολότερη τοποθέτηση 

παθητικών στοιχείων (πυκνωτές, πηνία) παράλληλα της γραμμής μεταφοράς. Κάτι τέτοιο 

απορρίπτει την παρεμβολή που θα υπήρχε στην περίπτωση της μικροταινίας, μίας και η 

σύνδεση του εκάστοτε παθητικού στοιχείου με την ηλεκτρική γη, θα απαιτούσε την χρήση 

via. 

 

  

Εικόνα 25: Τομή πλακέτας με Grounded Coplanar Waveguide (γ) 

Οι συναρτήσεις που χρησιμοποιούμε για τον υπολογισμό της χαρακτηριστικής αντίστασης στο 

GCPW, για πάχος κεντρικού αγωγού w, απόσταση κεντρικού αγωγού και πλευρικών αγωγών s, αλλά 

και ύψος h διηλεκτρικού υλικού είναι οι παρακάτω:
5
 

   
   

     

 

    
     

 
     
      

 

Όπου:  

     
    

     
    

     
      

  
     
    

     
      

 

 

Και: 

  
 

    
 

 

   
     

   
   

 

     
      

   
 
 

 

Τα K(k) και K(k’) πρόκειται για ολοκληρώματα υπολογισμού εμβαδού έλλειψης (elliptic integrals) 

και ο λόγος τους υπολογίζεται από τις παρακάτω συναρτήσεις:
5
 

 

                                                      
5
 Brian, C. Wadell (1991). Transmission Line Design Handbook. Artech House p.79. 
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Ενώ: 

           ,                    ,              ,                 
    

 

 

 

1.4. Wilkinson Combiner/Divider 

Εφευρέθηκε το 1960 από τον μηχανικό Ernest Wilkinson και, πρόκειται για έναν 

«διαμοιραστή»/διαχωριστή ισχύος, που πετυχαίνει ταυτόχρονα  υψηλά επίπεδα απομόνωσης μεταξύ 

των δύο εξόδων του, P2 και P3 όπως φαίνεται και στην παρακάτω εικόνα, ενώ παράλληλα 

εξακολουθεί να πετυχαίνει προσαρμογή και στις τρείς θύρες του P1, P2, P3. 

 
Εικόνα 26: Ο Wilkinson Combiner/Divider 

  

 

Δεδομένου ότι κατασκευάζεται και αποτελείται από παθητικά στοιχεία, μπορεί να χρησιμοποιηθεί και 

ως αθροιστής ισχύος σε σήματα βέβαια που έχουν την ίδια φάση.  

Η αντίστοιχη σχηματική αναπαράσταση τους κυκλώματος είναι η παρακάτω: 
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Εικόνα 27: Ισοδύναμο κύκλωμα του Combiner/Divider 

 

 

Για να αναλύσουμε το παραπάνω κύκλωμα, θα το σχεδιάσουμε συμμετρικό οριζόντια. Θα 

κανονικοποιήσουμε ως προς Ζ0 και θα χρησιμοποιήσουμε πηγές τάσης στις εξόδους P2 και P3. 

Στην είσοδο του κυκλώματος (P1) θα παρουσιάσουμε δύο αντιστάσεις τιμής 2. Παράλληλα αυτές οι 

αντιστάσεις θα έχουν τιμή 1, ίση δηλαδή με Ζ0. Οι δύο γραμμές μεταφοράς μήκους λ/4 θα έχουν 

κανονικοποιημένη τιμή r . 

Συνοψίζοντας έχουμε:
6
 

           

                                                      
6
 David, M. Pozar (2012). Microwave Engineering. Hamilton Printing p. 328. 



32 

Μεταπτυχιακή Διπλωματική Εργασία, Διονύσης Δεληγιαννόπουλος, ΑΜ: IES-0015 

 
Εικόνα 28: Even και Odd mode 

 

Για την ανάλυση του κυκλώματος θα ορίσουμε δύο λειτουργίες του παραπάνω κυκλώματος: 

 

 Even mode : Vg2 = Vg3 = 2V0 
 Odd mode :  Vg2 = -Vg3 = 2V0 

Στο even mode θα έχουμε το εξής: Vg2 = Vg3 = 2V0, άρα και V2
e
 = V3

e
 , άρα από την αντίσταση r/2 

δεν θα διαρρέει ρεύμα, καθώς και από το βραχυκύκλωμα στην θύρα  P1. Χωρίζουμε οπότε το 

κύκλωμα στην μέση, ανοιχτοκυκλώνοντας το παραπάνω κύκλωμα της Εικόνα 28 : 

 
Εικόνα 29: Wilkinson Combiner/Divider Even mode 

 

 

Η σύνθετη αντίσταση στην θύρα P2 θα είναι
7
: 

   
  

  

 
 

                                                      
7
 ό.π.: p.p.329-330. 
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Αφού πρόκειται για γραμμή προσαρμογής λ/4, όπως έχουμε ορίσει και παραπάνω, έχουμε     , 

άρα    
 =1 και   

    . Η αντίσταση r/2 είναι περιττή στην περίπτωση του ανοιχτοκυκλώματος.  

Για να βρούμε το V1
e 

, και το V2
e
 θα χρησιμοποιήσουμε την παρακάτω εξίσωση, θέτοντας: 

 x=0 , για την θύρα P1, 

 x=-λ/4 , για την θύρα P2 

V                    

Οπότε θα έχουμε:
7
 

  
     

 

 
              

  
                  

   

   
 

Ο συντελεστής ανάκλασης Γ  για την θύρα P1, κοιτώντας στην κανονικοποιημένη αντίσταση με τιμή 

2 θα είναι: 

  
    

    
 

Και 

  
         

Για odd-mode: Vg2 = -Vg3 = 2V0 και V2
ο
 = -V3

ο. Χωρίζουμε το κύκλωμα στην μέση, 

βραχυκυκλώνοντας το παραπάνω κύκλωμα της Εικόνα 28: 

 
Εικόνα 30: Wilkinson Combiner/Divider Odd mode 

 

Από την θύρα P2 βλέπουμε μία σύνθετη αντίσταση r/2 , παράλληλη σε μία γραμμή μεταφοράς 

μήκους λ/4 που στην συνέχεια βραχυκυκλώνεται στην θύρα P1. Για να υπάρχει προσαρμογή στην 

θύρα P2 πρέπει να επιλεγεί αντίσταση r=2, έτσι θα έχουμε όλη την ισχύ να καταναλώνεται στην 

αντίσταση r/2 και να μην διαπερνά την θύρα P1. Άρα θα έχουμε V2
ο
 = V0 και V1

ο
 = 0.  
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Τέλος θα υπολογίσουμε την σύνθετη αντίσταση στην θύρα P1 όταν οι θύρες P2 και P3 είναι 

τερματισμένες με προσαρμοσμένα φορτία.  

Το κύκλωμα θα διαμορφωθεί λοιπόν, ως εξής: 

 
Εικόνα 31: Ανάλυση κυκλώματος του Combiner/Divider (α) 

 

 

Αφού V2 = V3 η αντίσταση 2 μπορεί να παραληφθεί, έτσι καταλήγουμε στο κύκλωμα: 

 
Εικόνα 32: Ανάλυση κυκλώματος του Combiner/Divider (β) 

 

Αφού πρόκειται για μία παράλληλη σύνδεση σε γραμμές προσαρμογής λ/4 , οι οποίες με την σειρά 

τους είναι και αυτές τερματισμένες σε προσαρμοσμένες αντιστάσεις, κανονικοποιημένες ως προς Ζ0,   

η σύνθετη αντίσταση εισόδου θα είναι:
7
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Μπορούμε, λοιπόν, να καταλήξουμε στο συμπέρασμα για τις παραμέτρους S για τον Wilkinson 

Combiner/Divider: 

 

      Zin = 1 στην πόρτα P1 

          
Οι θύρες P1 και P3 είναι προσαρμοσμένες σε even και odd mode 

        
  

    
 

  
    

   
 

  
 Συμμετρία λόγω συζυγίας  

         
 

  
 Συμμετρικές θύρες P1 και P3 

          Λόγω ανοιχτοκυκλώματος/βραχυκυκλώματος. 

 

Δηλαδή στην περίπτωση του Wilkinson Combiner/Divider με δύο προσαρμοσμένες εξόδους, ο 

πίνακας που δείχνει την σχέση των  παραμέτρων S (S-parameters) είναι ο παρακάτω:
8
 

 

    
  

  
 
   
   
   

  

 

Όταν δηλαδή ο διαχωριστής οδηγείται από την θύρα P1 και οι έξοδοι είναι προσαρμοσμένες, 

καθόλου ισχύς δεν καταναλώνεται στην ενδιάμεση αντίσταση. Ο διαχωριστής μπορεί να θεωρηθεί με 

μηδενικές απώλειες. Μόνο ανακλάσεις από τις θύρες P2 και P3 φτάνουν στην ενδιάμεση αντίσταση 

όπου και καταναλώνονται. Επίσης, επειδή           οι θύρες P1 και P3  είναι απομονωμένες. 

 

Τα παραπάνω συμπεράσματα φαίνονται και στον διαχωριστή Wilkinson που σχεδιάστηκε για την 

παρούσα εργασία.  

Οι τιμές των εξαρτημάτων που αρχικά χρησιμοποιήθηκαν είναι οι παρακάτω: 

 

C 2.566pF 

L 12.5nH 

Z 50Ω 

                                                      
8
 Logan, J. Berens (2012). Design, Analysis and Construction of an Equal Split Wilkinson Power Divider. 

Master's Theses (2009 -). Paper 154. http://epublications.marquette.edu/theses_open/154 
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Εικόνα 33: Κυκλωματική απεικόνιση του Wilkinson Combiner/Divider 

 

Χρησιμοποιήθηκαν 1001 δείγματα συχνοτήτων από 0 έως και 2.1GHz.  

 

 
Εικόνα 34: Ρυθμίσεις σήματος εισόδου 

 

Τα αποτελέσματα της προσομοίωσης επιβεβαίωσαν την θεωρία που περιγράφουμε παραπάνω, κάτι 

που φαίνεται και στο παρακάτω διάγραμμα παραμέτρων S. 
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Εικόνα 35: Αποτέλεσμα προσομοίωσης (S-Parameters) 

Παρατηρούμε δηλαδή πως: 

S13 = S31 = -3.01dB 

S23 = S32 = -40.85 dB 

Εξαιρετικά απότελέσματα παρατηρούμε και στο γράφημα των στάσιμων κυμάτωνVSWR: 

 
Εικόνα 36: Αποτέλεσμα προσομοίωσης (VSWR) 
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ΚΕΦΑΛΑΙΟ 2: 

Παρουσίαση του Altium Designer 

 

 

2.1.  Περιγραφή κυκλώματος  

Παρακάτω θα ακολουθήσει μία παρουσίαση του εργαλείου που χρησιμοποιήθηκε για τον σχεδιασμό 

της πλακέτας, πρόκειται για το Altium Designer και την έκδοση 18.0.11.  

Η πλακέτα αρχικά σχεδιάστηκε στο Altium Designer και στην συνέχεια εισάχθηκε προς μελέτη και 

προσομοίωση στο CST-Studio Suite, στην έκδοση του 2021.  

 

Καταρχάς, θα γίνει αναφορά σε μερικά στοιχεία για το κύκλωμα της πλακέτας και ποιες επιθυμούμε 

να είναι οι λειτουργίες που θα πληροί. 

Επιγραμματικά, το κύκλωμα της πλακέτας είναι σύμφωνο με το παρακάτω σχεδιάγραμμα: 

 

 
Εικόνα 37: Σχεδιάγραμμα πλακέτας 

 

Σκοπός του κυκλώματος είναι η καθοδήγηση ενός σήματος σε μία ή δύο κεραίες ταυτόχρονα, καθώς 

προφανώς και η επιλογή της κατάλληλης κεραίας για την αντίστοιχη λήψη ενός σήματος. Πρόκειται 

ουσιαστικά για ένα κύκλωμα διεπαφής μεταξύ κυκλώματος μικροελεγκτή και κεραίας μεταγωγής 

λοβού. 

Το σήμα μας, προερχόμενο από ένα Freakduino, οδηγείται στην πλακέτα μας σε έναν επιλογέα. Ο 

επιλογέας, ανάλογα με την ρύθμιση που θα έχει, θα οδηγήσει το σήμα είτε στην πρώτη κεραία, είτε 

στην δεύτερη, είτε και στις δύο ταυτόχρονα, μέσω ενός Wilkinson Combiner/Divider. 
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Το τελικό σχέδιο του κυκλώματος πριν από τις πιθανές αλλαγές που θα προκύψουν σε επόμενο βήμα 

μελέτης και βελτιστοποίησης της πλακέτας, είναι το παρακάτω: 

 
Εικόνα 38: Σχέδιο κυκλώματος πριν τις διορθώσεις 
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2.2 Altium Designer 

Παρουσιάζουμε τα στοιχεία και τις λειτουργίες του λογισμικού Altium Designer, ακολουθώντας 

μερικά από τα βήματα που πραγματοποιήθηκαν για τον σχεδιασμό της τελικής πλακέτας της 

παρούσας εργασίας. Επιγραμματικά, παρουσιάζονται τα παρακάτω βήματα: 

1. Δημιουργία Project.  

2. Βασικά στοιχεία περιβάλλοντος χρήστη – παράδειγμα με δημιουργία μέρους του σχηματικού. 

3. Διαχείριση βιβλιοθηκών. 

4. Δημιουργία footprint και αντιστοίχιση στην βιβλιοθήκη. 

5. Εισαγωγή έτοιμης βιβλιοθήκης τρίτων. 

6. Δημιουργία PCB. 

7. Εξαγωγή αρχείου κατάλληλο για εισαγωγή στο CST-Studio Suite. 

 

 

2.2.1 Δημιουργία Project 

Ανοίγουμε το Altium Designer στον υπολογιστή μας. Στην συνέχεια αφού το πρόγραμμα φορτώσει, 

πλοηγούμαστε File > New > Project > PCB Project:  

 
Εικόνα 39: Δημιουργία νέου Project 
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Αποθηκεύουμε το Project στην τοποθεσία και με το επιθυμητό όνομα επιλέγοντας File > Save 

Project As: 

 
Εικόνα 40: Αποθήκευση Project (α) 

 

Στο παράθυρο που αναδύεται, επιλέγουμε την τοποθεσία και το όνομα του Project: 

 
Εικόνα 41: Αποθήκευση Project (β) 
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Το Project, που μόλις δημιουργήσαμε, βρίσκεται κάτω από το μενού Projects, στο αριστερό μέρος 

της οθόνης. 

 
Εικόνα 42: Projects Tab 
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2.2.2. Βασικά στοιχεία περιβάλλοντος χρήστη - Δημιουργία Σχηματικού  

Για να προσθέσουμε το σχηματικό του κυκλώματος, από το ίδιο μενού, επιλέγουμε το  Projects Tab 

, δεξί κλικ επάνω στο project που δημιουργήσαμε και στη συνέχεια:   

Add New to Project > Schematic. 

 

 
Εικόνα 43: Προσθήκη Σχηματικού 
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Μετονομάζουμε το σχηματικό με τον εξής τρόπο: 

Δεξί κλικ επάνω στο σχηματικό που μόλις προσθέσαμε στο Project και στην συνέχεια επιλέγουμε  

Save As…  

Επιλέγουμε τοποθεσία και όνομα αρχείου, όπως φαίνεται και παραπάνω στην εικόνα  (Εικόνα 41). 

 

 
Εικόνα 44: Αποθήκευση αρχείου σχηματικού 
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Με την δημιουργία του σχηματικού, βλέπουμε την παρακάτω οθόνη: 

Η λεγόμενη και ως Active Bar είναι ορατή στο κέντρο της οθόνης (Εικόνα 45: Το Active bar και το 

Properties Tab)(1) και δεξιά βρίσκεται το παράθυρο ιδιοτήτων Properties Tab (Εικόνα 45: Το 

Active bar και το Properties Tab)(2). 

 

 
Εικόνα 45: Το Active bar και το Properties Tab 

 

 
Εικόνα 46: Active Bar 

 

Active Bar: Πρόκειται για μία γραμμή συντομεύσεων με χρήσιμα εργαλεία που βρίσκεται σε όλα τα 

στάδια σχεδιασμού μιας πλακέτας στο Altium Designer, όπως και κατά τον σχεδιασμό του 

σχηματικού, της πλακέτας PCB αλλά και στη διαχείριση βιβλιοθήκης.   

Προσφέρει γρήγορη πρόσβαση σε συντομεύσεις, όπως τοποθέτηση εξαρτημάτων, κείμενο, 

ευθυγράμμιση στοιχείων κλπ. 

 

 

 

 

 

 

 

 

  

1 

2 
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Ένα σχετικό μενού επιλογών υπάρχει σε κάθε σύμβολο όπου παρατηρείται ένα τρίγωνο στην κάτω 

δεξιά γωνία, στο οποίο ο χρήστης μπορεί να αποκτήσει πρόσβαση κάνοντας δεξί κλικ, όπως φαίνεται 

και στην παρακάτω εικόνα (Εικόνα 47) 

 

 
Εικόνα 47: Active Bar 

 

Properties Tab: Πρόκειται για ένα πραγματικά χρήσιμο μενού στο περιβάλλον χρήστη. Εκεί, 

παρουσιάζονται και βρίσκονται όλες οι επιλογές που είναι σχετικές με το εκάστοτε αντικείμενο που 

έχουμε επιλέξει να επεξεργαστούμε. Όπως παρατηρούμε και στην παραπάνω εικόνα (Εικόνα 45: Το 

Active bar και το Properties Tab)(2), όταν τίποτα δεν είναι επιλεγμένο στο sheet μας, το Properties 

Tab εμφανίζει επιλογές σχετικές με το ποια στοιχεία θα είναι επιλέξιμα (Selection Filter) (Εικόνα 

48), γενικές ρυθμίσεις σχετικά με το sheet μας (General)(Εικόνα 49), καθώς και γενικές επιλογές για 

το sheet (Page Options)(Εικόνα 50). 

 

 
Εικόνα 48: Φίλτρο επιλέξιμων στοιχείων 
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Εικόνα 49: Επιλογές Sheet 

Εικόνα 50: Επιλογές σελίδας 

 

Για να τοποθετήσουμε τα στοιχεία του κυκλώματός μας στο sheet, θα ανοίξουμε τις βιβλιοθήκες με 

τα υλικά. Επιλέγουμε το κουμπί Panels (Εικόνα 51), το οποίο βρίσκεται στο κάτω δεξί μέρος του 

παραθύρου του προγράμματος και στην συνέχεια την επιλογή Libraries. 

 

 
Εικόνα 51: Πρόσβαση στην βιβλιοθήκη 
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Στη συνέχεια, αναδύεται το παράθυρο των βιβλιοθηκών. Εκεί, μπορούμε να αναζητήσουμε τα 

εξαρτήματα που θέλουμε να τοποθετήσουμε (Εικόνα 52), καθώς και να διαχειριστούμε τις 

βιβλιοθήκες που θέλουμε ή έχουμε (Εικόνα 53). 

 

 
Εικόνα 52: Αναζήτηση εξαρτημάτων στην βιβλιοθήκη 

 

 

 

 

Γενικά, το Altium, έχει προσανατολιστεί στην ύπαρξη διαφορετικών ρυθμίσεων και βιβλιοθηκών ανά 

Project, οπότε το εργαλείο αυτό είναι περισσότερο από χρήσιμο για την λειτουργία του 

προγράμματος και την χρήση του.  
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Εικόνα 53: Διαχείριση διαθέσιμων βιβλιοθηκών 

 

Θα αρχίσουμε να προσθέτουμε τα στοιχεία για την δημιουργία του Wilkinson Combiner/Divider, 

μιας και δεν θα χρειαστεί κάποια επιπλέον βιβλιοθήκη και στην συνέχεια θα ασχοληθούμε με το 

κομμάτι διαχείρισης και εμπλουτισμού των βιβλιοθηκών. 

Υπενθυμίζουμε πως το σχηματικό για τον Wilkinson Combiner/Divider είναι το παρακάτω: 

 
Εικόνα 54: Σχηματικό Wilkinson Combiner/Divider 
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Αρχίζουμε τοποθετώντας τα υλικά που θα χρειαστούμε στο sheet.  

Χρησιμοποιούμε το εργαλείο αναζήτησης που παρέχει η βιβλιοθήκη, γράφοντας λέξεις κλειδιά στο 

αντίστοιχο πεδίο αναζήτησης (Εικόνα 55)(1). 

Θα επιλέξουμε επάνω στην επιλογή Cap Semi και στην συνέχεια θα επιλέξουμε το footprint 

1608[0603]. Στο από κάτω πεδίο, βλέπουμε το footprint του υλικού που επιλέξαμε. Μας δίνεται, 

επίσης, η δυνατότητα να δούμε το υλικό που επιλέξαμε και σε τρισδιάστατο σχέδιο (Εικόνα 56) 

πατώντας στην επιλογή 3D (Εικόνα 55)(2). 

 

 
Εικόνα 55: Επιλογή footprint 

 

 
Εικόνα 56: Τρισδιάστατη απεικόνιση footprint 

  

1 

2 
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Έχοντας επιλέξει όλες τις επιμέρους λεπτομερείς του υλικού που θα χρησιμοποιήσουμε, επιλέγουμε 

το Place Cap Semi (Εικόνα 57).  

 
Εικόνα 57: Επιλογή υλικού για τοποθέτηση 

 

Αμέσως, μεταφερόμαστε στο sheet, για να τοποθετήσουμε το υλικό που επιλέξαμε (Εικόνα 58). 

 
Εικόνα 58: Τοποθέτηση στο sheet και συντομεύσεις πληκτρολογίου 

 

Μπορούμε να περιστρέψουμε το υλικό προτού το τοποθετήσουμε στο sheet με το spacebar του 

πληκτρολογίου. Οριζόντιος και κάθετος καθρεφτισμός (Mirror Left/Right, Mirror Up/Down) του 

υλικού μπορεί να πραγματοποιηθεί πατώντας τα πλήκτρα «Χ» και «Υ» του πληκτρολογίου. 
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Πιέζοντας το πλήκτρο Tab στο πληκτρολόγιό μας, μπορούμε να έχουμε πρόσβαση στο Properties 

Tab, εκεί μπορούμε να:  

 δώσουμε αριθμό (Designator) στο υλικό μας (Εικόνα 60)  

 περιστρέψουμε το υλικό ή να προσθέσουμε πληροφορίες (σύνδεσμο στην σελίδα του 

κατασκευαστή) (Εικόνα 61) 

 επιλέξουμε το footprint του υλικού που θα τοποθετήσουμε (Εικόνα 62) 

 επεξεργαστούμε τα μοντέλα που είναι διαθέσιμα (simulation, signal integrity) (Εικόνα 59) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Εικόνα 60: Ιδιότητες υλικού (δ) 

Εικόνα 62: Ιδιότητες υλικού (α) 

Εικόνα 61: Ιδιότητες υλικού (γ) 

Εικόνα 59: Ιδιότητες υλικού (β) 
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Για να συνεχίσουμε την τοποθέτηση των υλικών, πιέζουμε το κουμπί της παύσης που βρίσκεται στην 

μέση της οθόνης μας, επάνω στο sheet (Εικόνα 63) 

 

 
Εικόνα 63: Πολλαπλή τοποθέτηση υλικού 

 

Για να σταματήσουμε την τοποθέτηση των υλικών και για να επιστρέψουμε στην οθόνη επιλογής 

υλικών (τις βιβλιοθήκες μας), πιέζουμε το πλήκτρο ESC του πληκτρολογίου μας. 

 

 
Εικόνα 64: Έξοδος από την λειτουργία τοποθέτησης 

 

Πλοηγούμαστε στο sheet με τα εξής πλήκτρα: 

 Zoom : πίεση της ροδέλας και μετακίνηση του ποντικιού πάνω ή κάτω   

 

 Pan: δεξί κλικ και μετακίνηση ποντικιού  
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Αφού έχουμε τοποθετήσει τα εξαρτήματά μας για τον Wilkinson Combiner/Divider, θα ορίσουμε τις 

τιμές των υλικών και θα τα ενώσουμε. 

Για να ορίσουμε την τιμή ενός υλικού, επιλέγουμε το πεδίο της τιμής (Εικόνα 65)(1) και στην 

συνέχεια την αλλάζουμε στο Properties Tab (Εικόνα 65)(2). 

 
Εικόνα 65: Ορισμός τιμής υλικού 

 

Στην συνέχεια επιλέγουμε Place Wire από το Activity Bar (Εικόνα 66). 

 

 

Εικόνα 66: Επιλογή εργαλείου για την σύνδεση στοιχείων με αγωγούς 
  

1 

2 
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Η άκρη του κέρσορα του ποντικιού στην οθόνη ακολουθείται από έναν σταυρό. Πατώντας το 

αριστερό πλήκτρο του ποντικιού τοποθετούμε τις ενώσεις στα υλικά του sheet (Εικόνα 67). 

 
Εικόνα 67: Σύνδεση στοιχείων 

 

Τοποθετούμε τις θύρες P1 έως και P3 και πραγματοποιούμε όλες τις συνδέσεις (Εικόνα 68). 

 
Εικόνα 68: Wilkinson Combiner/Divider με ολοκληρωμένες συνδέσεις 

 

Για να αριθμήσουμε τα υλικά επάνω στο sheet, από το Program Toolbar επιλέγουμε: 

Tools > Annotation > Annotate Schematics Quietly (Εικόνα 69) 

 
Εικόνα 69: Αρίθμηση στοιχείων πλακέτας (α) 
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Θα αναδυθεί ένα νέο παράθυρο, ενημερώνοντάς μας για τις αλλαγές που πρόκειται να 

πραγματοποιηθούν (Εικόνα 70). 

 
Εικόνα 70: Αρίθμηση στοιχείων πλακέτας (β) 

 

Αυτόματα τα στοιχεία του sheet έχουν αριθμηθεί κατάλληλα, ανάλογα με τις αντίστοιχες ρυθμίσεις 

που έχει το Project (Εικόνα 71). 

 

 
Εικόνα 71: Ολοκλήρωση σχηματικού του Wilkinson Combiner/Divider 
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2.2.3 Διαχείριση βιβλιοθηκών 

Αφού έχουμε τοποθετήσει τα στοιχεία που σχετίζονται με τον Wilkinson Combiner/Divider, θα 

προχωρήσουμε και στα υπόλοιπα στοιχεία του κυκλώματός μας, προς την υλοποίηση του σχηματικού 

(Εικόνα 37). 

Θα πρέπει να εισάγουμε στο σχηματικό μας στοιχεία τα οποία δεν βρίσκονται ήδη στην 

προεπιλεγμένη βιβλιοθήκη, να τα δημιουργήσουμε δηλαδή ή και να τα εισαγάγουμε από έτοιμες 

βιβλιοθήκες για να τα χρησιμοποιήσουμε. 

Θα προχωρήσουμε στην δημιουργία των ολοκληρωμένων RF switch HMC252AQS24E, 

HMC284AMS8G και στην εισαγωγή του pin-out του Arduino, το οποίο συμβαδίζει με αυτό του 

Freakduino που θα χρησιμοποιηθεί ως πηγή του σήματος,  

Η σειρά HMC της Analog Devices επιλέχθηκε για την χαμηλή απώλεια εισόδου που έχει και την 

υψηλή απομόνωση ανάμεσα στις εξόδους (συνήθως μεγαλύτερη από 45dB). Επίσης, ο χρόνος 

αλλαγής κατάστασης είναι αρκετά μικρός, της τάξης των nano δευτερολέπτων. 

Το HMC284AMS8G εντάσσεται στους σχετικά φθηνούς  Single Pole Double Throw (SPDT) 

switches, πρόκειται για ένα MSOP package με οχτώ pin. Διαθέτει μία είσοδο (RFC) η οποία μπορεί 

να δρομολογηθεί σε μία από στις δύο εξόδους του κάθε φορά (RF1, RF2). Πρόκειται για έναν μη 

ανακλώμενο διακόπτη (non-reflective switch). Στην περίπτωση δηλαδή όπου το RF1 ή RF2 δεν είναι 

συνδεδεμένα, δεν επιστρέφουν ανακλάσεις καθώς τερματίζονται εσωτερικά από μία αντίσταση των 

50Ω. 

 

 

 
Εικόνα 72: Σχηματική απεικόνιση του HMC284AMS8G 

 

 

Όπως φαίνεται και στην παραπάνω  εικόνα, το HMC284AMS8G διαθέτει δύο pin για έλεγχο 

κατάστασης σύνδεσης (Α, Β) και ο πίνακας αληθείας του, σύμφωνα και με τα στοιχεία που δίνονται 

από τον κατασκευαστή είναι ο παρακάτω: 

 

Είσοδος ελέγχου Ρεύμα ελέγχου Διαδρομή σήματος 

Α (Vdc) B (Vdc) I a I b RFC στις RF1 RFC στις RF2 

0 +5 -0.2 0.2 ON OFF 

+5 0 0.2 -0.2 OFF ON 

0 0 - - Απροσδιόριστο Απροσδιόριστο 

+5 +5 0.2 0.2 Απροσδιόριστο Απροσδιόριστο 

Πίνακας 1: Πίνακας αληθείας του HMC284AMS8G 
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Παρακάτω παρατίθενται και τα στοιχεία που δίνει ο κατασκευαστής σχετικά με την απώλεια εισόδου 

καθώς και με την απομόνωση των εξόδων RF1 και RF2 (Εικόνα 73). 

 

 
Εικόνα 73: Απώλεια εισόδου και απόμόνωση του HMC284AMS8G 

 

Αντίστοιχα, το HMC252AQS24E είναι ένας SP6T (Single Pole 6 Throw) διακόπτης με τρεις 

γραμμές για τον έλεγχο της διαδρομής που θα ακολουθήσει το σήμα. Διαθέτει μία είσοδο (RFC) και 

έξι εξόδους (RF1 έως RF6). Αν και θα χρησιμοποιηθούν μόνο οι τρείς από στις έξι εξόδους, 

επιλέχθηκε καθαρά βάσει του ότι διαθέτει τρείς εξόδους στην ίδια πλευρά, κάτι που θα 

χρησιμοποιηθεί για την ευκολότερη σχεδίαση ίσων σε απόσταση και χαρακτηριστικών γραμμών 

μεταφοράς. 

 

 
Εικόνα 74: Σχηματική απεικόνιση του HMC252AQS24E 
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Ο πίνακας αληθείας που δίνεται από τον κατασκευαστή είναι ο παρακάτω: 

Είσοδος ελέγχου Διαδρομή σήματος 

Α Β C RFC στις: 

LOW LOW LOW RF1 

HIGH LOW LOW RF2 

LOW HIGH LOW RF3 

HIGH HIGH HIGH RF4 

LOW LOW HIGH RF5 

HIGH LOW HIGH RF6 

LOW HIGH HIGH ALL OFF 

HIGH HIGH HIGH ALL OFF 

Πίνακας 2: Πίνακας αληθείας του HMC252AQS24E 

 

Τα χαρακτηριστικά του ως προς την απομόνωση ανάμεσα στις εξόδους και την απώλεια εισόδου 

είναι τα παρακάτω: 

 
Εικόνα 75: Απώλεια εισόδου και απόμόνωση του HMC252AQS24E 
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Για την δημιουργία του ολοκληρωμένου, αρχικά θα επιλέξουμε τη δημιουργία μίας νέας βιβλιοθήκης 

όπως φαίνεται και στην παρακάτω εικόνα: 

 
Εικόνα 76: Δημιουργία νέας βιβλιοθήκης 

 

Στην καινούρια αυτή βιβλιοθήκη μπορούμε να προσθέσουμε υλικά. 

 

 
Εικόνα 77: Προσθήκη υλικών στην νέα βιβλιοθήκη 

 

Επιλέγουμε οπότε το επιθυμητό sheet. Από το Active Bar επιλέγουμε το σύμβολο Place Pin και 

αρχίζουμε να προσθέτουμε pins, ακολουθώντας το pin-out που μας δίνεται από το σχετικό έγγραφο 

που μας παρέχει ο κατασκευαστής. 

 

 
Εικόνα 78: Επιλογή Place Pin στο Active Bar 
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Τα πλήκτρα που χρησιμοποιούμε για την τοποθέτηση των pin είναι τα παρακάτω: 

 

 Αριστερό κλικ ποντικιού για την προσθήκη pin.   

 

 Δεξί κλικ ποντικιού ή ESC για τον τερματισμό προσθήκης pin.  ή 

 

 Μπορούμε να περιστρέψουμε το pin που πρόκειται να προσθέσουμε με το Spacebar  

 

 
Εικόνα 79: Τοποθέτηση Pin 

 

Αφού προσθέσουμε όλα τα pin του εξαρτήματος που επιθυμούμε να κατασκευάσουμε, αλλάζουμε τα 

ονόματα των pin από το παράθυρο ιδιοτήτων.  

 

 
Εικόνα 80: Μετονομασία Pin 
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Αφού έχουμε ολοκληρώσει την προσθήκη όλων των επαφών που διαθέτει το εξάρτημα σύμφωνα και 

με το έντυπο του κατασκευαστή, προσθέτουμε το σώμα του εξαρτήματος: 

Place > Rectangle 

 

Μετά την προσθήκη του σώματος του εξαρτήματος, από το παράθυρο των ιδιοτήτων, επιλέγουμε την 

επιλογή Transparent, ώστε το σώμα του εξαρτήματος που τοποθετήσαμε να μην καλύπτει τα 

ονόματα των pin που έχουμε δώσει. 

 

 
Εικόνα 83: Ορισμός διαφάνειας σώματος εξαρτήματος 

 

  

Εικόνα 81: Τοποθέτηση σώματος 

εξαρτήματος (β) 
Εικόνα 82: Τοποθέτηση σώματος 

εξαρτήματος (α) 



63 

Μεταπτυχιακή Διπλωματική Εργασία, Διονύσης Δεληγιαννόπουλος, ΑΜ: IES-0015 

Κάνοντας κλικ επάνω στο sheet, μπορούμε από το παράθυρο ιδιοτήτων να επιλέξουμε και την 

εμφάνιση των πεδίων Designator και Name για το εξάρτημα που φτιάξαμε. 

 

 
Εικόνα 84: Εμφάνιση πεδίου αρίθμησης και ονόματος εξαρτήματος 

 

Στο πεδίο του Designator προσθέτουμε τους χαρακτήρες U? μιας και πρόκειται για ολοκληρωμένο. 

Το λατινικό ερωτηματικό θα χρησιμοποιηθεί αυτόματα από το λογισμικό για την αυτόματη αρίθμηση 

στα σχέδια στα οποία θα χρησιμοποιηθεί. Στο πεδίο Name συμπληρώνουμε το όνομα του 

εξαρτήματος. 

 

 

Επιλέγοντας το COMPONENT 1, που μόλις φτιάξαμε από το παράθυρο SCH Library μπορούμε 

να προσθέσουμε και άλλα στοιχεία σχετικά με το εξάρτημα που προσθέτουμε, όπως για παράδειγμα 

από ποιον κατασκευαστή είναι και από πού μπορούμε να το προμηθευτούμε.  
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Επιλέγουμε το κουμπί Add (1), πληκτρολογούμε στο πεδίο αναζήτησης τον κατασκευαστή και το 

όνομα του εξαρτήματος (2), επιλέγουμε τον επιθυμητό προμηθευτή για το εξάρτημα και τέλος 

επιλέγουμε το κουμπί OK (3) για την επαλήθευση της επιλογής μας.  

 

 
Εικόνα 85: Ορισμός κατασκευαστή και προμηθευτή εξαρτήματος 

 

Μετά την προσθήκη πληροφοριών για το εξάρτημα από τον προμηθευτή, θα μας εμφανιστεί η 

σχετική πληροφορία επάνω στο sheet. Αφού όμως εμείς έχουμε προσθέσει ήδη το όνομα του 

εξαρτήματος, από το παράθυρο ιδιοτήτων (Properties Tab) θα αποκρύψουμε την πληροφορία 

αυτή.  

Επιλέγουμε το Parameters Tab και από εκεί επιλέγουμε την απόκρυψη του πεδίου Supplier Part 

Number. 

 

 
 Εικόνα 86: Απόκρυψη αριθμού κατασκευαστή  

 

1 

2 

3 
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Αποθηκεύουμε την βιβλιοθήκη και στην συνέχεια θα ολοκληρώσουμε με την προσθήκη footprint για 

το εξάρτημα που μόλις δημιουργήσαμε. 

2.2.4 Δημιουργία footprint και αντιστοίχιση στη βιβλιοθήκη 

Για την δημιουργία footprint πρέπει, αρχικά, να δημιουργήσουμε μία νέα βιβλιοθήκη πλακετών (PCB 

Library). Project > Add New to Project > PCB Library 

 

 
Εικόνα 87: Προσθήκη PCB Library 

 

Στη συνέχεια θα χρησιμοποιήσουμε τον οδηγό για την δημιουργία νέου footprint (IPC Compliant 

Footprint Wizard). 

Tools > IPC Compliant Footprint Wizard… 

 

 
Εικόνα 88: Εκκίνηση οδηγού δημιουργίας footprint 
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Ένα νέο παράθυρο αναδύεται και αρχίζει να μας καθοδηγεί στα απαραίτητα βήματα για τη 

δημιουργία ενός footprint.  

 

 
Εικόνα 89: Οδηγός δημιουργίας footprint (1) 

Αρχικά επιλέγουμε το είδος, το package δηλαδή, που στην περίπτωσή μας και για το ολοκληρωμένο 

HMC284A είναι MSOP (Mini Small Outline Package). 

 

 
Εικόνα 90: Οδηγός δημιουργίας footprint (2) 
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Συνεχίζουμε συμπληρώνοντας τα στοιχεία του εξαρτήματος όπως μας τα δίνει ο κατασκευαστής στο 

αντίστοιχο έγγραφο (datasheet). Επιλέγουμε και την επιλογή Generate STEP Model Preview, 

ώστε να έχουμε και μία πληρέστερη εικόνα για το εξάρτημα, σύμφωνα με τις διαστάσεις που 

εισαγάγουμε στην φόρμα. 

 
Εικόνα 91: Οδηγός δημιουργίας footprint (2) 

Στην επόμενη οθόνη, προσθέτουμε και ένα θερμικό pad, όπως αυτό αναφέρεται και στο έγγραφο του 

κατασκευαστή, αν και στην περίπτωσή μας πρόκειται για pad απαραίτητο για τη γείωση του 

ολοκληρωμένου. 

 
Εικόνα 92: Οδηγός δημιουργίας footprint (3) 
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Ο οδηγός συνεχίζεται με κάποιες οθόνες που περιέχουν αποστάσεις και διαστάσεις που έχουν 

υπολογιστεί αυτόματα, όπως την απόσταση από τις καμπές των pins του ολοκληρωμένου, την 

διαμόρφωση της κόλλησης , τις ανοχές στις διαστάσεις του κύριου σώματος του εξαρτήματος, κλπ. 

 
Εικόνα 93: Οδηγός δημιουργίας footprint (4) 

 

 
Εικόνα 94: Οδηγός δημιουργίας footprint (5) 
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Στην περίπτωσή μας, θα αλλάξουμε το σχήμα των pads του εξαρτήματος επιλέγοντάς τα να είναι 

τετραγωνισμένα και όχι στρογγυλά στις άκρες τους. 

 
Εικόνα 95: Οδηγός δημιουργίας footprint (6) 

 

Στην επόμενη οθόνη, βρίσκονται αυτόματα υπολογισμένες διαστάσεις για την μεταξοτυπία που θα 

έχει η πλακέτα στο σημείο του εξαρτήματος. 

 
Εικόνα 96: Οδηγός δημιουργίας footprint (7) 
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Στα τελευταία βήματα του οδηγού, επιλέγουμε το όνομα του εξαρτήματος, καθώς και σε ποια 

βιβλιοθήκη αυτό θα αποθηκευτεί. 

 

 
Εικόνα 97: Οδηγός δημιουργίας footprint (8) 

 

 
Εικόνα 98: Οδηγός δημιουργίας footprint (9) 
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Εικόνα 99: Οδηγός δημιουργίας footprint (10) 

 

Μετά το πέρας της ολοκλήρωσης του οδηγού και αφότου αυτός κλείσει, εμφανίζεται στο κυρίως 

παράθυρο του προγράμματος το footprint του εξαρτήματος. 

 

 
Εικόνα 100: Απεικόνιση του δημιουργημένου footprint 
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Το αυτόματα αναπαραχθέν τρισδιάστατο μοντέλο του εξαρτήματος, την δημιουργία του οποίου μόλις 

ολοκληρώσαμε, μπορούμε να αναπαράγουμε στην οθόνη μας και να επεξεργαστούμε, πιέζοντας στο 

πληκτρολόγιό μας το πλήκτρο 3. Με τα πλήκτρα 2 και 3 μπορούμε και στο κομμάτι τους σχεδιασμού 

της πλακέτας να εναλλάξουμε τη δυσδιάστατη και τρισδιάστατη απεικόνιση της πλακέτας. 

 

 
Εικόνα 101: Τρισδιάστατη απεικόνιση του footprint 

  



73 

Μεταπτυχιακή Διπλωματική Εργασία, Διονύσης Δεληγιαννόπουλος, ΑΜ: IES-0015 

Για την τελική αντιστοίχιση του παρόντος εξαρτήματος που δημιουργήσαμε με το αντίστοιχο 

σχηματικό του, πρέπει αφού αποθηκεύσουμε την τρέχουσα βιβλιοθήκη, να επιστρέψουμε στην 

βιβλιοθήκη με τα σχηματικά των εξαρτημάτων και να επιλέξουμε στο αντίστοιχο εξάρτημα την 

επιλογή Add Footprint.  

 

 
Εικόνα 102: Αντιστοίχιση footprint με σχηματική απεικόνιση (1) 

  



74 

Μεταπτυχιακή Διπλωματική Εργασία, Διονύσης Δεληγιαννόπουλος, ΑΜ: IES-0015 

Ένα νέο παράθυρο θα αναδυθεί και από εκεί, και αφού βρούμε την σχετική βιβλιοθήκη που μόλις 

δημιουργήσαμε, θα βρούμε και το αντίστοιχο εξάρτημα που επιθυμούμε να αντιστοιχήσουμε. 

 
Εικόνα 103: Αντιστοίχιση footprint με σχηματική απεικόνιση (1) 

Επικυρώνουμε την επιλογή μας και πλέον έχει καταχωρηθεί επιτυχώς ο συσχετισμός του σχηματικού 

εξαρτήματος με το αντίστοιχο εξάρτημα πλακέτας, το σχετικό δηλαδή footprint. 

 
Εικόνα 104: Αντιστοίχιση footprint με σχηματική απεικόνιση (1) 
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 2.2.5 Εισαγωγή έτοιμης βιβλιοθήκης τρίτων 

Επειδή πολλές φορές είναι χρονοβόρο να δημιουργούμε τα εξαρτήματα κάθε φορά, μας δίνεται και η 

δυνατότητα να εισαγάγουμε και έτοιμες βιβλιοθήκες τρίτων ή ακόμη και project, τα οποία είχαν 

δημιουργηθεί με την βοήθεια άλλων εργαλείων σχεδίασης όπως είναι το Eagle. 

Για να εισαγάγουμε μία έτοιμη βιβλιοθήκη ή ένα project από κάποιο άλλο πρόγραμμα, εκτελούμε τον 

κατάλληλο οδηγό από οποιαδήποτε οθόνη του προγράμματος. 

File > Import Wizard 

 
Εικόνα 105: Εκκίνηση οδηγού εισαγωγής βιβλιοθήκης τρίτων 

 

Αναδύεται ένα νέο παράθυρο με τον οδηγό και ακολουθούμε τις οδηγίες που μας προβάλει. 

 
Εικόνα 106: Οδηγός εισαγωγής βιβλιοθήκης τρίτων (1) 

Επιλέγουμε την εισαγωγή αρχείων από το πρόγραμμα Eagle. 
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Εικόνα 107: Οδηγός εισαγωγής βιβλιοθήκης τρίτων (2) 

Στην επόμενη οθόνη, ο οδηγός μας ζητά να του υποδείξουμε το σημείο όπου βρίσκονται τα αρχεία 

σχετικά με το project που θέλουμε να εισάγουμε από το Eagle. Επειδή όμως πρόκειται για αρχείο 

βιβλιοθήκης του Eagle, θα προχωρήσουμε στην αντίστοιχη οθόνη. 

 
Εικόνα 108: Οδηγός εισαγωγής βιβλιοθήκης τρίτων (3) 
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Επιλέγουμε το κουμπί Add και πλοηγούμαστε στην θέση του αρχείου της βιβλιοθήκης που 

επιθυμούμε να εισαγάγουμε. Στην συνέχεια επιλέγουμε Next, 

 
Εικόνα 109: Οδηγός εισαγωγής βιβλιοθήκης τρίτων (4) 

Το πρόγραμμα θα αναλύσει το αρχείο που επιθυμούμε να εισαγάγουμε και στην συνέχεια θα μας 

προβάλει μία σειρά επιλογών, σχετικά με το ποια επίπεδα θα χρησιμοποιήσει για την δημιουργία 

τρισδιάστατων σωμάτων για τα εξαρτήματα, για την αυτόματη αναγνώριση εισόδων ισχύος κλπ. 

 
Εικόνα 110: Οδηγός εισαγωγής βιβλιοθήκης τρίτων (5) 
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Στην συνέχεια θα μας ζητηθεί να επιλέξουμε το σημείο αποθήκευσης των αρχείων προς εισαγωγή. 

 
Εικόνα 111: Οδηγός εισαγωγής βιβλιοθήκης τρίτων (6) 

Τέλος ο οδηγός ολοκληρώνει με το άνοιγμα της νεοεισαχθείσας βιβλιοθήκης για την άμεση χρήση 

της. 
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Εικόνα 112: Οδηγός εισαγωγής βιβλιοθήκης τρίτων (7) 

Έτσι μπορούμε να χρησιμοποιήσουμε το σχηματικό και το αντίστοιχο σχηματικό πλακέτας για το 

Freakduino, επιλέγοντας την χρήση εξαρτημάτων από την βιβλιοθήκη που μόλις εισαγάγαμε. 



80 

Μεταπτυχιακή Διπλωματική Εργασία, Διονύσης Δεληγιαννόπουλος, ΑΜ: IES-0015 

 
Εικόνα 113: Εισαγωγή layout Arduino 

  



81 

Μεταπτυχιακή Διπλωματική Εργασία, Διονύσης Δεληγιαννόπουλος, ΑΜ: IES-0015 

2.2.6 Δημιουργία του PCB 

Έχοντας ολοκληρώσει το σχηματικό μας, θα προχωρήσουμε στην δημιουργία της πλακέτας μας. 

Αρχικά θα τρέξουμε τον αυτόματο έλεγχο για λάθη που παρέχει το Altium.  

Project > Compile PCB Project RFSplitter.PrjPcb 

 
Εικόνα 114: Έλεγχος Project για σφάλματα 

 

Αρχίζουμε επιλέγοντας File > New > PCB όπως φαίνεται και στην παρακάτω εικόνα:  

 
Εικόνα 115: Δημιουργία αρχείου PCB 

 

Αφού αποθηκεύσουμε το αρχείο για το PCB, θα προχωρήσουμε στον αυτόματο εμπλουτισμό του 

PCB από το σχηματικό. Έχοντας ανοιχτό το σχηματικό, επιλέγουμε:  

Design > Update PCB Document RFSplitterPCB.PcbDoc 

 
Εικόνα 116: Μεταφορά στοιχείων σχηματικού στο PCB (populate PCB from schematic) 

 

Ένα νέο παράθυρο θα αναδυθεί, ενημερώνοντάς μας για τις αλλαγές που πρόκειται να 

πραγματοποιηθούν στο PCB αρχείο. 
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Εικόνα 117: Έλεγχος και επικύρωση μεταφοράς αλλαγών στο PCB 

 

Αφού επικυρώσουμε τις αλλαγές (Validate Changes , Execute Changes), κλείνουμε το 

παράθυρο και ανοίγουμε το αρχείο της πλακέτας PCB.  

Αμέσως παρατηρούμε πως όλα τα επιθυμητά εξαρτήματα βρίσκονται πλέον σε έναν χώρο δίπλα στην 

πλακέτα μας, όπως φαίνεται παρακάτω και στην εικόνα. 

 

 
Εικόνα 118: Μετακίνηση και διαρρύθμιση στοιχείων στο PCB 
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Δεδομένου ότι η πλακέτα μας θα τοποθετηθεί επάνω σε ένα Freakduino, αρχίζουμε μετακινώντας το 

pinout για το Arduino που έχουμε εισαγάγει.  

 

Παρατηρούμε πως μετακινώντας το pin-out του Arduino, αυτό «σπρώχνει» τα υπόλοιπα υλικά που θα 

τοποθετηθούν στην πλακέτα μας. Για να αποτρέψουμε την ενέργεια αυτή, από την γραμμή εντολών 

επιλέγουμε:  Tools > Preferences 

 

 
Εικόνα 119: Προτιμήσεις για την λειτουργία σχεδίασης PCB 
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Ένα νέο παράθυρο με επιλογές σχετικές με το πρόγραμμα θα εμφανιστεί. Εκεί, θα επιλέξουμε: PCB 

Editor > Interactive Routing 

Στο πεδίο Component pushing επιλέγουμε Ignore. 

 
Εικόνα 120: Ignore Component pushing 

 
Αφού αποκτήσουμε μία γενική εικόνα για το πού θα βρίσκονται τα εξαρτήματα της πλακέτας μας, θα 

προχωρήσουμε στον ορισμό των διαστάσεών της. 

 

 
Εικόνα 121: Αρχική διάταξη στοιχείων επάνω στην πλακέτα 

  



85 

Μεταπτυχιακή Διπλωματική Εργασία, Διονύσης Δεληγιαννόπουλος, ΑΜ: IES-0015 

Για να ορίσουμε διαστάσεις στην πλακέτα, αρχικά προσθέτουμε τις περιμετρικές γραμμές που 

θέλουμε να έχει η πλακέτα. Από το Active Bar επιλέγουμε το εργαλείο Place Line. 

 
Εικόνα 122: Τοποθέτηση ορίων πλακέτας 

 

Αφού τοποθετήσουμε την γραμμή, ορίζουμε και σε ποιο επίπεδο (layer) αυτή θα ανήκει. Επιλέγουμε 

το επίπεδο Mechanical 8 από το Properties Tab. 

 
Εικόνα 123: Μεταφορά γραμμής ορισμού ορίων πλακέτας στο επίπεδο Mechanical 8 

  



86 

Μεταπτυχιακή Διπλωματική Εργασία, Διονύσης Δεληγιαννόπουλος, ΑΜ: IES-0015 

Τέλος για να ορίσουμε τις διαστάσεις της πλακέτας, επιλέγουμε τις γραμμές που τοποθετήσαμε και 

επιλέγουμε Design > Board Shape > Define from selected objects 

 
Εικόνα 124: Ορισμός διαστάσεων πλακέτας 

 

Έχουμε την επιλογή να μετονομάσουμε και το επίπεδο που επιλέξαμε και τοποθετήσαμε τις γραμμές 

για το τελικό σχήμα της πλακέτας. Κάνοντας δεξί κλικ επάνω στο επίπεδο που θέλουμε να 

μετονομάσουμε, αναδύεται παράθυρο όπου και μπορούμε να εισαγάγουμε το επιθυμητό όνομα για το 

επίπεδο αυτό.  

 
Εικόνα 125: Μετονομασία επιπέδου διαστάσεων πλακέτας 
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Σημαντικό είναι να ορίσουμε και το σημείο αναφοράς (Origin) για τις διαστάσεις της πλακέτας μας, 

το σημείο δηλαδή σε σχέση με το οποίο θα ορίζονται όλες οι αποστάσεις για όλα τα στοιχεία της 

πλακέτας. 

Για να αποκτήσουμε γρήγορα πρόσβαση στην ρύθμιση αυτή, θα χρησιμοποιήσουμε το πεδίο 

αναζήτησης που βρίσκεται στο επάνω δεξιά μέρος της οθόνης του προγράμματος, όπως αυτό 

φαίνεται και στην παρακάτω εικόνα. Εισαγάγουμε τη λέξη Origin στο πεδίο αναζήτησης και στην 

συνέχεια επιλέγουμε την εντολή Origin > Set. 

 

 
Εικόνα 126: Ορισμός σημείου αναφοράς πλακέτας 

 

Χρησιμοποιούμε τον δείκτη του ποντικιού για να ορίσουμε το σημείο αναφοράς στο κάτω αριστερό 

μέρος της πλακέτας. 
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Εικόνα 127: Τοποθέτηση σημείου αναφοράς πλακέτας 

 

Αμέσως θα παρατηρήσουμε το όρισμα του νέου σημείου αναφοράς, οπότε και μπορούμε να 

συνεχίσουμε την κατασκευή της πλακέτας μας. 

 

 
Εικόνα 128: Απεικόνιση σημείου αναφοράς πλακέτας 
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2.2.7. Εξαγωγή αρχείου κατάλληλο για εισαγωγή στο CST-Studio Suite. 
 

Έχοντας ολοκληρώσει τον σχεδιασμό της πλακέτας, μπορούμε να προχωρήσουμε στην εξαγωγή  

αρχείου, κατάλληλου για την εισαγωγή του στο CST studio Suite, όπου θα γίνει και η μελέτη της 

πλακέτας. 

 

Για την εξαγωγή επιλέγουμε: File > Fabrication Outputs > ODB++ Files 

 

 
Εικόνα 129: Οδηγός εξαγωγής αρχείου πλακέτας (1) 
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Αναδύεται νέο παράθυρο με όλες τις επιλογές σχετικά με τα επίπεδα (layers) που επιθυμούμε να 

εξαγάγουμε.  

 
Εικόνα 130: Οδηγός εξαγωγής αρχείου πλακέτας (2) 

Μετά από την σχετική προετοιμασία και επεξεργασία των αρχείων, το πρόγραμμα θα εξάγει ένα νέο 

αρχείο για την πλακέτα μας και θα το εμφανίσει στο κυρίως παράθυρο της εφαρμογής. 

 
Εικόνα 131: Απεικόνιση αρχείου εξαγωγής πλακέτας 
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ΚΕΦΑΛΑΙΟ 3: 

PCB Studio – CST Studio Suite 

 

 

Στο σημείο αυτό θα παρουσιάσουμε τις λειτουργίες του λογισμικού CST Studio Suite, για την 

έκδοση του 2021. 

Πρόκειται για ένα πακέτο λογισμικού που μπορεί να χρησιμοποιηθεί για τον σχεδιασμό, την ανάλυση 

και την βελτιστοποίηση ηλεκτρομαγνητικών στοιχείων και κυκλωμάτων. 

Μιας και βασιστήκαμε σε κάποιο άλλο λογισμικό για τον σχεδιασμό του κυκλώματος και της 

πλακέτας, θα χρησιμοποιήσουμε το πακέτο λογισμικού CST Studio για την ανάλυση και την 

βελτιστοποίηση της πλακέτας μας. Πιο συγκεκριμένα θα χρησιμοποιήσουμε δύο στοιχεία του CST 

Studio, το PCB Studio και το Microwave Studio.  

Στο κομμάτι του PCB Studio θα γίνει η εισαγωγή της ήδη σχεδιασμένης πλακέτας. Εκεί θα 

οριστούν τα υλικά που χρησιμοποιούνται, καθώς και οι διαστάσεις της πλακέτας. 

Αφού πλέον το Project θα είναι σε μία πιο συμβατή μορφή, θα εισαχθεί στο Microwave Studio, 

όπου και θα πραγματοποιηθεί η ανάλυση και τυχόν βελτιστοποίησή του. 

 

Τα βήματα που θα ακολουθήσουμε είναι: 

 Εισαγωγή των αρχείων 

 Ορισμός διαστάσεων και υλικού πλακέτας 

 Έλεγχος – ορισμός επιπέδων πλακέτας (stackup) 

 Ορισμός Net 

 Ορισμός θυρών 

 Έλεγχος πλακέτας για λάθη 

 Εισαγωγή στο Microwave Studio για ανάλυση 
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3.1. Εισαγωγή αρχείων πλακέτας 

Είμαστε έτοιμοι να εισαγάγουμε τα παραγόμενα αρχεία της πλακέτας προς μελέτη στο CST Studio 

Suite. 

Ανοίγουμε το PCB Studio, στη συνέχεια επιλέγουμε Import > EDA Import. 

 
Εικόνα 132: Εισαγωγή αρχείου ODB++ (1) 

Στο παράθυρο που αναδύεται, επιλέγουμε ODB++ και στην συνέχεια χρησιμοποιούμε το παράθυρο 

πλοήγησης, αναζητώντας τα αρχεία εξαγωγής του Altium για την πλακέτα μας. 

 

 
Εικόνα 133: Εισαγωγή αρχείου ODB++ (2) 
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Επιλέγουμε το αρχείο και στην συνέχεια πατάμε εισαγωγή. 

 

 
Εικόνα 134: Εισαγωγή αρχείου ODB++ (3) 

 

 
Εικόνα 135: Εισαγωγή αρχείου ODB++ (4) 
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Μετά το τέλος της επεξεργασίας των αρχείων, στην κύρια οθόνη του CST θα εμφανιστεί η πλακέτα 

μας έτοιμη προς επεξεργασία. 

 

 
Εικόνα 136: Εισαγωγή αρχείου ODB++ (5) 
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3.2. Ορισμός διαστάσεων και υλικού πλακέτας 

 

Για να ορίσουμε τις διαστάσεις της πλακέτας, καθώς και το υλικό που θα χρησιμοποιήσουμε, από το 

Navigation Tree επιλέγουμε: Technology > Board > Edit Outline 

 
Εικόνα 137: Ορισμός διαστάσεων πλακέτας (1) 

 

Στην συνέχεια θα αναδυθεί παράθυρο όπου θα ορίσουμε επακριβώς τις διαστάσεις της πλακέτας. 

 
Εικόνα 138: Ορισμός διαστάσεων πλακέτας (2) 
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Αφού ελέγξουμε - ορίσουμε τις διαστάσεις της πλακέτας μπορούμε να επιλέξουμε και το υλικό από 

το οποίο αυτή θα αποτελείται. 

 
Εικόνα 139: Επιλογή υλικού πλακέτας 

 

Στο Navigation Tree μπορούμε να ορίσουμε τις ιδιότητες των υλικών που θα χρησιμοποιήσουμε 

στο Project. Κάνοντας δεξί κλικ στο εκάστοτε υλικό, μπορούμε να επεξεργαστούμε τις ιδιότητές 

του. 
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Εικόνα 140: Επεξεργασία υλικού πλακέτας (1) 

Εκεί θα ορίσουμε και την διηλεκτρική σταθερά που μας ορίζει ο κατασκευαστής. 

 
Εικόνα 141: Επεξεργασία υλικού πλακέτας (2) 

 

3.3. Έλεγχος – ορισμός επιπέδων πλακέτας (stackup) 

 

Στο σημείο αυτό θα προβάλουμε και θα ελέγξουμε το stackup της πλακέτας.  

Στο κεντρικό παράθυρο του προγράμματος και στην επάνω μπάρα με τις συντομεύσεις επιλέγουμε 

την συντόμευση Stackup.  
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Εικόνα 142: Επιλογές για το Stackup (1) 
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Αμέσως αναδύεται νέο παράθυρο με τα επίπεδα της πλακέτας. Παρατηρούμε πως υπάρχουν και δύο 

επιπλέον επίπεδα SOLDER_MASK_TOP και SOLDER_MASK_BOTTOM. 

Όταν αντίστοιχα θα τρέξουμε τον ενσωματωμένο έλεγχο για την ορθότητα των επιπέδων, θα δούμε 

πως τα επίπεδα αυτά έχουν μηδενικό πάχος. 

 

 
Εικόνα 143: Επιλογές για το Stackup (2) 

 

 
Εικόνα 144: Επιλογές για το Stackup (3) 
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Μπορούμε να διαγράψουμε τα επίπεδα αυτά για να συνεχίσουμε με την ανάλυση της πλακέτας. 

 

 
Εικόνα 145: Επιλογές για το Stackup (4) 

 

Σημαντικό εδώ είναι να επεξηγήσουμε το πεδίο Fill, που αναγράφεται και στον παραπάνω πίνακα 

της εικόνας (Εικόνα 145). Ουσιαστικά πρόκειται για την τοποθέτηση επάνω στην ενδιάμεση στρώση 

διηλεκτρικού υλικού. Στην περίπτωσή μας, το επάνω επίπεδο χαλκού (L1) θα είναι επάνω (above) 

και το κάτω επίπεδο χαλκού θα είναι κάτω (below) από το διηλεκτρικό υλικό μας. 

Στη περίπτωση που υπήρχε επίπεδο χαλκού ενδιάμεσα σε δύο στρώσεις διηλεκτρικού υλικού, 

ανάλογα με την επιλογή που θα ορίζαμε, το τελικό αποτέλεσμα θα ήταν όπως και στην παρακάτω 

εικόνα (Εικόνα 146). 

 
Εικόνα 146: Επεξήγηση Fill 

 

 
Εικόνα 147: : Επιλογές για το Stackup (5) 
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3.4. Ορισμός Nets 

Στο σημείο αυτό θα επεξεργαστούμε τα Nets χρησιμοποιώντας τον ενσωματωμένο Net Editor του 

PCB Studio. Η χρήση των nets κατά τον σχεδιασμό μίας πλακέτας, μας βοηθά για να 

κατηγοριοποιήσουμε τα σήματα. Για παράδειγμα, όλα τα pad σε μία πλακέτα, τα οποία πρέπει να 

συνδεθούν στο Ground, ανήκουν όλα στο net Ground και στην αντίστοιχη κλάση. Έτσι μπορούμε να 

κατηγοριοποιήσουμε τους αγωγούς που χρησιμοποιούνται στη μεταφορά σημάτων, τη μεταφορά 

ισχύος, τη μεταφορά κρίσιμων σημάτων κ.ο.κ. 

Από το επάνω μέρος του παραθύρου, επιλέγουμε Net Editor. 

 

 
Εικόνα 148: Net Editor (1) 

 

Ένα νέο παράθυρο αναδύεται. Εδώ εμπεριέχονται όλες οι πληροφορίες σχετικά με τα Nets  που 

βρίσκονται στην πλακέτα μας. 

 
Εικόνα 149: Net Editor (2) 

Κάνοντας διπλό κλικ με το ποντίκι μας επάνω σε ένα Net, εμφανίζεται ένα παράθυρο από όπου 

μπορούμε να επιλέξουμε τον τύπο του σήματος που διαπερνά το Net αυτό. Όπως φαίνεται και στην 

παρακάτω εικόνα, θα δώσουμε την ιδιότητα power στο Net που επιλέξαμε, μιας και επιλέξαμε αυτό 

των 5V. 
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Εικόνα 150: Ιδιότητες των Net 

Αν παρατηρήσουμε και την πλακέτα, θα δούμε πως το συγκεκριμένο Net επισημαίνεται και στην 

πλακέτα μόλις το επιλέξουμε από τον Net Editor. Μπορούμε να έχουμε έτσι μία καλύτερη αντίληψη 

για το ποιο είναι εκείνο το Net που επεξεργαζόμαστε. 

 
Εικόνα 151: Επισήμανση των Nets στην πλακέτα 

Στην περίπτωση που χρειάζεται, μπορούμε να ορίσουμε και διαφορικό ζεύγος Net. Αρχίζουμε 

επιλέγοντας ένα Net από τον Net Editor, στην συνέχεια του ορίζουμε την κλάση differential και 

τέλος επιλέγουμε και το δεύτερο Net που επιθυμούμε. Αν και δεν έχουμε κάποια χρήση στη 
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συγκεκριμένη πλακέτα διαφορικών σημάτων αφού τα σήματά μας θα πρέπει να είναι συμφασικά, θα 

χρησιμοποιήσουμε την επιλογή αυτή στον μετέπειτα αυτοματοποιημένο έλεγχο της πλακέτας, όπου 

θα επιβεβαιώσουμε την διαφορά μήκους των ζευγών μας ή αν θέλετε την απόκλιση μήκους των 

γραμμών μεταφοράς. 

 
Εικόνα 152: Ορισμός διαφορικού ζεύγους (1) 

 

 
Εικόνα 153: Ορισμός διαφορικού ζεύγους (2) 

Βλέποντας την εισαγόμενη πλακέτα, παρατηρούμε πως τα Nets, που δεν συνδέονται πουθενά, που 

είναι δηλαδή ανοικτοκυκλωμένα, είναι αρκετά. Επιλέγοντάς τα, διαπιστώνουμε πως πρόκειται για 
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γραμμές που προορίζονται για την μεταξοτυπία της πλακέτας. Ένα τέτοιο Net στην περίπτωσή μας 

είναι το NONE__30. Πρόκειται για Net που σχηματίζει το περίγραμμα του εξαρτήματος 

HMC252A. 

 

 
Εικόνα 154: Διαγραφή περιττών Net 
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3.5. Ορισμός θυρών 

Αφού έχουμε ορίσει σωστά τα Net συνεχίζουμε ορίζοντας τις θύρες (ports) του κυκλώματος. 

Για να ορίσουμε μία θύρα στο PCB Editor επιλέγουμε: Edit > Terminals. 

 

 
Εικόνα 155: Εισαγωγή Terminal (1) 

 

Στο παράθυρο που αναδύεται επιλέγουμε την δημιουργία νέου τερματικού (Terminal).  

 

 
Εικόνα 156: Εισαγωγή Terminal (2) 
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Στο επόμενο παράθυρο επιλέγουμε το Net στο οποίο αυτό θα αντιστοιχεί, καθώς επίσης και την θέση 

του τερματικού, δηλαδή της θύρας. Συνεχίζουμε και για τις υπόλοιπες θύρες του κυκλώματός μας. 

 

 
Εικόνα 157: Εισαγωγή Terminal (3) 

 

3.6. Έλεγχος πλακέτας για λάθη 

Προτού προχωρήσουμε στους αυτόματους οδηγούς εύρεσης λαθών, ακολουθώντας έναν οπτικό 

έλεγχο της πλακέτας παρατηρούμε μερικά σφάλματα ή και ατέλειες από το αρχικό πρόγραμμα 

σχεδιασμού.  

Στο συγκεκριμένο παράδειγμα, μπορούμε να παρατηρήσουμε τις μικρές αιχμές που μένουν από το 

κομμάτι χαλκού στην επαφή της αντίστασης R3. Μπορούμε να επεξεργαστούμε το κομμάτι χαλκού, 

επιλέγοντας το αντίστοιχο Trace με δεξί κλικ και στην συνέχεια επιλέγοντας Edit. 

 
Εικόνα 158: Επεξεργασία ηλεκτρικών αγωγών (1) 

Αναδύεται ένα νέο παράθυρο και μας δίνεται η επιλογή να σείρουμε με τον δείκτη του ποντικιού το 

άκρο του χάλκινου αγωγού. 
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Εικόνα 159: Επεξεργασία ηλεκτρικών αγωγών (2) 

Συνεχίζοντας, παρατηρούμε και μία ασυνέχεια στο κομμάτι της γείωσης, κοντά στους πυκνωτές C10 

και C11. Στο σημείο αυτό μπορούμε να προσθέσουμε περιοχή χαλκού, κάνοντας δεξί κλικ επάνω στο 

κομμάτι της πλακέτας και επιλέγοντας από το αναδυόμενο μενού Create New Objects. 

 
Εικόνα 160: Επεξεργασία ηλεκτρικών αγωγών (3) 

Στο νέο παράθυρο που θα αναδυθεί, επιλέγουμε την δημιουργία ενός νέου πολύγωνου. Αναδύεται νέο 

παράθυρο που επιλέγουμε τις συντεταγμένες του πολύγωνου επάνω στην πλακέτα μας. 
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Εικόνα 161: Διόρθωση ασυνεχιών χαλκού (1) 

 

 
Εικόνα 162: Διόρθωση ασυνεχιών χαλκού (2) 
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Συνεχίζοντας με τα αυτοματοποιημένα εργαλεία ελέγχου πλακέτας, από την αρχική καρτέλα του 

προγράμματος (Home) επιλέγουμε το Start BOARDCHEK Rule Checking. Ουσιαστικά 

πρόκειται για ένα εργαλείο που έχει σαν είσοδο κανόνες που ορίζει ο χρήστης και ελέγχει την 

πλακέτα για την τήρηση αυτών των κανόνων. 

 
Εικόνα 163: Εκκίνηση οδηγού ελέγχου πλακέτας  

Επιλέγοντας την καρτέλα Rules στο παράθυρο που αναδύεται, βλέπουμε μία σειρά κανόνων που 

μπορούμε να ορίσουμε για τα κρίσιμα σήματα, όπως τον έλεγχο του αν αλλάζουν επίπεδο στην 

πλακέτα μας κατά την μεταφορά τους ή παραμένουν στο ίδιο επίπεδο. Πιο αναλυτικά, θα δούμε το 

κομμάτι των διαφορικών σημάτων, τα οποία και επιλέξαμε πιο νωρίς κατά την διάρκεια ορισμού των 

Nets. 
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Εικόνα 164: Οδηγός ελέγχου πλακέτας (1)  



111 

Μεταπτυχιακή Διπλωματική Εργασία, Διονύσης Δεληγιαννόπουλος, ΑΜ: IES-0015 

Διαλέγουμε λοιπόν την επιλογή Critical Differential Net Matching και ορίζουμε από το δεξί 

μέρος του παραθύρου την μέγιστη απόσταση ανάμεσα στους δύο αγωγούς, καθώς και την μέγιστη 

επιτρεπτή διαφορά μήκους που θα έχουν.  

 

 
Εικόνα 165: Οδηγός ελέγχου πλακέτας (2) 

 

Στην αντίστοιχη καρτέλα του οδηγού Nets, μπορούμε να ορίσουμε ή να αλλάξουμε τα Nets σε 

σχέση με τις επιλογές που έχουμε θέσει ήδη. 

 

 
Εικόνα 166: Οδηγός ελέγχου πλακέτας (3) 
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Στην καρτέλα Components μπορούμε να δούμε τις τιμές των στοιχείων-υλικών που έχουμε επάνω 

στην πλακέτα. Ειδικότερα, μας δίνεται και η δυνατότητα να ορίσουμε το σχετικό Touchstone 
αρχείο για την καλύτερη προσομοίωση του κυκλώματος. Επειδή ωστόσο αυτό δεν μεταφέρεται στο 

επόμενο βήμα της εξαγωγής σε τρισδιάστατο μοντέλο στο CST Microwave Studio, θα 

παραλείψουμε αυτό το βήμα. 

 

 
Εικόνα 167: Οδηγός ελέγχου πλακέτας (4) 

 

Τέλος επιλέγουμε την εκκίνηση του αυτοματοποιημένου ελέγχου της πλακέτας, επιλέγοντας Start. 
 

 
Εικόνα 168: Οδηγός ελέγχου πλακέτας (5) 
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Ένα ακόμα εργαλείο αυτοματοποιημένου ελέγχου που μας παρέχεται είναι το Layout Check. Το 

βρίσκουμε στην καρτέλα Edit.  
 

 
Εικόνα 169: Εκκίνηση ελέγχου Layout 

Με το συγκεκριμένο εργαλείο μπορούμε να εντοπίσουμε σημεία αγωγών, διαφορετικά Nets, τα 

οποία αλληλοκαλύπτονται καθώς επίσης και ανοιχτούς κόμβους (Overlaps, Open-Ended Nodes). 

 

 
Εικόνα 170: Έλεγχος Overlaps (1) 
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Επιλέγοντας την εκκίνηση του εργαλείου ελέγχου, το πρόγραμμα αναγνωρίζει την περιοχή όπου 

δημιουργήσαμε για να καλύψουμε το κενό που υπήρχε στην γείωση, καθώς και ποια Nets 
εμπλέκονται. 

 

 
Εικόνα 171: Έλεγχος Overlaps (2) 

Διορθώνουμε ορίζοντας την περιοχή που δημιουργήσαμε μέρος του Net GND. 
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3.7. Εισαγωγή στο Microwave Studio για ανάλυση 

Αποθηκεύουμε το αρχείο μας και στην συνέχεια επιλέγουμε από την αρχική καρτέλα (Home) την 

επιλογή Export. 

 

 
Εικόνα 172: Εκκίνηση εξαγωγής προς Microwave Studio 

 

Ακολούθως, αναδύεται παράθυρο με τις σχετικές επιλογές για την εξαγωγή του αρχείου στο 

Microwave Studio. 

Εκεί αρχικά επιλέγουμε τις θύρες του κυκλώματος, όπως τις ορίσαμε και παραπάνω. 

 

 
Εικόνα 173: Εξαγωγή προς Microwave Studio (1) 
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Εικόνα 174: Εξαγωγή προς Microwave Studio (2) 

 

Αφού τελειώσουμε με την επιλογή των διακριτών θυρών, επιλέγουμε την επιλογή Specials. Εκεί 

μπορούμε να ορίσουμε διάφορες επιλογές για την εξαγωγή της πλακέτας στο Microwave Studio.  

 
Εικόνα 175: Εξαγωγή προς Microwave Studio (3) 

 

Επιλέγουμε την αναπαράσταση των επιπέδων (δυσδιάστατα ή τρισδιάστατα) καθώς και την ακρίβεια 

με την οποία θα γίνει η αναπαραγωγή τους. Για την καλύτερη απόδοση στο τρισδιάστατο σχέδιο, 

συνιστάται η επιλογή Use straight-line geometry. Πρόκειται για την χρήση αλγορίθμου που  

προσπαθεί να αναπαραστήσει με ευθύγραμμα τμήματα καμπύλες και τόξα που πιθανόν να έχουν οι 

μεταλλικοί αγωγοί, απλοποιώντας έτσι κατά πολύ το σχέδιο κατά την διάρκεια του meshing κατά 

την ανάλυση της πλακέτας.  



117 

Μεταπτυχιακή Διπλωματική Εργασία, Διονύσης Δεληγιαννόπουλος, ΑΜ: IES-0015 

 
Εικόνα 176: Εξαγωγή προς Microwave Studio (4) 

 

Για να απλοποιήσουμε περαιτέρω την ανάλυση της πλακέτας, μπορούμε να επιλέξουμε και την 

προσέγγιση των κυκλικών σημείων των vias, προσεγγίζοντας την αναπαράστασή τους με εξάγωνα, 

οκτάγωνα ή τετράγωνα.  

 
Εικόνα 177: Εξαγωγή προς Microwave Studio (5) 

 

Στη συνέχεια, μπορούμε να επιλέγουμε την ανύψωση των ισοδύναμων κυκλωμάτων των υλικών στην 

πλακέτα μας, καθώς επίσης και σε ποιο σημείο θα βρίσκονται τα άκρα του ισοδύναμου κυκλώματος 

των υλικών σε σχέση με τους αγωγούς του χαλκού. 
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Εικόνα 178: Εξαγωγή προς Microwave Studio (6) 

 

Αφού ολοκληρώσουμε με την επιλογή όλων των επιμέρους παραμέτρων που επιθυμούμε να 

αλλάξουμε, επιλέγουμε OK. 

 
Εικόνα 179: Εξαγωγή προς Microwave Studio (7) 

  

Προχωρούμε στον τελικό έλεγχο των επιλογών μας, επιλέγοντας Check. 
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Εικόνα 180: Εξαγωγή προς Microwave Studio (8) 

 

Εμφανίζεται μία συνολική εκτύπωση που περιγράφει την κατάσταση των υλικών και των στοιχείων 

που θα εξαχθούν. 

 
Εικόνα 181: Εξαγωγή προς Microwave Studio (9) 
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Τέλος επιλέγουμε ΟΚ και μετά από μία σχετική επεξεργασία, ανοίγει δεύτερο Project στον χώρο 

εργασίας του προγράμματος με το τρισδιάστατο μοντέλο της πλακέτας μας. 

 

 
Εικόνα 182: Εξαγωγή προς Microwave Studio (10) 

 

 
Εικόνα 183: Το Project στο Microwave Studio 
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ΚΕΦΑΛΑΙΟ 4: 

Microwave Studio – CST Studio Suite 

 

 

Έχοντας εισαγάγει την πλακέτα μας στο Microwave Studio θα ετοιμάσουμε την πλακέτα για 

προσομοίωση και βάσει των αποτελεσμάτων, θα προχωρήσουμε στην βελτιστοποίησή της. 

 

Τα βήματα που θα ακολουθήσουμε είναι τα εξής:  

 Διαχωρισμός της πλακέτας στα επιμέρους κυκλώματα, αρχική προσομοίωση και ρυθμίσεις 

 Βελτιστοποίηση και διόρθωση των επιμέρους κυκλωμάτων. Βελτιστοποίηση με την χρήση 

αυτόματων εργαλείων βελτιστοποίησης (Optimizer) 

 Παρουσίαση αποτελεσμάτων επιμέρους κομματιών της πλακέτας και εξαγωγή αρχείων 

touchstone για το κάθε μέρος του κυκλώματος 

 Εισαγωγή όλων των αρχείων σε ένα νέο αρχείο μαζί με τα ολοκληρωμένα κυκλώματα. 

 

4.1. Διαχωρισμός της πλακέτας σε επιμέρους κυκλώματα, αρχική προσομοίωση και 

ρυθμίσεις 

Έχοντας ανοιχτό το project της πλακέτας μας, θα αρχίσουμε να απομονώνουμε σταδιακά τα κομμάτια 

της πλακέτας με σκοπό την επιμέρους βελτιστοποίησή τους. 

 

Αρχίζουμε απομονώνοντας το πρώτο κομμάτι από την είσοδο του κυκλώματος, μέχρι το πρώτο 

ολοκληρωμένο κύκλωμα, RF switch, το HMC252AQS24E. 

 

 
Εικόνα 184: Απόμόνωση πρώτου κυκλώματος πλακέτας 
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Χρησιμοποιούμε blocks, για να πραγματοποιήσουμε την απόμόνωση, «κόβοντας» κομμάτια της 

πλακέτας. 

 

Καταλήγουμε στην παρακάτω μορφή: 

 

 
Εικόνα 185: Απομονωμένο κύκλωμα πλακέτας 

 

 

Ακολούθως, και για να είναι παραμετρικό το σχέδιό μας, θα σβήσουμε τους υπάρχοντες χάλκινους 

αγωγούς ώστε να δημιουργήσουμε καινούριους, των οποίων οι διαστάσεις θα διαμορφώνονται με τις 

μεταβλητές που θα επιλέξουμε. 

 

 
Εικόνα 186: Διαγραφή χάλκινων αγωγών 
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Θα χρησιμοποιήσουμε το εργαλείο Curve στο παράθυρο Modeling του προγράμματος και θα 

ορίσουμε το μήκος των γραμμών χαλκού. 

 

 
Εικόνα 187: Ορισμός χάλκινων αγωγών με Curves (1) 

 

 

Αφού σχεδιάσουμε την γραμμή που επιθυμούμε επάνω στην πλακέτα πατάμε το πλήκτρο ESC και 

στην συνέχεια εμφανίζεται το παράθυρο επιθεώρησης των σημείων που επιλέξαμε. 

 

 
Εικόνα 188: Ορισμός χάλκινων αγωγών με Curves (2) 

 

Επαναλαμβάνουμε την ίδια διαδικασία για μία νέα γραμμή και φροντίζουμε να βρίσκεται σε 

διαφορετικό φάκελο στο Navigation Tree.  
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Στη συνέχεια, πάλι στο παράθυρο Modeling, επιλέγουμε Curve Tools , Trace from Curve. 

Επιλέγουμε μία από τις δύο γραμμές και στην συνέχεια επικυρώνουμε με το Enter. 

 

 
Εικόνα 189: Ορισμός χάλκινων αγωγών με Curves (3) 

 

Στο νέο παράθυρο που αναδύεται, επιλέγουμε το υλικό, σε ποιόν φάκελο Component θα ενταχθεί 

και τις διαστάσεις τις οποίες θα έχει. Όπως φαίνεται και στην παρακάτω εικόνα, οι διαστάσεις που 

χρησιμοποιούμε είναι μεταβλητές που έχουμε ήδη δημιουργήσει. 

 

 
Εικόνα 190: Ορισμός χάλκινων αγωγών με Curves (4) 

 

           το κενό ανάμεσα στον κεντρικό αγωγό και στην γη 

           το πάχος του κεντρικού αγωγού 

h = 0.745 mm  το ύψος του διηλεκτρικού υλικού 

copperHeight = 0.035 mm το ύψος του χαλκού 
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Αφού επιβεβαιώσουμε τη δημιουργία του νέου αυτού block, εμφανίζεται νέο παράθυρο όπου και θα 

επιλέξουμε την ενέργεια που θα ακολουθηθεί μιας και το block αυτό που δημιουργήσαμε 

διασταυρώνεται με το ήδη υπάρχον υλικό χαλκού. Επιλέγουμε Cut away highlighted shape. 

 

 
Εικόνα 191: Ορισμός αποστάσεων των αγωγών από το Ground Plane 

 

Αφού ολοκληρώσαμε την υλοποίηση του κενού που θα υπάρχει γύρω από τον χάλκινο αγωγό, 

επαναλαμβάνουμε την διαδικασία για την δεύτερη γραμμή που έχουμε, ώστε να δημιουργήσουμε και 

τον ίδιο τον αγωγό. 

 
Εικόνα 192: Πρόσθεση αγωγού 

 

Στην συνέχεια, αφού δημιουργηθεί και ο αγωγός χαλκού, θα προσθέσουμε τα επιμέρους σχήματα-

blocks μεταξύ τους. Επιλέγουμε τα στοιχεία που θέλουμε να προσθέσουμε-ενοποιήσουμε και 

επιλέγουμε από το παράθυρο Boolean, Add και στην συνέχεια πιέζουμε το πλήκτρο Enter. 

 



126 

Μεταπτυχιακή Διπλωματική Εργασία, Διονύσης Δεληγιαννόπουλος, ΑΜ: IES-0015 

 
Εικόνα 193: Συνδυασμός επιμέρους κομματιών αγωγού  

  

Αφού έχουμε τελειώσει με την πρόσθεση των επιμέρους αντικειμένων, θα προχωρήσουμε στον 

ορισμό των θυρών. Σύμφωνα και με την βιβλιογραφία του προγράμματος, για το GCPW θα 

ακολουθήσουμε τις ίδιες βασικές αρχές για την δημιουργία των θυρών όπως και στην μικροταινία.  

Αρχικά, το μέγεθος της θύρας θα πρέπει να είναι αρκετά μεγάλο ώστε να περικλείει αρκετό μέρος του 

αγωγού. Ωστόσο, δεν πρέπει να είναι υπερμεγέθης, ώστε να επιτρέπεται η διάδοση κυμάτων 

υψηλότερης τάξης. Ιδανικά η θύρα που θα χρησιμοποιηθεί, θα πρέπει να είναι δύο με τρείς φορές 

μεγαλύτερη σε μήκος και δύο φορές μικρότερη σε ύψος σε σχέση με τον πλάτος του αγωγού και των 

πλευρικών αποστάσεων από τη γη, όπως φαίνεται στην παρακάτω εικόνα (Εικόνα 194). 

 
Εικόνα 194: Απεικόνιση διαστάσεων θύρας 

 

Θα χρησιμοποιήσουμε κάποιες μεταβλητές ώστε να μπορούμε να αλλάξουμε το μέγεθος δυναμικά 

και να μπορούμε να χρησιμοποιήσουμε τον Optimizer που προσφέρεται αν μετατρέψουμε το σχέδιό 

μας σε παραμετρικό. Θα  δημιουργήσουμε τις μεταβλητές σε σχέση με τα μεγέθη του SMA connector 

που βρίσκεται στην άκρη της πλακέτας, και στην συνέχεια, σύμφωνα με τα μεγέθη που έχουμε 

χρησιμοποιήσει για το GCPW, θα συγκρίνουμε τα δύο αποτελέσματα. 
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            το κενό ανάμεσα στον κεντρικό αγωγό και στην γη 

            το πάχος του κεντρικού αγωγού 

h = 0.745 mm  το ύψος του διηλεκτρικού υλικού 

 

 
Εικόνα 195: Ορισμός διαστάσεων θύρας (1) 

 

Για να δημιουργήσουμε ευκολότερα την θύρα, μπορούμε να χρησιμοποιήσουμε το εργαλείο επιλογής 

σημείων που προσφέρει το CST.  

 

Στο αρχικό παράθυρο, επιλέγουμε Simulation > Picks > Pick End Point. Με το εργαλείο αυτό 

μπορούμε να επιλέξουμε σημεία και αιχμές στο τρισδιάστατο μοντέλο. 

 

 
Εικόνα 196: Ορισμός διαστάσεων θύρας (2) 
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Επιλέγουμε τις γωνίες του χάλκινου αγωγού του κονέκτορα που εφάπτονται στο υπόστρωμα της 

πλακέτας.  

 

 
Εικόνα 197: Ορισμός διαστάσεων θύρας (3) 

 

Στην συνέχεια επιλέγουμε την τοποθέτηση θύρας κυματοδηγού, από το αρχικό παράθυρο, 

Simulation > Waveguide Port. 
 

 
Εικόνα 198: Ορισμός θύρας τύπου Waveguide Port (1) 

 

Αναδύεται νέο παράθυρο με τις επιλογές της θύρας κυματοδηγού, όπου θα ορίσουμε το επίπεδο στο 

οποίο αυτή θα βρίσκεται, τις συντεταγμένες και την κατεύθυνση που θα έχει. 
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Εικόνα 199: Ορισμός θύρας τύπου Waveguide Port (2) 

 

Όπως αναφέραμε και πιο πριν, πρέπει η θύρα που θα χρησιμοποιηθεί, να είναι δύο με τρείς φορές 

μεγαλύτερη σε μήκος σε σχέση με τον αγωγό και δύο φορές μικρότερη σε ύψος σε σχέση με τον 

αγωγό και τις πλευρικές αποστάσεις από την γη επάνω από το υποστηρικτικό υλικό της πλακέτας. 

Αυτό αντικατοπτρίζεται και στην σχέση που ορίσαμε για το ελάχιστο σημείο στον άξονα Υ.  

             
  

 
 

Όπου: 

    το σημείο που ορίστηκε από τον επιλογέα, 

           

   = 0.15 mm 
   = 1.27 mm 

 
Ορίζουμε αντίστοιχα και το μέγιστο σημείο στον άξονα Y. 

             
  

 
 

 

Έτσι στο σύνολο, το μήκος της θύρας είναι διπλάσιο του w1 

Όσον αφορά το ύψος της θύρας έχουμε: 

         

       
  

 
 

Όπου: 

Ζ το σημείο που ορίστηκε από τον επιλογέα, δεδομένο που στην περίπτωσή μας είναι κοινό. 

h το ύψος του διηλεκτρικού υλικού. 

 

Συνεχίζουμε ορίζοντας και την θύρα για το άλλο άκρο της πλακέτας. 
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Εικόνα 200: Ορισμός θύρας τύπου Waveguide Port (3) 

 

Ορίζουμε το εύρος συχνοτήτων που επιθυμούμε να εξετάσουμε την πλακέτα μας. 

Στην δική μας περίπτωση, δεδομένης της συχνότητας που χρησιμοποιεί το Freakduino το κέντρο 

του εύρους συχνοτήτων θα πρέπει να είναι πάνω από τα 900MHz.  

Ορίζουμε οπότε το εύρος συχνοτήτων στο Project από 0 έως 2.1GHz στο παράθυρο Simulation, 

και εν συνεχεία επιλέγουμε Frequency. Ένα παράθυρο αναδύεται και εκεί ορίζουμε το εύρος των 

συχνοτήτων. 

 

 
Εικόνα 201: Ορισμός εύρους συχνοτήτων Project  

 

Στην συνέχεια, θα ορίσουμε το Background υλικό στον επόμενο διάλογο. 
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Εικόνα 202: Ορισμός υλικού Background (1) 

 

 
Εικόνα 203: Ορισμός υλικού Background (2) 

 

Πρόκειται ουσιαστικά για τον ορισμό του υλικού μέσα στο άδειο χώρο του ορίου γύρω από την 

πλακέτα. Στην περίπτωσή μας, πρόκειται για τα κομμάτια επάνω και κάτω από την πλακέτα που 

ορίσαμε όπως φαίνεται και παραπάνω στα 10 χιλιοστά (Lower Z distance , Upper Z distance). 

 

Όσον αφορά στον τύπο του υλικού που θα γεμίσει τον κενό χώρο, έχουμε τις ακόλουθες επιλογές: 

 

 Να χρησιμοποιήσουμε κάποιο από τα προκαθορισμένα υλικά τα οποία περιλαμβάνουν PEC, 

Normal, Anisotropic καθώς και Lossy Metal. 

 Να ορίσουμε εμείς τις ιδιότητες του υλικού. 

 Να ορίσουμε πολλαπλά επίπεδα από διαφορετικά υλικά. 

 

Συνεχίζουμε ορίζοντας τον περιβάλλοντα χώρο γύρω από την πλακέτα μας. Για να τον ορίσουμε 

επιλέγουμε από το ίδιο σημείο ρυθμίσεων την επιλογή Boundaries. 
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Εικόνα 204: Ορισμός Boundaries (1) 

 

 
Εικόνα 205: Ορισμός Boundaries (2) 

Εδώ έχουμε τις ακόλουθες επιλογές: 

 Electric: Συμπεριφέρεται σαν τέλειος ηλεκτρικός αγωγός. Όλα τα εφαπτόμενα μαγνητικά 

πεδία και οι κανονικές ηλεκτρικές ροές θέτονται στο μηδέν. 

 Magnetic: Συμπεριφέρεται σαν τέλειος μαγνητικός αγωγός. Όλα τα εφαπτόμενα μαγνητικά 

πεδία και οι κανονικές ηλεκτρικές ροές θέτονται στο μηδέν.  

 Open: Πρόκειται για προσομοίωση ελεύθερου χώρου όπου τα κύματα μπορούν να περάσουν 

με ελάχιστες ανακλάσεις. 

 Open (add space): Ίδια συμπεριφορά με την προσομοίωση ελεύθερου ανοιχτού χώρου με 

την διαφορά ότι προσθέτει επιπλέον χώρο, που επιτρέπει την υλοποίηση των υπολογισμών για 

farfield. 

 Periodic: Συνδέει δύο αντιδιαμετρικά όρια (boundaries) με μία ορισμένη αλλαγή φάσης, 

τέτοια ώστε ο υπολογισμός που προσομοιώνεται, εκτείνεται περιοδικά στην συγκεκριμένη 

κατεύθυνση. 

 Conducting Wall: Συμπεριφέρεται σαν «τοίχος» αγωγού με απώλειες. 

 Unit Cell: Είναι παρόμοιο με το περιοδικό όριο, με την διαφορά ότι η περιοδικότητα που 

περιγράψαμε και παραπάνω είναι δυσδιάστατη.  

Επιπρόσθετα στο ίδιο παράθυρο, μπορούμε να προσθέσουμε και επίπεδα συμμετρίας απλοποιώντας 

έτσι κατά πολύ την υπολογιστική απαίτηση της προσομοίωσης, το οποίο όμως δεν μπορεί να 
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πραγματοποιηθεί στη δική μας πλακέτα, δεδομένου ότι δεν υπάρχει κανένα επίπεδο συμμετρίας στην 

κατασκευή μας. 

 

 
Εικόνα 206: Επιλογές συμμετρικών επιπέδων  

 

Ολοκληρώνουμε το κομμάτι των ρυθμίσεων προτού προχωρήσουμε στην προσομοίωση με τις 

σχετικές ρυθμίσεις του Solver. Από το κεντρικό παράθυρο, επιλέγουμε Setup Solver. 

 

 
Εικόνα 207: Εκκίνηση ορισμού επιλογών του Solver 

 

 
Εικόνα 208: Ορισμός επιλογών του Solver 
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Από αυτήν την οθόνη οι ρυθμίσεις που θα αλλάξουμε είναι η ακρίβεια (Accuracy), θα 

κανονικοποιήσουμε τις S-Parameters σε σταθερή σύνθετη αντίσταση των 50Ω και θα προχωρήσουμε 

σε μία ανάλυση μεταβλητού meshing (Adaptive Meshing). 

 

 Accuracy: Πρόκειται για την ακρίβεια της προσομοίωσης και επηρεάζει αρκετά τον χρόνο 

όπου αυτή θα χρειαστεί για να ολοκληρωθεί. Κάθε κομμάτι προσομοίωσης που 

διαδραματίζεται έχει έναν πεπερασμένο χρόνο εκτέλεσης. Στο τέλος του πεπερασμένου αυτού 

χρόνου, τα σήματα τα οποία έχουν εισέλθει στην προσομοίωση, μαζί με τη συνολική ενέργεια 

που βρίσκεται σε αυτήν υπολογίζονται με μετασχηματισμούς Fourier. Αν οι τιμές που 

χρησιμοποιούνται και υπολογίζονται από τους μετασχηματισμούς Fourier δεν είναι μηδενικοί, 

τότε στην προσομοίωσή μας υπάρχει ακόμη μέρος του σημάτων. Τα αρχικά δηλαδή σήματα 

που έχουν εισέλθει στην προσομοίωση δεν έχουν ολοκληρωθεί. Η τιμή που ορίζουμε από το 

Accuracy φέρει ακριβώς αυτό το αποτέλεσμα, πόσο μικρότερο θα είναι δηλαδή το μέγεθος των 

εναπομείναντων σημάτων μέσα στην προσομοίωση κατά την ολοκλήρωση του πεπερασμένου 

χρόνου της. 

 

 S-parameters (Normalize to fixed impedance): Οι S-Parameters πάντα 

κανονικοποιούνται με την σύνθετη αντίσταση της θύρας της προσομοίωσης. Στο πεδίο αυτό 

μπορούμε να ορίσουμε εμείς την τιμή που θα χρησιμοποιηθεί για την κανονικοποίηση. 

 

 Adaptive Meshing: Πρόκειται για την βελτιστοποίηση του mesh επάνω στο μοντέλο της 

προσομοίωσης. Με την επιλογή αυτή είτε προστίθενται νέες γραμμές για ευκρινέστερο 

meshing είτε ο αριθμός των κελιών του mesh αλλάζει δυναμικά. 

Έχοντας ορίσει τις ρυθμίσεις που επιθυμούμε, πιέζουμε το κουμπί εκκίνησης της προσομοίωσης 

(Start).  

Μετά από λίγο, η προσομοίωση σταματά και μας εμφανίζεται το παρακάτω σφάλμα στο πεδίο των 

μηνυμάτων:  

 

 
Εικόνα 209: Μήνυμα σφάλματος προσομοίωσης 
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Το σφάλμα αυτό οφείλεται στην ανομοιογένεια της κατασκευής κοντά στη θύρα 2 (Port 2). 

Δεδομένου ότι θέλουμε να γίνει βελτιστοποίηση του mesh, μιας και αυτό θα οδηγήσει σε καλύτερα 

αποτελέσματα ακόμα και με χαμηλή ακρίβεια, θα προχωρήσουμε στην αλλαγή της κατασκευής 

εμπρός από την θύρα 2. Θα γεμίσουμε τα κενά στο επάνω επίπεδο χαλκού και θα επανεκκινήσουμε 

την προσομοίωση. 

 

 
Εικόνα 210: Διόρθωση σφάλματος προσομοίωσης 

 

 
Εικόνα 211: Απεικόνιση κομματιού πλακέτας μετά την διόρθωση ανομοιογένειας κοντά 

στην θύρα 2 
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Μετά το πέρας της διόρθωσης εκκινούμε την προσομοίωση και μετά από μερικά λεπτά έχουμε τα 

αρχικά μας αποτελέσματα τα οποία παρατίθενται παρακάτω: 

 

 
Εικόνα 212: S-Parameters πρώτης προσομοίωσης 

 

 
Εικόνα 213: VSWR πρώτης προσομοίωσης 

 

Από το γράφημα του VSWR παρατηρούμε πως η αλλαγή που θα πρέπει να πραγματοποιήσουμε στην 

πλακέτα ξεπερνά τα όρια της βελτιστοποίησης των μεγεθών που σχετίζονται με το GCPW. 

Δεδομένου ότι η προσομοίωση που πραγματοποιούμε σχετίζεται με μέρη μίας πλακέτας και όχι με 

την πλακέτα ολόκληρη, πρέπει να αλλάξουμε τις ρυθμίσεις των ορίων που χρησιμοποιούμε 

(boundaries).  

Επιστρέφουμε λοιπόν στο παράθυρο ορισμού boundaries και επιλέγουμε electric boundary 

περιμετρικά της πλακέτας και open boundary επάνω και κάτω από την πλακέτα. 
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Εικόνα 214: Επιλογή Boundaries 

 

Προχωράμε σε νέα εκτέλεση της προσομοίωσης και έχουμε τα παρακάτω αποτελέσματα για S-

Parameters και VSWR. 

 

 
Εικόνα 215: S-Parameters μετά την αλλαγή των boundaries 

 

 
Εικόνα 216: VSWR μετά την αλλαγή των boundaries 

 

Εδώ παρατηρούμε πως υπάρχει πρόβλημα με την πρώτη θύρα στην προσομοίωση, κάτι λογικό, 

δεδομένου του σχήματος του pad του χαλκού όπου χρησιμεύει για να τοποθετηθεί ο SMA Connector. 

Απομονώνουμε ακόμη περισσότερο το κομμάτι του αγωγού μην λαμβάνοντας υπόψη το κομμάτι του 

SMA Connector που δεν μπορούμε εύκολα να προσομοιώσουμε. 
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Καταλήγουμε λοιπόν, στο παρακάτω κομμάτι πλακέτας, που έχουμε αλλάξει και την θύρα 1. 

Εκτελούμε εκ νέου την προσομοίωση και έχουμε τα παρακάτω αποτελέσματα. 

 

 
Εικόνα 217: Αλλαγή πλακέτας για κατάλληλη προσομοίωση 

 

 
Εικόνα 218: S-Parameters μετά την αλλαγή στην πρώτη θύρα 

 

 
Εικόνα 219: VSWR μετά την αλλαγή στην πρώτη θύρα 
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4.2. Βελτιστοποίηση και διόρθωση των επιμέρους κυκλωμάτων. Βελτιστοποίηση με την 

χρήση αυτόματων εργαλείων βελτιστοποίησης (Optimizer) 

 

Έχοντας μία αρχική εκτίμηση των αποτελεσμάτων της προσομοίωσης, θα προχωρήσουμε στην 

βελτιστοποίηση της πλακέτας με την βοήθεια του Optimizer. Από το κεντρικό παράθυρο, 

επιλέγουμε από το πεδίο Simulation την επιλογή Optimizer. Αναδύεται παράθυρο όπου 

περιλαμβάνει τις μεταβλητές που έχουμε στο σχέδιό μας. 

 

 
Εικόνα 220: Εκκίνηση Optimizer 

 

 
Εικόνα 221: Επιλογές Optimizer 

 

Στο παράθυρο αυτό μπορούμε να ορίσουμε τις μεταβλητές που επιθυμούμε να βελτιώσουμε. Αρχικά 

ορίζουμε τις ελάχιστες και μέγιστες τιμές που επιθυμούμε να έχουν οι μεταβλητές μας.  

Στην περίπτωσή μας, οι μεταβλητές που θα επηρεάσει ο Optimizer είναι το πλάτος των χάλκινων 

αγωγών (g) καθώς και το κενό μεταξύ χάλκινου αγωγού του σήματος και του επιπέδου ground της 

πλακέτας (s).  

Συνεχίζουμε ορίζοντας στόχους για τον Optimizer (Goals). 
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Εικόνα 222: Ορισμός στόχων Optimizer 

Διαλέγουμε την επιλογή Add new Goal και αναδύεται ένα νέο παράθυρο, μέσω του οποίου 

μπορούμε και να επιλέξουμε την κατάλληλη συνθήκη, τον κατάλληλο στόχο για τον Optimizer. 

 

 
Εικόνα 223: Προσθήκη στόχων του Optimizer 

 

Παρατηρώντας την παραπάνω εικόνα, βλέπουμε πως μας δίνονται αρκετές επιλογές, από S-

Parameters, VSWR, σύνθετη αντίσταση αναφοράς (Reference Impedance), εισερχόμενη ενέργεια, 

Adaptive Meshing, κλπ.  

Αφού ορίσουμε ποια μέτρηση θα χρησιμοποιεί ο Optimizer για να συγκρίνει και να επιλέξει τις 

κατάλληλες τιμές μεταβλητών, ορίζουμε και το μέγεθος αυτής της μέτρησης, την συνθήκη 

ικανοποίησης δηλαδή του Optimizer. 



141 

Μεταπτυχιακή Διπλωματική Εργασία, Διονύσης Δεληγιαννόπουλος, ΑΜ: IES-0015 

 

 
Εικόνα 224: Ορισμός στόχου VSWR για τον Optimizer 

Στο πεδίο των συνθηκών (Conditions) μπορούμε πέρα από τους λογικούς τελεστές (Operators) « > 
» , « < » , « = », να ορίσουμε και άλλες συνθήκες, όπως μέγιστο (max), ελάχιστο (min), μετατόπιση 

μέγιστου (move max), μετατόπιση ελάχιστου (move min) του οποίους εξηγούμε και παρακάτω: 

 

 max: Ο Optimizer προσπαθεί να μεγιστοποιήσει το μέγεθος προς σύγκριση. 

 min: Ο Optimizer προσπαθεί να ελαχιστοποιήσει το μέγεθος προς σύγκριση. 

 move max: Ο Optimizer προσπαθεί να μετακινήσει το μέγιστο που υπάρχει ήδη, στην 

επιλεγμένη συχνότητα ή εύρος συχνοτήτων. 

 move min: Ο Optimizer προσπαθεί να μετακινήσει το ελάχιστο που υπάρχει ήδη, στην 

επιλεγμένη συχνότητα ή εύρος συχνοτήτων. 

Ανάλογα με τον τελεστή που θα επιλέξουμε, ορίζουμε και το μέγεθος με το οποίο θα γίνει η 

σύγκριση, καθώς επίσης και το «βάρος» (Weight) που θα έχει γενικότερα η συνθήκη αυτή σε σχέση 

με τις υπόλοιπες στις προσεχείς προσομοιώσεις που θα ακολουθήσουν.  

 

Στο πεδίο Range μπορούμε να ορίσουμε είτε συγκεκριμένη συχνότητα, είτε να ορίσουμε εύρος 

συχνοτήτων είτε να προσπαθήσει ο Optimizer να βρει κατάλληλη τιμή για να ικανοποιήσει την 

συνθήκη στο σύνολο του εύρους των συχνοτήτων του project. 

 

Αφού ορίσουμε τους στόχους της προσομοίωσης μπορούμε να επιλέξουμε την έναρξη των 

προσομοιώσεων με το κουμπί Start. 
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Εικόνα 225: Εκκίνηση Optimizer 

 

Το παράθυρο του Optimizer θα εμφανίσει το πεδίο Info, το οποίο παρέχει πληροφορίες σχετικά με 

την πορεία του Optimizer, τις καλύτερες μεταβλητές που ικανοποιούν τους στόχους που έχουμε 

ορίσει και τον χρόνο της κάθε προσομοίωσης. 

Κάθε φορά, σε κάθε προσομοίωση, ο Optimizer θα μεταβάλλει μία μεταβλητή μέσα στο πλαίσιο 

που του έχουμε ορίσει, το πρόγραμμα θα ανατρέχει το ιστορικό των αλλαγών του project και θα 

τρέχει την προσομοίωση της πλακέτας, αφού θα εξαγάγει τα αποτελέσματα της προσομοίωσης και θα 

τα συγκρίνει με τους στόχους που του έχουμε ορίσει. 

Αν δεν ικανοποιεί τις συνθήκες, τότε θα συνεχίζει μεταβάλλοντας εκ νέου μία μεταβλητή, 

επαναλαμβάνοντας την παραπάνω διαδικασία. 

Η ροή αυτή θα συνεχίσει μέχρι να ικανοποιηθούν όσο επιτρέπεται καλύτερα από τις συνθήκες που 

έχουμε ορίσει. 
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Εικόνα 226: Παράθυρο προβολής κατάστασης Optimizer κατά την διάρκεια της 

προσομοίωσης 

 

Τα νέα αποτελέσματα για τις τιμές μεταβλητών του Optimizer είναι τα παρακάτω: 

 

 
Εικόνα 227: S-Parameters μετά την χρήση Optimizer 
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Εικόνα 228: VSWR μετά την χρήση Optimizer 

 

4.3. Παρουσίαση αποτελεσμάτων επιμέρους κομματιών της πλακέτας και εξαγωγή 

αρχείων touchstone για το κάθε μέρος του κυκλώματος 

 

Αφού έχουμε ολοκληρώσει την βελτιστοποίηση όλων των μερών της πλακέτας και έχουμε βρει τις 

βέλτιστες τιμές με την χρήση του Optimizer, θα εξαγάγουμε από το κάθε project ένα touchstone 

αρχείο για την προσομοίωση της συνολικής πλακέτας, αφού πρώτα παρουσιάσουμε τα αποτελέσματα 

των επιμέρους κομματιών της πλακέτας. 

Η πλακέτα χωρίστηκε σε 4 κομμάτια όπως αυτά εμφανίζονται και παρακάτω: 

 

 Από τον SMΑ connector μέχρι το πρώτο RF switch HMC252AQS24E 

 
Εικόνα 229: Απεικόνιση 1

ου
 μέρους πλακέτας από SMA connector μέχρι HMC252AQS24E 
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S-Parameters: 

 
Εικόνα 230: S-Parameters 1

ου
 μέρους πλακέτας 

 

Smith Chart: 

 

Εικόνα 231: Χάρτης Smith 1
ου

 μέρους πλακέτας 

 

VSWR: 

 
Εικόνα 232: VSWR 1

ου
 μέρους πλακέτας 
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 Από το RF switch HMC252AQS24E με απευθείας σύνδεση με το δεύτερο RF switch, το 

HMC284A 

 
Εικόνα 233: Απεικόνιση 2

ου
 μέρους πλακέτας από HMC252AQS24E μέχρι HMC284A 

 

S-Parameters: 

 
Εικόνα 234: S-Parameters 2

ου
 μέρους πλακέτας 

Smith Chart: 

 
Εικόνα 235: Χάρτης Smith 2

ου
 μέρους πλακέτας 
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VSWR: 

 
Εικόνα 236: VSWR 2

ου
 μέρους πλακέτας 

 

 Από το RF switch HMC252AQS24E μέχρι το δεύτερο RF switch, το HMC284A μέσω του 

Wilkinson Combiner/Divider. 

 
Εικόνα 237: Απεικόνιση 3

ου
 μέρους πλακέτας Wilkinson Combiner/Divider 
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S-Parameters: 

 
Εικόνα 238: S-Parameters Wilkinson Splitter/Combiner 

 

Smith Chart: 

 
Εικόνα 239: Χάρτης Smith Wilkinson Splitter/Combiner 

 

VSWR: 

 
Εικόνα 240: VSWR Wilkinson Splitter/Combiner 
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 Από το RF switch HMC284A έως τον SMA connector για την έξοδο του σήματος από την 

πλακέτα 

 
Εικόνα 241: Απεικόνιση 4

ου
 μέρους πλακέτας από HMC284A έως τον SMA connector 

 

S-Parameters: 

 
Εικόνα 242: S-Parameters 4

ου
 μέρους πλακέτας 
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Smith Chart: 

 
Εικόνα 243: Χάρτης Smith 4

ου
 μέρους πλακέτας 

 

VSWR: 

 
Εικόνα 244: VSWR 4

ου
 μέρους πλακέτας 

 

  



151 

Μεταπτυχιακή Διπλωματική Εργασία, Διονύσης Δεληγιαννόπουλος, ΑΜ: IES-0015 

Για να εξαγάγουμε τα τελικά αρχεία touchstone ώστε να προχωρήσουμε με την ολοκλήρωση της 

προσομοίωσης όλου του κυκλώματος, θα ακολουθήσουμε τα παρακάτω βήματα: 

Στο παράθυρο Post-Processing, επιλέγουμε Import/Export και στην συνέχεια κάτω από το πεδίο 

Export, επιλέγουμε τον τύπο TOUCHSTONE. 

 
Εικόνα 245: Εξαγωγή αρχείου touchstone 

 

Στην συνέχεια αναδύεται νέο παράθυρο με τις επιλογές της εξαγωγής: 

 
Εικόνα 246: Διάλογος εξαγωγής touchstone 

 

Εδώ επιλέγουμε την εξαγωγή των τρεχόντων αποτελεσμάτων (η επιλογή αυτή εμφανίζεται επειδή 

έχουμε χρησιμοποιήσει τον optimizer και έχουν αποθηκευτεί πολλαπλά αποτελέσματα με 

διαφορετικές τιμές μεταβλητών) . Επιλέγουμε την εξαγωγή των S-Parameters, κανονικοποιημένα 

με αντίσταση στα 50Ω και οι μονάδες θα είναι σε dB. Το προεπιλεγμένο εύρος συχνοτήτων και ο 

αριθμός των δειγμάτων μπορεί να μείνει ως έχει. Επιλέγουμε OK και ορίζουμε την θέση του 

αρχείου. 

Ανάλογα με το κομμάτι της πλακέτας, του οποίου τα αποτελέσματα επιθυμούμε να εξάγουμε, έχουμε 

και διαφορετικό τύπο αρχείου. 
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Συγκεκριμένα για τα κομμάτια της πλακέτας τα οποία είχαν μόνο δύο θύρες έχουμε αρχεία .s2p ενώ 

αντίστοιχα για το κομμάτι του Wilkinson Combiner/Divider όπου είχαμε τρείς θύρες, έχουμε 

αρχείο .s3p. 

 

Παραδείγματα των αρχείων αυτών παρατηρούμε στους παρακάτω πίνακες. 

 

Αρχείο: NETC2_1-NETC2_2(part1).s2p 

 

! TOUCHSTONE file generated by CST MICROWAVE STUDIO 

! Date and time: Sat Mar 20 21:53:06 2021 

! Project name: NETC2_1-NETC2_2 (part1).cst 

! Parameters = {copperHeight=0.035001; g=0.4; g1=1.27; h=0.71; s=0.124054; s1=0.15; w=0.648108; w1=1.57} 

! Header version: 2018 

! Port assignment regex: !\s*Touchstone port\s*([0-9]+)\s*=\s*(CST MWS port|CST DS port)\s*([0-

9]+|Zmin|Zmax)\s*\(\"(.*)\"\)(\s*mode\s*([0-9]+))?.* 

! Touchstone port assignment: 

! Touchstone port 1 = CST MWS port 1 ("Port1") 

! Touchstone port 2 = CST MWS port 2 ("Port2") 

# GHz S DB R 50 

0                      -0.130627     8.88774e-12         -38.4101     4.91359e-07         -38.4101     4.91359e-07       -0.0841749             180 

0.0021                 -0.181247        -6.65745         -18.7805         74.7425         -18.7805         74.7425        -0.179508         -23.933 

0.0042                 -0.331592        -13.1994         -12.9131         73.2203         -12.9131         73.2203        -0.330927        -20.4293 

0.0063                 -0.575574        -19.5189         -9.60369           68.87         -9.60369           68.87         -0.57532        -22.7996 

0.0084                 -0.904112        -25.5233         -7.38693         64.0056         -7.38693         64.0056        -0.904076        -26.4934 

… 

… 

… 

Πίνακας 3: Δείγμα αρχείου NETC2_1-NETC2_2(part1).s2p 
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Αρχείο: NETC13_1 – WilkinsonSplitter (part3_LumpedElements).s3p 

 

! TOUCHSTONE file generated by CST MICROWAVE STUDIO 

! Date and time: Sat Mar 20 21:54:53 2021 

! Project name: NETC13_1 - WilkinsonSplitter (part3_LumpedElements.cst 

! Parameters = {C1=3.48976e-12; C2=2.04546e-12; C2_Pad1_x=9.125; C2_Pad1_y=-0.32; C3_Pad1_x=23.005; C3_Pad1_y=1.45; 

Cc=1e-10; L1=7.14592e-09; L1_Pad1_x=15.315; L1_Pad1_y=4.68; R=100; R_Pad1_y=0.15; copperHeight=0.035001; g=0.6; g1=0.5; 
g_common=0.608432; g_port1=0.45; g_port2=0.5; h=0.710001; s=0.14; s1=0.19; s_common=0.142304; s_port1=0.15; s_port2=0.18; 

w=0.88; w1=0.88; w_common=0.89304; w_port1=0.75; w_port2=0.86} 

! Header version: 2018 

! Port assignment regex: !\s*Touchstone port\s*([0-9]+)\s*=\s*(CST MWS port|CST DS port)\s*([0-

9]+|Zmin|Zmax)\s*\(\"(.*)\"\)(\s*mode\s*([0-9]+))?.* 

! Touchstone port assignment: 

! Touchstone port 1 = CST MWS port 1 ("Port1") 

! Touchstone port 2 = CST MWS port 2 ("Port2") 

! Touchstone port 3 = CST MWS port 3 ("Port3") 

# GHz S DB R 50 

0                       -9.54242            -180         -3.52183              -0         -3.52183              -0   

                        -3.52183              -0         -9.54242            -180         -3.52183              -0   

                        -3.52183              -0         -3.52183              -0         -9.54242            -180   

0.0021                  -9.54243             180         -3.52183       -0.189038         -3.52183       -0.189038   

                        -3.52183       -0.189038         -9.54271         179.622         -3.52197         -0.3781   

                        -3.52183       -0.189038         -3.52197         -0.3781         -9.54271         179.622   

0.0042                  -9.54243             180         -3.52183       -0.378077         -3.52183       -0.378077   

                        -3.52183       -0.378077         -9.54356         179.244         -3.52239       -0.756185   

                        -3.52183       -0.378077         -3.52239       -0.756185         -9.54356         179.244   

0.0063                  -9.54243             180         -3.52183       -0.567115         -3.52183       -0.567115   

                        -3.52183       -0.567115         -9.54498         178.866          -3.5231        -1.13424   

                        -3.52183       -0.567115          -3.5231        -1.13424         -9.54498         178.866   

0.0084                  -9.54243             180         -3.52183       -0.756154         -3.52183       -0.756154   

                        -3.52183       -0.756154         -9.54696         178.488         -3.52409        -1.51224   

                        -3.52183       -0.756154         -3.52409        -1.51224         -9.54696         178.488 

… 

… 

Πίνακας 4: NETC13_1 – WilkinsonSplitter (part3_LumpedElements).s3p 
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4.4. Εισαγωγή όλων των αρχείων σε ένα νέο αρχείο μαζί με τα ολοκληρωμένα κυκλώματα. 

 

Αφού έχουμε κατεβάσει τα αντίστοιχα αρχεία για τα ολοκληρωμένα κυκλώματα RF switch που 

έχουμε χρησιμοποιήσει και έχοντας συγκεντρώσει όλα τα επιμέρους αρχεία μπορούμε να ανοίξουμε 

ένα νέο project στο Design Studio του CST και να αρχίσουμε να εισαγάγουμε τα αρχεία στην 

βιβλιοθήκη για την ευκολότερη προσπέλασή τους και σε μελλοντικά μας project. 

 

Από το κεντρικό παράθυρο στο Design Studio, επιλέγουμε: Device Model Library. Στην 

συνέχεια, επιλέγουμε Import from file. 

 

 
Εικόνα 247: Εισαγωγή μοντέλων στην βιβλιοθήκη (1) 

 

 
Εικόνα 248: Εισαγωγή μοντέλων στην βιβλιοθήκη (2) 
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Τέλος επιλέγουμε τον τύπο του μοντέλου που μόλις εισαγάγαμε. Μπορούμε πλέον να βρούμε το 

μοντέλο που εισαγάγαμε και να το χρησιμοποιήσουμε για την πραγματοποίηση της προσομοίωσής 

μας. 

 

 
Εικόνα 249: Εισαγωγή μοντέλων στην βιβλιοθήκη (3) 

 

 
Εικόνα 250: Εισαγωγή μοντέλων στην βιβλιοθήκη (4) 
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Επιλέγοντας το μοντέλο που επιθυμούμε και πιέζοντας το πλήκτρο Use, μπορούμε να το 

τοποθετήσουμε στο project μας. 

 

 
Εικόνα 251: Εισαγωγή μοντέλων στην βιβλιοθήκη (5) 

 

 
Εικόνα 252: Εισαγωγή των μοντέλων στο project για προσομοίωση 
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Αφού έχουμε εισαγάγει όλα τα μοντέλα από τις επιμέρους πλακέτες που φτιάξαμε, θα εισαγάγουμε 

και τα αρχεία των S-Parameters που μας προσφέρει ο κατασκευαστής των ολοκληρωμένων 

κυκλωμάτων RF switch που έχουμε χρησιμοποιήσει. Προσπαθώντας να εισαγάγουμε όμως τα 

αρχεία για το HMC252AQS24E που είναι ένας SP6T, παρουσιάζεται το εξής πρόβλημα: 

 

 
Εικόνα 253: Εισαγωγή έτοιμων μοντέλων από κατασκευαστή 

 

Το Design Studio του CST, δεν υποστηρίζει αρχεία .s7p. Ακόμη και αν ορίσουμε την επιλογή 

UNKNOWN στον επιλογέα εισαγωγής συσκευής, το πρόγραμμα δεν μπορεί να αναγνωρίσει αυτόν 

τον τύπο αρχείου. 

 
Εικόνα 254: Ασυμβατότητα αρχείου μοντέλου κατασκευαστή 

 

Για να μπορέσουμε να εισαγάγουμε τα αρχεία της συγκεκριμένης συσκευής για την πραγματοποίηση 

των προσομοιώσεων, θα χρειαστεί να μετατρέψουμε τα αρχεία .s7p σε αρχεία .s4p. 

Για να το επιτύχουμε αυτό, θα χρειαστεί πρώτα να μελετήσουμε τους δύο τύπους αρχείων, ώστε να 

καταλήξουμε στο ποια από τα μέρη του μεγαλύτερου αρχείου θα χρειαστούμε και θα κρατήσουμε, 

διαγράφοντας όλα τα υπόλοιπα. 

Αυτό βέβαια μπορούμε να το πραγματοποιήσουμε αφού στην συγκεκριμένη κατασκευή, δεν 

χρησιμοποιούμε και τις 7 θύρες του ολοκληρωμένου HMC252AQS24E. Για την ακρίβεια 

χρησιμοποιούμε τέσσερεις από τις επτά θύρες. 
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Οι θύρες που χρησιμοποιούμε βάσει της πλακέτας είναι οι παρακάτω: 

 RFC = Port 1 

 RF1 = Port 2 

 RF2 = Port 3 

 RF3 = Port 4  

Μετά από σχετική μελέτη, καταλήγουμε πως τα αρχεία .sNp καταγράφουν τις S-Parameters με την 

παρακάτω μορφή: 

F S11m S11a S12m S12a S13m S13a S14m S14a 

   S15m S15a S16m S16a S17m S17a 

   S21m S21a S22m S22a S23m S23a S24m S24a 

   S25m S25a S26m S26a S27m S27a 

   S31m S31a … etc…   

 

Το αντίστοιχο πραγματικό αρχείο δηλαδή έχει ως εξής: 
0.01 -23.969 -2.03 -0.634 -0.326 -77.379 -39.264 -81.175 119.701 
 -82.579  35.039 -71.04  46.7 -68.647  104.81   
 -0.636 -0.324 -24.003 -1.865 -73.128  105.554 -73.638 53.497 
 -77.753  96.556  -67.367 75.658 -76.889 59.919   
 -69.267 60.037 … etc… 

 

 Οποιαδήποτε γραμμή ξεκινά με τον χαρακτήρα «!» πρόκειται για σχόλιο και οι μονάδες δηλώνονται 

με την γραμμή που βρίσκεται επάνω από τις S-Parameters: 
# GHz S  dB   R 50  

 

Έχοντας αυτά υπόψη, συγγράφηκε και χρησιμοποιήθηκε το παρακάτω κομμάτι κώδικα Python 3.7 

για την μετατροπή των αρχείων σε .s4p με σκοπό την μετατροπή του περιεχομένου των αρχείων στην 

παρακάτω μορφή: 

F    S11m  S11a  S12m  S12a  S13m  S13a  S14m  S14a 

     S21m  S21a  S22m  S22a  S23m  S23a  S24m  S24a 

     S31m  S31a  S32m  S32a  S33m  S33a  S34m  S34a 

     S41m  S41a  S42m  S42a  S43m  S43a  S44m  S44a 

 

Συνοπτικά αυτό που θα πραγματοποιηθεί με την εκτέλεσή του είναι: 

1. Εύρεση των επιθυμητών αρχείων με τύπο αρχείου .s7p στο ίδιο επίπεδο φακέλου όπου 

βρίσκεται και το εκτελέσιμο αρχείο. 

2. Ανάγνωση των αρχείων και καταγραφή των «header» των αρχείων για την μεταφορά τους 

στα νέα αρχεία. 

3. Αναγνώριση των S-Parameters για τη μεταφορά τους στα νέα αρχεία. 

4. Δημιουργία νέων αρχείων με τύπο αρχείου .s4p, διατήρηση του υπάρχοντος ονόματος 

αρχείου και καταγραφή των «header» και των επιθυμητών S-Parameters. 
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Ο κώδικας παρατίθεται στον παρακάτω πίνακα: 

#!/usr/bin/python3 

 

import os 

import time 

 

if (os.name == 'nt'): 

    os.system('cls') 

else: 

    os.nice(19) 

    os.system('clear') 

 

class S_Param_Line(): 

    ''' 

    Description: 

        Class that will extract the S-Parameters from a .s7p file.\n 

        In an .s7p file the format is the following:\n 

        !F=0.01 S11m=-23.969    S11a=-2.03  S12m=-0.634 S12a=-0.326 S13m=-77.379    S13a=-

39.264    S14m=-81.175    S14a=119.701\n 

        !   S15m=-82.579    S15a=35.039 S16m=-71.04 S16a=46.7   S17m=-

68.647    S17a=104.81\n 

        !   S21m=-0.636 S21a=-0.324 S22m=-24.003    S22a=-1.865 S23m=-

73.128    S23a=105.554    S24m=-73.638    S24a=53.497\n 

        !   S25m=-77.753    S25a=96.556 S26m=-67.367    S26a=75.658 S27m=-

76.889    S27a=59.919\n 

        ! etc...  \n 

        In the new file we want to keep the following:\n 

            # {}\t    {}\t    {}\t    {}\t    {}\t    {}\t    {}\t    {}\t    {}\n 

            !F\t    S11m\t  S11a\t  S12m\t  S12a\t  S13m\t  S13a\t  S14m\t  S14a\n 

            ! \t    S21m\t  S21a\t  S22m\t  S22a\t  S23m\t  S23a\t  S24m\t  S24a\n 

            ! \t    S31m\t  S31a\t  S32m\t  S32a\t  S33m\t  S33a\t  S34m\t  S34a\n 

            ! \t    S41m\t  S41a\t  S42m\t  S42a\t  S43m\t  S43a\t  S44m\t  S44a\n 

         

    Accepts: 

        lines(list): The lines of the file that is read 

        index(int): The index of the current line in the for loop 

         

    Attributes: 

        freq, S11m, S11a, S12m, S12a, ... , S77m, S77a 

    ''' 

    def __init__(self, lines:list, index:int) -> None:         

        self.freq = lines[index].split('\t')[0] 

    #---------------S1x Parameters---------------------- 

        SLineIndex = index 

        (self.S11m, self.S11a) = self.split_pair(lines[SLineIndex], 1) 

        (self.S12m, self.S12a) = self.split_pair(lines[SLineIndex], 3) 
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        (self.S13m, self.S13a) = self.split_pair(lines[SLineIndex], 5) 

        (self.S14m, self.S14a) = self.split_pair(lines[SLineIndex], 7) 

        SLineIndex = index + 1 

        (self.S15m, self.S15a) = self.split_pair(lines[SLineIndex], 1) 

        (self.S16m, self.S16a) = self.split_pair(lines[SLineIndex], 3) 

        (self.S17m, self.S17a) = self.split_pair(lines[SLineIndex], 5) 

    #---------------S2x Parameters----------------------- 

        SLineIndex = index + 2 

        (self.S21m, self.S21a) = self.split_pair(lines[SLineIndex], 1) 

        (self.S22m, self.S22a) = self.split_pair(lines[SLineIndex], 3) 

        (self.S23m, self.S23a) = self.split_pair(lines[SLineIndex], 5) 

        (self.S24m, self.S24a) = self.split_pair(lines[SLineIndex], 7) 

        SLineIndex = index + 3 

        (self.S25m, self.S25a) = self.split_pair(lines[SLineIndex], 1) 

        (self.S26m, self.S26a) = self.split_pair(lines[SLineIndex], 3) 

        (self.S27m, self.S27a) = self.split_pair(lines[SLineIndex], 5) 

    #---------------S3x Parameters----------------------- 

        SLineIndex = index + 4 

        (self.S31m, self.S31a) = self.split_pair(lines[SLineIndex], 1) 

        (self.S32m, self.S32a) = self.split_pair(lines[SLineIndex], 3) 

        (self.S33m, self.S33a) = self.split_pair(lines[SLineIndex], 5) 

        (self.S34m, self.S34a) = self.split_pair(lines[SLineIndex], 7) 

        SLineIndex = index + 5 

        (self.S35m, self.S35a) = self.split_pair(lines[SLineIndex], 1) 

        (self.S36m, self.S36a) = self.split_pair(lines[SLineIndex], 3) 

        (self.S37m, self.S37a) = self.split_pair(lines[SLineIndex], 5) 

    #---------------S4x Parameters----------------------- 

        SLineIndex = index + 6 

        (self.S41m, self.S41a) = self.split_pair(lines[SLineIndex], 1) 

        (self.S42m, self.S42a) = self.split_pair(lines[SLineIndex], 3) 

        (self.S43m, self.S43a) = self.split_pair(lines[SLineIndex], 5) 

        (self.S44m, self.S44a) = self.split_pair(lines[SLineIndex], 7) 

        SLineIndex = index + 7 

        (self.S45m, self.S45a) = self.split_pair(lines[SLineIndex], 1) 

        (self.S46m, self.S46a) = self.split_pair(lines[SLineIndex], 3) 

        (self.S47m, self.S47a) = self.split_pair(lines[SLineIndex], 5) 

    #---------------S5x Parameters----------------------- 

        SLineIndex = index + 8 

        (self.S51m, self.S51a) = self.split_pair(lines[SLineIndex], 1) 

        (self.S52m, self.S52a) = self.split_pair(lines[SLineIndex], 3) 

        (self.S53m, self.S53a) = self.split_pair(lines[SLineIndex], 5) 

        (self.S54m, self.S54a) = self.split_pair(lines[SLineIndex], 7) 

        SLineIndex = index + 9 

        (self.S55m, self.S55a) = self.split_pair(lines[SLineIndex], 1) 

        (self.S56m, self.S56a) = self.split_pair(lines[SLineIndex], 3) 

        (self.S57m, self.S57a) = self.split_pair(lines[SLineIndex], 5) 
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    #---------------S6x Parameters----------------------- 

        SLineIndex = index + 10 

        (self.S61m, self.S61a) = self.split_pair(lines[SLineIndex], 1) 

        (self.S62m, self.S62a) = self.split_pair(lines[SLineIndex], 3) 

        (self.S63m, self.S63a) = self.split_pair(lines[SLineIndex], 5) 

        (self.S64m, self.S64a) = self.split_pair(lines[SLineIndex], 7) 

        SLineIndex = index + 11 

        (self.S65m, self.S65a) = self.split_pair(lines[SLineIndex], 1) 

        (self.S66m, self.S66a) = self.split_pair(lines[SLineIndex], 3) 

        (self.S67m, self.S67a) = self.split_pair(lines[SLineIndex], 5) 

    #---------------S7x Parameters----------------------- 

        SLineIndex = index + 12 

        (self.S71m, self.S71a) = self.split_pair(lines[SLineIndex], 1) 

        (self.S72m, self.S72a) = self.split_pair(lines[SLineIndex], 3) 

        (self.S73m, self.S73a) = self.split_pair(lines[SLineIndex], 5) 

        (self.S74m, self.S74a) = self.split_pair(lines[SLineIndex], 7) 

        SLineIndex = index + 13 

        (self.S75m, self.S75a) = self.split_pair(lines[SLineIndex], 1) 

        (self.S76m, self.S76a) = self.split_pair(lines[SLineIndex], 3) 

        (self.S77m, self.S77a) = self.split_pair(lines[SLineIndex], 5) 

        return 

    def split_pair(self, line:str, pair:int): 

        ''' 

        Inside the file the S-parameters are in pairs of mangitude and angle\n 

        S11m, S11a 

        ''' 

        Sm = line.split('\t')[pair] 

        Sa = line.split('\t')[pair+1].replace('\n','') 

        return (Sm, Sa) 

 

 

def main(): 

    currentPath = os.getcwd() 

    files_to_Convert = [] 

    new_files = [] 

    print('Files to read:') 

    for top, dirs, files in os.walk(currentPath): 

        for file in files: 

            filename, file_extension = os.path.splitext(file) 

            if (file_extension == '.s7p'): 

                files_to_Convert.append('{}'.format(file)) 

                new_files.append('{}{}'.format(filename, '.s4p')) 

                print(file)       

    print('------------------------------------') 
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    for fileIndex, file in enumerate(files_to_Convert): 

        print('Reading new file: {}'.format(file), end='') 

        S_Paramameters = [] 

        linesToWrite = [] 

        linesToWrite.append('! Custom .s4p file\n') 

        linesToWrite.append('! Kept Ports 1,2,3,4\n') 

 

        with open(file,'r') as f: 

            lines = f.readlines() 

            for index, line in enumerate(lines): 

                if ((line[0] == "!") or (line[0] == '#')): 

                    linesToWrite.append(line) 

                elif (line[0] != '\t'): 

                    S_Paramameters.append(S_Param_Line(lines, index)) 

                else: 

                    pass 

                print('\rReading file: {} {:.2f}%'.format(file, index*(100/len(lines))), en

d='') 

 

        print('\rReading file:{} Complete'.format(file), end='') 

 

        # We want to keep Ports 1, 2, 3, 4 

         

        for s_par in S_Paramameters: 

            #---------------S1 line with Frequency----------------- 

            linesToWrite.append( 

                '{}\t{}\t{}\t{}\t{}\t{}\t{}\t{}\t{}\n'.format( 

                    s_par.freq, s_par.S11m, s_par.S11a, s_par.S12m, s_par.S12a, s_par.S13m,

 s_par.S13a, s_par.S14m, s_par.S14a 

                ) 

            ) 

            #---------------S2 line-------------------------------- 

            linesToWrite.append( 

                '\t{}\t{}\t{}\t{}\t{}\t{}\t{}\t{}\n'.format( 

                    s_par.S21m, s_par.S21a, s_par.S22m, s_par.S22a, s_par.S23m, s_par.S23a,

 s_par.S24m, s_par.S24a 

                ) 

            ) 

            #---------------S3 line-------------------------------- 

            linesToWrite.append( 

                '\t{}\t{}\t{}\t{}\t{}\t{}\t{}\t{}\n'.format( 

                    s_par.S31m, s_par.S31a, s_par.S32m, s_par.S32a, s_par.S33m, s_par.S33a,

 s_par.S34m, s_par.S34a 

                ) 

            ) 

            #---------------S4 line-------------------------------- 
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            linesToWrite.append( 

                '\t{}\t{}\t{}\t{}\t{}\t{}\t{}\t{}\n'.format( 

                    s_par.S41m, s_par.S41a, s_par.S42m, s_par.S42a, s_par.S43m, s_par.S43a,

 s_par.S44m, s_par.S44a 

                ) 

            ) 

        with open(new_files[fileIndex], 'w') as fi: 

            fi.writelines(linesToWrite) 

            print('\rReading file:{} Complete ======> Writing to new file:{} Complete      

   '.format(file, new_files[fileIndex])) 

    print('Thy work here is done find the files:') 

    for new_file in new_files: 

        print(new_file) 

    print('Exiting..') 

main() 

exit() 

Πίνακας 5: Αλγόριθμος για την μετατροπή αρχείου S-Parameters 

 

Μετά την εκτέλεση του παραπάνω αλγορίθμου ένα ενδεικτικό αποτέλεσμα ενός αρχείου είναι το 

παρακάτω: 

0.01 -23.969 -2.03 -0.634 -0.326 -77.379 -39.264 -81.175 119.701 

 -0.636 -0.324 -24.003 -1.865 -73.128 105.554 -73.638 53.497 

 -69.267 60.037 -69.351 125.438 -0.161 -5.997 -72.277 107.886 

 -71.714 128.574 -86.208 -62.651 -74.641 11.779 -0.184 -6.494 

0.02 -24.109 -3.203 -0.632 -0.539 -64.235 94.004 -65.581 86.359 

 -0.635 -0.531 -24.081 -3.376 -61.739 91.117 -67.729 97.766 

 -64.201 87.791 -63.923 87.744 -0.318 -11.46 -80.99 82.782 

 -65.009 80.311 -64.679 104.496 -72.537 73.933 -0.351 -12.443 

 

Το αποτέλεσμα αυτό μπορούμε να εισαγάγουμε επιτυχώς στο CST Design Studio επιλέγοντας ως 

τύπο συσκευής  Generic (4PIN). 
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Θα χρησιμοποιήσουμε τα παραπάνω στοιχεία για να ταυτοποιήσουμε τις θύρες (Left – Top – Right – 

Bottom) στο σχηματικό μας. 

 
Εικόνα 255: Εισαγωγή αρχείου μετά την παραμετροποίηση με την χρήση κώδικα 

 

Συνδέοντας τέσσερεις θύρες, μπορούμε να διασταυρώσουμε μέσω των αποτελεσμάτων πως η 

αριστερή θύρα είναι η πρώτη, η επάνω η δεύτερη κτλ.  

 

 
Εικόνα 256: Απεικόνιση παραμετροποιημένου αρχείου 

 

Μπορούμε έτσι να προχωρήσουμε στην δημιουργία των τριών συνδέσεων για το κύκλωμά μας. Θα 

χρησιμοποιήσουμε τη παρακάτω εικόνα της πλακέτας για την επίδειξη των θυρών, όπου 

χρησιμοποιείται και ο όρος Terminal (τερματικό) ώστε η αρχική με την τελική θύρα να είναι πιο 

ευδιάκριτη. 
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Εικόνα 257: Οι θύρες της πλακέτας 

 

 

 Από το Terminal 1 στο Terminal 2 (RFC to RF1): 

 

Εικόνα 258: Απεικόνιση κυκλώματος (θύρα 1 προς θύρα 2) 
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 Από το Terminal 1 στο Terminal 3 (RFC to RF2): 

 

Εικόνα 259: Απεικόνιση κυκλώματος (θύρα 1 προς θύρα 3) 

 

 

 Από το Terminal 1 στο Terminal 2 και στο Terminal 3: 

 

Εικόνα 260: Απεικόνιση κυκλώματος (θύρα 1 προς θύρα 2 και θύρα 3) 
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ΚΕΦΑΛΑΙΟ 5: 

Μεταφορά αλλαγών στο Altium  – Παρουσίαση 

αποτελεσμάτων CST Studio 

 

 

5.1. Μεταφορά αλλαγών στο Altium 

 

Αφού έχουμε ολοκληρώσει τις προσομοιώσεις και έχουμε καταλήξει στις αλλαγές που επιθυμούμε να 

πραγματοποιήσουμε στην πλακέτα στο Altium, μπορούμε να προχωρήσουμε εξαγάγοντας είτε το 

Gerber αρχείο, είτε ένα αρχείο dxf και να περάσουμε τις αλλαγές. 

 

Ωστόσο, λόγω των ιδιαιτεροτήτων που έχει το CST για την εξαγωγή των προαναφερθέντων αρχείων 

και για να μην έχουμε προβλήματα με την ευθυγράμμιση για τα κομμάτια που πρόκειται να 

εξαγάγουμε, οφείλουμε να λάβουμε υπόψη τα παρακάτω. 

 

Το CST έχει την εξής ιδιαιτερότητα στην διαδικασία εξαγωγής είτε αρχείου Gerber, είτε αρχείου dxf. 

Εξαγάγει αρχείο για το επίπεδο της επιφάνειας όπου τέμνει το τρέχον σύστημα αξόνων. Αν έχει 

οριστεί τοπικό σύστημα αξόνων (u, v, w), εξαγάγει την επιφάνεια ή τις επιφάνειες όπου τέμνει για 

w=0. Στην περίπτωση όπου δεν έχει οριστεί τοπικό σύστημα αξόνων, τότε εξαγάγει την επιφάνεια ή 

τις επιφάνειες όπου τέμνει για z=0. Επίσης, για να μην χρειαστεί να πραγματοποιήσουμε κάποια 

μετακίνηση του  dxf ή Gerber αρχείου στο Altium και για να είναι ευθυγραμμισμένο, πρέπει να 

εξαγάγουμε όλα τα αρχεία με το ίδιο σύστημα αξόνων. Πρέπει δηλαδή το σημείο της αρχής των 

αξόνων στο CST, να είναι το ίδιο με αυτό που φαίνεται στο κομμάτι του Altium στην Εικόνα 128. 

Ακολουθούμε οπότε τα παρακάτω βήματα: 
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Επαναφέρουμε το σημείο αρχής των αξόνων ώστε να είναι κοινό με αυτό που έχουμε στο Altium. 

Στο αρχικό παράθυρο, επιλέγουμε Local WCS. 

 

 
Εικόνα 261: Επαναφορά σημείου αναφοράς 

 

 
Εικόνα 262: Απεικόνιση σημείου αναφοράς 

 

  



169 

Μεταπτυχιακή Διπλωματική Εργασία, Διονύσης Δεληγιαννόπουλος, ΑΜ: IES-0015 

Για αρχείο dxf μπορούμε είτε να επιλέξουμε πολλαπλά σημεία για την εξαγωγή πολλαπλών επιπέδων 

είτε να μετακινήσουμε το σύστημα αξόνων κατά ύψος ώστε το επίπεδο που επιθυμούμε να 

εξαγάγουμε να τέμνεται για w=0. Σε αυτό το σημείο, θα δείξουμε την επιλογή σημείου και θα 

μετακινήσουμε το σύστημα αξόνων ώστε το σημείο αναφοράς να είναι κοινό και για την εξαγωγή του 

αρχείου Gerber. 

Με τη βοήθεια του εργαλείου επιλογέα σημείων (point picker) επιλέγουμε την επάνω αριστερή 

γωνία του επιπέδου χαλκού στο επάνω σημείο της πλακέτας. 

 
Εικόνα 263: Επιλογή επιπέδου για την εξαγωγή αρχείου DXF 

 

Στη συνέχεια από το κεντρικό παράθυρο, επιλέγουμε: Import/Export > 2D Files > DXF 

 

 
Εικόνα 264: Εξαγωγή αρχείου DXF (1) 
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Παρατηρούμε πως πάνω στην πλακέτα μας επισημαίνεται το επίπεδο που πρόκειται να εξαχθεί: 

 

 
Εικόνα 265: Εξαγωγή αρχείου DXF (2) 

 

Επικυρώνουμε την ενέργεια αυτή και στο παράθυρο που αναδύεται, επιλέγουμε το όνομα 

αποθήκευσης του αρχείου καθώς επίσης και την τοποθεσία του. 

 

 
Εικόνα 266: Εξαγωγή αρχείου DXF (3) 
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Για την εξαγωγή αρχείου Gerber θα δημιουργήσουμε ένα τοπικό σύστημα αξόνων στο κατάλληλο 

ύψος και στη συνέχεια εξάγουμε το επιθυμητό αρχείο. 

Από το αρχικό παράθυρο, επιλέγουμε Local WCS > Local Coordinate System Properties… 

 

 
Εικόνα 267: Ορισμός σημείου αναφοράς 

 

Στο νέο παράθυρο που εμφανίζεται, επιλέγουμε την απόσταση του τοπικού συστήματος αξόνων σε 

σχέση με το αρχικό. 

 

 
Εικόνα 268: Ορισμός ύψους σημείου αναφοράς 
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Στην συνέχεια, από το αρχικό παράθυρο, επιλέγουμε: Import/Export > 2D Files > Gerber 

(Signle Layer)... 

 

 
Εικόνα 269: Εξαγωγή αρχείου Gerber (1) 

 

Παρατηρούμε, λοιπόν, πως επισημαίνεται στην πλακέτα, το επίπεδο που πρόκειται να εξαχθεί: 

 

 
Εικόνα 270: Εξαγωγή αρχείου Gerber (2) 
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Επικυρώνουμε την ενέργεια αυτή και στο παράθυρο που αναδύεται, επιλέγουμε το όνομα 

αποθήκευσης του αρχείου, καθώς επίσης και την τοποθεσία του. 

 

 
Εικόνα 271: Εξαγωγή αρχείου Gerber (3) 
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Η διαδικασία που θα περιγράψουμε παρακάτω, αφορά μόνο την εισαγωγή αρχείων DXF στο Altium 

Designer, μιας και φαίνεται να υπάρχει κάποια ασυμβατότητα με την εισαγωγή αρχείων Gerber. 

Βέβαια, τα αρχεία Gerber του CST μπορεί να είναι συμβατά με άλλα προγράμματα και καλό είναι 

γενικά να έχουμε έναν βαθμό ευελιξίας όταν επιθυμούμε να μεταφέρουμε πληροφορία από ένα 

πρόγραμμα σε ένα άλλο. 

 

Αφού εξαγάγουμε όλα τα κομμάτια της πλακέτας, ανοίγουμε το project στο Altium Designer. 

Αρχικά θα πρέπει να διαγράψουμε όλα τα Via που έχουμε τοποθετήσει. Για να τα επιλέξουμε όλα 

και να τα διαγράψουμε, κάνουμε δεξί κλικ επάνω σε ένα από αυτά και επιλέγουμε από το μενού που 

αναδύεται Find Similar Objects… 
 

 
Εικόνα 272: Εύρεση vias για αφαίρεση 

 

Στο νέο παράθυρο που θα εμφανιστεί, επιλέγουμε τις ιδιότητες των όμοιων αντικειμένων που 

επιθυμούμε να επιλέξουμε. Στην συνέχεια επικυρώνουμε την επιλογή μας και όλα τα via της 

πλακέτας που χρησιμοποιούνται για την ένωση της γείωσης στα δύο επίπεδα είναι επιλεγμένα. 
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Εικόνα 273: Απεικόνιση χρήσης εργαλείου φίλτρου επιλογών 

 



176 

Μεταπτυχιακή Διπλωματική Εργασία, Διονύσης Δεληγιαννόπουλος, ΑΜ: IES-0015 

 
Εικόνα 274: Επιλογή vias για διαγραφή 

 
Αφού τα διαγράψουμε, θα εισαγάγουμε τα κομμάτια της πλακέτας που έχουμε αλλάξει στο CST. 

Ακολουθούμε τις επιλογές: File > Import > DXF/DWG 

 

 
Εικόνα 275: Εισαγωγή αρχείου DXF (1) 

 

Στο επόμενο παράθυρο επιλέγουμε το αρχείο όπου επιθυμούμε να εισαγάγουμε. 
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Εικόνα 276: Εισαγωγή αρχείου DXF (2) 

 

Στο νέο παράθυρο όπου αναδύεται, επιλέγουμε τις μονάδες του αρχείου προς εισαγωγή (mm, mil, 

inch κλπ.), το επίπεδο επάνω στο οποίο θα εισαχθεί το προς εισαγωγή αντικείμενο, καθώς και ποιο θα 

είναι το σημείο αναφοράς του. Σύμφωνα με τον τρόπο εξαγωγής των αρχείων, το σημείο αναφοράς 

έχει οριστεί στο κάτω αριστερά άκρο της πλακέτας και αυτό θα επιλέξουμε κι εδώ με την επιλογή του 

Select, επιλέγοντας παράλληλα το origin που θα έχει η πλακέτα (Εικόνα 278). 

 
Εικόνα 277: Εισαγωγή αρχείου DXF (3) 
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Εικόνα 278: Ορισμός σημείου αναφοράς εισαγόμενου αρχείου DXF 

 

Αφού ολοκληρώσουμε την εισαγωγή, μπορούμε να δούμε το κομμάτι της πλακέτας που 

εισαγάγαμε επάνω στο υπάρχον σχέδιο. 

 

 
Εικόνα 279: Απεικόνιση εισαγόμενου αρχείου DXF στην πλακέτα 
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Αφού διαγράψουμε το υπάρχον κομμάτι χαλκού, επιλέγουμε τις γραμμές του σχεδίου που εισαγάγαμε 

και στην συνέχεια από το μενού επιλογών Tools > Convert > Create Region from Selected 

Primitives. 

 
Εικόνα 280: Δημιουργία Region από τις γραμμές του αρχείου DXF (1) 

 

 
Εικόνα 281: Δημιουργία Region από τις γραμμές του αρχείου DXF (2) 

 

Μεταφέρουμε την περιοχή χαλκού που δημιουργήσαμε στο επίπεδο L1 της πλακέτας από το 

παράθυρο ιδιοτήτων στο δεξί μέρος της οθόνης του προγράμματος. Ορίζουμε, επίσης, το Net στο 

οποίο αυτή η περιοχή θα ανήκει. 
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Εικόνα 282: Μεταφορά περιοχών στο επίπεδο L1 

 

 
Εικόνα 283: Ορισμός Nets για τις περιοχές που δημιουργήθηκαν 

 

Επαναλαμβάνουμε την διαδικασία για τα υπόλοιπα κομμάτια της πλακέτας δίνοντας ιδιαίτερη 

προσοχή στα κομμάτια χαλκού που χρησιμοποιούσαμε στην προσομοίωση στο CST ως κομμάτια 

γείωσης, αφού αυτά θα συμπίπτουν με άλλους αγωγούς που χρησιμοποιούνται για σήματα ελέγχου. 

 

 
Εικόνα 284: Απεικόνιση περιοχών που εισάχθηκαν 
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Αφού εισαγάγουμε όλα τα κομμάτια της πλακέτας, μπορούμε να πραγματοποιήσουμε και τις αλλαγές 

στο σχηματικό, ώστε να συμφωνούν με την πλακέτα. 

Περνώντας τις αλλαγές και επιλέγοντας νέα διακριτά στοιχεία που θα συμφωνούν με τις τιμές της 

προσομοίωσης (πυκνωτές και πηνία) ενημερώνουμε και το project της πλακέτας. 

 

 
Εικόνα 285: Μετατροπή σχηματικού πλακέτας 

 

 
Εικόνα 286: Ενημέρωση αρχείου PCB από το σχηματικό 
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Εάν υπάρχουν τυχόν διαφωνίες μεταξύ των δύο αρχείων, κυρίως ως προς την αντιστοίχιση κάποιου 

υλικού στην πλακέτα και στο σχηματικό, το πρόγραμμα θα μας ειδοποιήσει με σχετικό παράθυρο 

όπου θα μας δίνει και διάφορες επιλογές για το ποιο υλικό θα πάρει την θέση ποιου κλπ.  

Πραγματοποιούμε και έναν τελευταίο έλεγχο για να διαπιστώσουμε και την επιτυχή αλλαγή της 

πλακέτας και του σχηματικού σχετικά με τα υλικά και τις τιμές τους. 

 

 
Εικόνα 287: Τελική μορφή πλακέτας 

 

Έτσι η τελική μας πλακέτα έχει την παρακάτω μορφή:  

 

 
Εικόνα 288: Τρισδιάστατη απεικόνιση πλακέτας 
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Ομοιοτρόπως, έχουμε την παρακάτω απεικόνιση του τελικού σχηματικού για την πλακέτα μας: 

 
Εικόνα 289: Τελικό σχηματικό πλακέτας 

Τέλος θα εξαγάγουμε και το BoM (Bill of Materials) της πλακέτας. 

Report > Bill of Materials 

 

 
Εικόνα 290: Εξαγωγή BoM 
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Στο νέο παράθυρο που αναδύεται, μας προσφέρεται η δυνατότητα να επιλέξουμε ποιες πληροφορίες 

θα συμπεριλαμβάνει το αρχείο εξαγωγής, από τον κατασκευαστή, τα κέντρα των υλικών σύμφωνα με 

την πλακέτα, τα σχόλια που έχουμε ορίσει για το κάθε υλικό κλπ. 

 

 
Εικόνα 291: Επιλογές εξαγωγής ΒοΜ 
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Στον παρακάτω πίνακα, παρατίθεται και το BoM για την πλακέτα μας. 
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Πίνακας 6: Bill of Materials 
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5.2. Παρουσίαση αποτελεσμάτων CST Studio 

 

Στο σημείο αυτό θα παρουσιάσουμε τα αποτελέσματα των προσομοιώσεων από τις τρεις συνδέσεις 

της πλακέτας. 

 

 Από το Terminal 1 στο Terminal 2 (RFC to RF1): 

 

Εικόνα 292: Απεικόνιση σχηματικού προσομοίωσης (σύνδεση θύρας 1 με θύρα 2) 
 

Παρατηρούμε στις παρακάτω εικόνες (Εικόνα 293, Εικόνα 294, Εικόνα 295) πως παρόλη την 

προσαρμογή και βελτιστοποίηση των μεμονωμένων κομματιών της πλακέτας, η συνολική επίδοση 

του κυκλώματος, δεν είναι η αναμενόμενη. 

Ενδιαφέρον παρουσιάζει και η παράθεση των αποτελεσμάτων του κυκλώματος που αποτελείται μόνο 

από τα κομμάτια της πλακέτας  που σχεδιάσαμε (Εικόνα 296, Εικόνα 297, Εικόνα 298). 

Από αυτό συμπεραίνουμε πως τα HMC284A και HMC252A συνεισφέρουν με αρκετές απώλειες στο 

σύστημά μας, μιας και το μέγιστο S11 που έχει για παράδειγμα το HMC252A, σύμφωνα με το αρχείο 

του κατασκευαστή που περιλαμβάνει τα S-Parameters, είναι της τάξης των -19.763dB, για την 

περίπτωση κατά την οποία επιλεγμένη είναι η θύρα RF1. 

Στον παρακάτω πίνακα παρατίθεται μέρος του σχετικού αρχείου για την συχνότητα των 900MHz: 

 

0.9 -19.763 -53.583 -0.728 -17.888 -47.78 -55.532 -52.541 -21.324 

 -53.91 -13.145 -49.212 22.646 -44.214 63.279   

 -0.725 -17.894 -26.052 -65.857 -43.453 66.876 -54.111 18.946 

 -55.995 -19.363 -51.198 -21.807 -48.964 -51.52   

 -47.784 -55.357 -43.431 67.098 -21.255 -74.613 -43.34 91.898 

 -65.071 65.046 -63.211 84.094 -63.694 88.198   

 -52.485 -21.746 -54.132 19.427 -43.37 91.788 -20.595 -68.166 

 -60.989 59.279 -62.773 75.721 -66.405 79.637   

 -53.968 -12.955 -56.203 -19.825 -64.572 63.297 -61.127 59.587 

 -20.953 -70.436 -43.991 89.282 -58.535 76.327   

 -49.251 22.536 -51.15 -21.727 -62.93 83.83 -62.796 73.729 

 -43.977 89.436 -21.352 -76.547 -45.522 92.333   

 -44.246 63.686 -48.974 -51.635 -63.67 87.205 -66.441 80.757 

 -58.322 76.664 -45.524 92.225 -20.603 -78.526   

Πίνακας 7: Δείγμα αρχείου S-Parameters του HMC252A 
 

Τα ίδια συμπεράσματα ισχύουν και για την σύνδεση από το terminal 1 στο terminal 2 (Εικόνα 299). 

  



187 

Μεταπτυχιακή Διπλωματική Εργασία, Διονύσης Δεληγιαννόπουλος, ΑΜ: IES-0015 

S-Parameters: 

 
Εικόνα 293: S-Parameters τελικού κυκλώματος (σύνδεση θύρας 1 με θύρα 2) 

Smith Chart: 
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Εικόνα 294: Χάρτης Smith τελικού κυκλώματος (σύνδεση θύρας 1 με θύρα 2) 
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VSWR: 

 
Εικόνα 295: VSWR τελικού κυκλώματος (σύνδεση θύρας 1 με θύρα 2) 

 
Εικόνα 296: Κύκλωμα σύνδεσης κομματιών πλακέτας που σχεδιάστηκαν χωρίς RF switch 
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Εικόνα 297: Χάρτης Smith κυκλώματος μερών πλακέτας που σχεδιάστηκαν, χωρίς RF 

Switch 
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Εικόνα 298: S-Parameters κυκλώματος μερών πλακέτας που σχεδιάστηκαν, χωρίς RF 

Switch 
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 Από το Terminal 1 στο Terminal 3 (RFC to RF2): 

 

 
Εικόνα 299 : Απεικόνιση σχηματικού προσομοίωσης (σύνδεση θύρας 1 με θύρα 3) 
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S-Parameters: 

 
Εικόνα 300: S-Parameters τελικού κυκλώματος (σύνδεση θύρας 1 με θύρα 3) 

Smith Chart: 
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Εικόνα 301: Χάρτης Smith τελικού κυκλώματος (σύνδεση θύρας 1 με θύρα 3) 
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VSWR: 

 
Εικόνα 302: VSWR τελικού κυκλώματος (σύνδεση θύρας 1 με θύρα 3) 

 Από το Terminal 1 στο Terminal 2 και στο Terminal 3: 

 

 
Εικόνα 303 : Απεικόνιση σχηματικού προσομοίωσης (σύνδεση θύρας 1 με θύρα 2 και θύρα 

3) 
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S-Parameters: 

 
Εικόνα 304: S-Parameters τελικού κυκλώματος (σύνδεση θύρας 1 με θύρα 2 και θύρα 3) 

Smith Chart: 
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Εικόνα 305: Χάρτης Smith τελικού κυκλώματος (σύνδεση θύρας 1 με θύρα 2 και θύρα 3) 
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VSWR: 

 
Εικόνα 306: VSWR τελικού κυκλώματος (σύνδεση θύρας 1 με θύρα 2 και θύρα 3) 
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ΚΕΦΑΛΑΙΟ 6: 

Συμπεράσματα – Προτάσεις  

 

 

Στην παρούσα εργασία, ακολουθήσαμε τα βήματα για τον σχεδιασμό, τον έλεγχο, την 

βελτιστοποίηση και την προσομοίωση μίας πλακέτας. Μελλοντικές συνεισφορές στο παρόν 

project, μπορούν δυνητικά να είναι η συγγραφή του κώδικα για το Freakduino, όπου ανάλογα 

με τις μετρήσεις της ποιότητας του σήματος που θα λαμβάνει η κεραία μεταβλητού λοβού, 

θα χρησιμοποιεί την αντίστοιχη διαδρομή, με στόχο την βέλτιστη επικοινωνία. 

Αν και το αποτέλεσμα της παρούσας εργασίας μπορεί να χρήζει βελτίωσης, κυρίως ως προς 

τα υλικά που επιλέχθηκαν και πιο συγκεκριμένα τα RF Switch, τα βήματα που 

ακολουθήθηκαν παραμένουν τα ίδια και έχουν μια ευρεία εφαρμογή σε ένα μεγάλο φάσμα 

κατασκευών και πλακετών. Η παρούσα εργασία μπορεί να θεωρηθεί και ως ένας 

ενημερωμένος οδηγός των προγραμμάτων που  χρησιμοποιήθηκαν. 

Επίσης, μπορεί να θεωρηθεί πως αναφέρεται και σε δύο διαφορετικούς κλάδους μίας 

εταιρείας, σε αυτόν που θα σχεδιάσει το κύκλωμα και την πλακέτα με εργαλεία που είναι 

βελτιστοποιημένα για τον μαζικό σχεδιασμό πλακετών και στοχεύουν στην απλοποίηση 

διαδικασιών της γραμμής παραγωγής πλακετών και σε αυτόν που θα έχει τον ρόλο είτε της 

διασφάλισης ποιότητας και ελέγχου των πλακετών είτε θα έχει ένα θεωρητικό υπόβαθρο 

στην σχεδίαση υψίσυχνων κυκλωμάτων και κεραιών. Συχνά παρατηρείται ασυμβατότητα 

μεταξύ των εργαλείων όπου αυτοί οι δύο κλάδοι χρησιμοποιούν και οι «ευκολίες» τις οποίες 

παρέχουν οι δύο κατηγορίες εργαλείων είναι διαφορετικές, καθώς βλέπουν και 

επεξεργάζονται τη διαδικασία σχεδίασης μιας πλακέτας από τελείως διαφορετικές σκοπιές 

και οπτικές γωνίες. Μπορεί το αποτέλεσμα και ο στόχος του κάθε εργαλείου να είναι κοινός, 

ο τρόπος όμως, η προσέγγιση και η βαθμίδα ειδίκευσης ποικίλουν, ακόμα και αν τα εργαλεία 

αυτά ανήκουν στην ίδια οικογένεια προγραμμάτων, κάτω από την ίδια εταιρική στέγη. 

 

Αν και η παρούσα εργασία ξεκίνησε με στόχο τον σχεδιασμό και την υλοποίηση του 

κυκλώματος διεπαφής μεταξύ μικροελεγκτή και κεραίας μεταβλητού λοβού, κατέληξε να 

έχει περισσότερο τη μορφή ενός αναλυτικού οδηγού της διαδικασίας τόσο του σχεδιασμού 

στο Altuim Designer, όσο και του ελέγχου, της βελτιστοποίησης και της προσομοίωσης της 

πλακέτας τυπωμένου κυκλώματος στο CST Studio. Η μη ύπαρξη ενός οδηγού ή 

οποιασδήποτε καθοδήγησης σε γραπτές και μη πηγές, αποτέλεσαν το έρεισμα στη στροφή 

αυτής της εργασίας. Η ανεύρεση και επισήμανση των δυσκολιών και των δυστοκιών του 

εκάστοτε εργαλείου σχεδίασης και προσομοίωσης αποτελεί μια αρκετά χρονοβόρα και 

επίπονη διαδικασία, μέσω της οποίας όμως ο χρηστής καταφέρνει να ανακαλύψει μια 

χρηστική διαδικασία για την επίτευξη του στόχου του.  
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